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Introduction to the Management Reporter User 

Guide 

Management Reporter for Microsoft Dynamics
®

 ERP is designed to help you create financial reports that 

can be tailored to meet the needs of your company. Designed by accountants for accountants, 

Management Reporter helps you to create high-volume, presentation-quality reports in minutes. You can 

also share report information through email, instant messaging, and other communication features in 

Management Reporter.  

This guide will help you learn how to create reports in Management Reporter, maintain existing reports, 

and use additional features to share financial information with other people in your organization. The 

content in this guide is organized by components and tasks, so that you can easily find the information 

that you need. 

Some functionality and features of Management Reporter are available only with certain Microsoft 

Dynamics ERP systems. We recommend that you review the Management Reporter online help and the 

user guide for the Microsoft Dynamics ERP system that you are using. 

This user guide is divided into the following sections: 
 

Section Description 

Management Reporter overview Describes the components of Management Reporter, 

including the Report Viewer, Desktop Viewer, and Web 

Viewer. This section also provides a general description of 

how you can use Management Reporter in your business. 

Management Reporter administration Describes how to assign users to roles and user groups, grant 

permissions, and use security options in the report library.  

Building blocks and reports Describes how to use report components, referred to as 

building blocks, to create a report in Management Reporter.  

Row definitions Describes how to use the row-based features of a report, 

including row totals and formulas, links to financial data, and 

formatting codes for the rows of a report.  

Column definitions Describes how to use the column-based features of a report, 

including calculation columns, links from an Excel
®

 

worksheet, descriptions from the row definition, and 

formatting codes for the columns of a report. 

Reporting tree definitions Describes how to use a reporting tree to define the structure 

and hierarchy of an organization in a report. 

Reporting trees are optional building blocks that are not 

required to build a report, but they offer additional security 

and reporting features. 
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Section Description 

Report definitions Describes how to use row definitions, column definitions, and 

reporting tree definitions to create a report. 

Report definitions also contain formatting and rounding 

options for a report. 

Formatting options for reports Describes the basic formatting options that are available for 

reports. Basic options include headers and footers, column 

justification, column and row text options, and report 

settings. 

Advanced formatting options Describes the advanced formatting options that are available 

for reports. Advanced options include dimension filters, 

reporting unit restrictions, non-printing rows, column 

restrictions, and IF/THEN/ELSE statements. 

Generate reports Describes how to publish reports to the report library, 

schedule reports, and how to run a missing account analysis 

of a report. It also describes options for viewing and securing 

reports. 

Organize reports Describes how to maintain different versions of reports, sort 

reports into folders in the report library, create and manage 

report groups, and maintain the report library. 

Use additional file types with Management Reporter Describes how to use Management Reporter with other types 

of files, such as worksheets in Microsoft Excel
®

, XPS files, and 

XBRL files. 

Desktop Viewer Describes the features that are available in the Desktop 

Viewer. Features include how to view reports, add comments 

or charts to a report, initiate an instant message conversation 

when you are viewing a report, share a report, export a 

report, and drill down into the Microsoft Dynamics ERP 

system to view more details about report data. 

Web Viewer Describes the features of the Web Viewer and explains how 

to view and share reports in an Internet browser. 

 

For more information about specific features, see the Management Reporter Help documentation.  
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Management Reporter overview 

Management Reporter for Microsoft Dynamics ERP is an interactive reporting application that financial 

and business professionals can use to create, maintain, deploy, and view financial statements. It moves 

past traditional reporting constraints, and lets you enhance your creativity and helps you design a variety 

of reports efficiently. Communication is stream-lined with the use of interactive notes and instant 

messaging. 

Management Reporter includes native dimension support. Account segments or dimensions are 

immediately available to select in Management Reporter and does not require additional tools or 

configuration.  

For more information about Management Reporter and your Microsoft Dynamics ERP system, such as 

news, training, downloads and updates, demos, and additional documentation, go to CustomerSource 

(https://mbs.microsoft.com/customersource/). 

 

 Components of Management Reporter 

 Account systems 

 Migrating from Microsoft FRx to Management Reporter 

https://mbs.microsoft.com/customersource/
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Components of Management Reporter 
The following components of Management Reporter provide ease of use to create, view, and schedule 

reports. 
 

Management Reporter Component Functions 

Report Designer Used to create report building blocks that are combined to define and 

generate a report. The report wizard guides less experienced users through 

the design process. Advanced users can create report building blocks from 

scratch or modify existing building blocks to meet their needs. For more 

information, see the Management Reporter Help documentation. 

Desktop Viewer Used to organize and view reports and supporting files. It also stores the 

report library. For more information, see Desktop Viewer. 

Web Viewer Displays Management Reporter reports in a web browser. The Web Viewer 

does not require an installation of Management Reporter server 

components. For more information, see Web Viewer. 

Report schedules A user can schedule a single report or a group of reports to generate on a 

regular basis. For more information, see Schedule reports. 

Management Reporter database This SQL database stores the components, known as building blocks, which 

are used to generate reports. It also stores report definitions and previously 

generated reports. 

Application service Controls access to the data provider and provides connectivity to clients. 

For more information, see the Management Reporter Help documentation. 

Process service Generates the reports that are created and queued by the Management 

Reporter client. 

 

See Also 
Building blocks and reports 

Security, user roles, and permissions 

Desktop Viewer 

Management Reporter overview 
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Account systems 
Management Reporter includes native dimension support, which means that the application works the 

same whether it is connected to a fully-qualified account system or a dimension-based system. New 

account segments or dimensions are immediately available in Management Reporter without requiring 

any additional tools or configuration. 

Fully qualified account system 

A fully qualified account contains a value for an account or natural segment, such as Cash or Sales, in 

addition to values for additional segments, such as Location, Division, and Department. In Management 

Reporter, these additional segments are referred to as the responsibility segments, and each of the 

segments is a fixed length. 

The following illustration shows how the natural and responsibility segments combine to form a fully 

qualified account. 
 

 
 

The difference between a natural segment for a fully qualified account and a responsibility segment is 

important to the use of Management Reporter. Typically, users specify the natural segment values in a 

row definition and the responsibility segment values in a reporting tree definition. When reports are 

generated, these values are combined in various ways to extract specific financial data records from a 

Microsoft Dynamics ERP system. 

Dimension-based account system 

A dimension-based account system includes an account dimension and other dimensions that can 

represent details, such as customers, projects, departments, or other areas of importance to your 

company. Each dimension can be variable in length. Typically, users specify the natural dimension values 

in a row definition and the responsibility dimension values in a reporting tree definition. When reports are 

generated, the values are combined in various ways to extract specific financial data records from your 

Microsoft Dynamics ERP system. 
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Dimension values 

Management Reporter row definitions and reporting tree definitions support the use of special characters 

as a way to identify multiple dimension values without naming each item individually. The following table 

describes the characters that are supported for specifying dimension values. 
 

Character Function for Row Definitions Function for Reporting Tree 

Definitions 

Ampersand (&) In the Dimension row of the Insert Rows from dialog box, 

identifies the dimension from which to bring values into the row 

definition. These values become the basis of the rows in the 

generated report. 

Ampersands are typically used for the account dimension. 

Not used in a dimension-based 

system. 

Number sign (#) In the Dimension row of the Insert Rows from dialog box, 

identifies the dimensions to ignore when bringing values into the 

row definition. 

Number signs are typically used for the responsibility 

dimensions. 

Not used. 

Plus sign (+) Not used. In the segments area of the 

Insert Reporting Units from 

dialog box, identifies the 

dimensions from which to 

bring values into the row 

definition. These values 

become the reporting units in 

the reporting tree. 

Digits (0-9) In the Range rows of the Insert Rows from dialog box, identify 

the first and last dimension values to bring into the row 

definition. 

In the Link to Financial Dimensions column of a row definition, 

identify the dimension values to include in the report for each 

row. 

In the From Account and To 

Account columns of the Insert 

Reporting Units from dialog 

box, identify the first and last 

dimension values to bring into 

the reporting tree definition. 

In the Dimensions column of a 

reporting tree definition, 

identify the dimension value to 

include in the reporting unit for 

each row. 

Letters (a-z, A-

Z) 

Used in the same ways as digits.  
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Character Function for Row Definitions Function for Reporting Tree 

Definitions 

Question mark 

(?) 

A placeholder for a single character in a dimension value. For 

example, the value 22?? indicates that Management Reporter 

should insert the total financial amount for all dimension values 

in the range from 2200 through 2299 into the generated report. 

 

Asterisk (*) A placeholder for one or more characters in a dimension value. 

For example, for a color dimension, the value GR* indicates that 

Management Reporter should insert the combined financial 

amount for the GREEN and GRAY dimension values into the 

generated report. 

 

 

See Also 

Management Reporter overview 
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Migrating from Microsoft FRx to Management 

Reporter 
If you are migrating from Microsoft FRx

®
 to Management Reporter, see the Migration Guide on the 

Management Reporter for Microsoft Dynamics ERP Installation, Migration, and Configuration Guides 

(http://go.microsoft.com/fwlink/?LinkID=162565) web site. 

See Also 

Management Reporter overview 

http://go.microsoft.com/fwlink/?LinkID=162565
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Management Reporter administration 

When Management Reporter is installed, the user doing the installation is assigned the role of 

administrator. The administrator has permission to do the following tasks: 

 Create users and groups and assign appropriate permissions. For more information, see Security, user 

roles, and permissions. 

 Add companies and modify company information. For more information, see Maintaining company 

information (data provider). 

 View log files. For more information, see View log files. 

 Design and view reports.  
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Security, user roles, and permissions 
Management Reporter uses several levels of security to help ensure that only authorized users can 

perform tasks in Management Reporter, modify the building blocks that are used for reports, and view the 

reports that are generated to the report library. 

For information about securing individual reports or folders, see Report security options. 

User security and permissions 

Users in Management Reporter are assigned to one of four roles: administrator, designer, generator, or 

viewer. Some security permissions are limited to certain roles, but you can also modify security 

permissions for individual users, or assign users to a group and then modify security for the entire user 

group. 

By default, all new users are assigned to the role of viewer. 

For more information, see Users in Management Reporter. 

Depending on the Microsoft Dynamics ERP system that you are integrating with, user roles might 

automatically be assigned, based on user permissions in the ERP database. For more information, 

see the integration guide for your Microsoft Dynamics ERP system. 

Report Designer security 

Security settings in Report Designer are managed through company access and protected building blocks. 

To access information for a specific company, you must be granted access to that company by an 

administrator in Management Reporter. For more information, see Manage access to a company and 

Reset password for company access. 

You can also protect individual building blocks from modifications by using a password. Other users 

cannot modify the protected building block, but they can still view it and use to generate reports. For 

more information, see Lock a building block. 

If you are using a reporting tree, you can restrict access to specific reporting units in the tree, and prevent 

certain users or user groups from accessing the reporting unit. For more information, see Restrict access 

to a reporting unit. 

Report library security 

In Desktop Viewer, security can be set up for individual folders, reports, and report groups in the report 

library. You can store reports in a public folder that all Management Reporter users can access, or you can 

limit folders, reports, and report groups to specific users or user groups. You can define security settings 

only for folders that you are granted access to by an administrator in Management Reporter.  

For more information, see Report library security and Change report library permissions. 

Note 
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See Also 

Reset password for company access 

Lock a building block 

Report security options 

Management Reporter administration 

Users in Management Reporter 

Security for Management Reporter ensures that only authorized users can access the program and limits 

the tasks that each user can perform. An administrator role is created at the time of installation, and the 

user assigned to the role of administrator can create and manage other users and user groups. 

To manage security for users, user groups, and companies, open Report Designer, and on the Go 

menu, click Security. 

User roles 

Users are assigned one of four roles: administrator, designer, generator, or viewer. By default, all new 

users are assigned the role of viewer. Before you set up new users, some planning is required. List the 

tasks that each user performs, and assign the role that is appropriate for each user. By default, the roles 

can perform the following tasks. 

For more information, see Manage users. 
 

Role Report Designer tasks Desktop Viewer tasks 

Administrator The administrator is allowed full access to all 

tasks in Report Designer. 

The administrator is allowed full access to all 

tasks in the Desktop Viewer. 

Designer The designer can design, generate, edit, view 

reports and report building blocks, and schedule 

when reports are generated. 

The designer can delete, edit, create folders, 

rename reports and folders, export reports, and 

view reports that the designer has been granted 

access to. 

Generator The generator can generate reports and to 

modify parameters for reports. 

The generator can create and rename folders, 

view, delete, edit, rename, and export reports 

that the generator has been granted access to. 

Viewer The viewer is not granted access to Report 

Designer. 

The viewer can view and export reports that the 

viewer has been granted access to. 

 

User groups 

You can create user groups and grant access to a company based on groups. This allows you to grant 

users access to many companies without having to change each user's permissions. You can create a 

report and select one group, instead of selecting dozens or hundreds of individual users. For example, 

Note 
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instead of selecting each manager in a company, you can create a Managers group and then add 

managers to the group. 

You can grant group access to reporting units in reporting tree definitions. You can also grant group 

access to a report library location. 

For more information, see Manage user groups. 

Permissions 

Management Reporter defines the following permissions. Each of these permissions is associated with 

one or more roles. 
 

 Permissions Description Roles Allowed 

Generate Allows you to generate reports from 

Report Designer to include all output. 

Administrator, Designer, Generator 

Exporting reports Allows you to export and print from 

Desktop Viewer. 

Administrator, Designer, Generator, 

Viewer 

Create reports Allows you to create rows, columns, 

trees, and report definitions in Report 

Designer. 

Administrator, Designer 

Report library administration in 

Management Reporter Desktop 

Viewer 

Allows modifications to the security 

settings (view, edit, create, and delete 

access) on folders, items, and report 

versions in the report library. 

Administrator 

Dimension set access Allows modifications (create, edit, 

and delete) to dimension sets, and to 

view dimension sets from the Edit 

menu while you are viewing a row 

definition. Users without this 

permission can see the list of 

dimension sets and use them in 

reports, but cannot change them. 

Administrator, Designer 

All companies access Allows you to generate reports and 

to access the data for all companies 

in Management Reporter. Users 

without this permission can be 

granted access to specific companies 

on the Company Access tab. Users 

without access to any company 

cannot log on to Management 

Reporter. 

Administrator 
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 Permissions Description Roles Allowed 

Company administration Allows modifications (create, edit, 

and delete) to companies, and to 

view companies from the Company 

menu. Users without this permission 

can see the list of companies, but 

cannot change them. 

Administrator 

Building block administration Allows modifications (create, edit, 

and delete) to building block groups 

and to view building block groups 

from the Company menu. Users 

without this permission can see the 

list of building blocks, but cannot 

change them. 

Administrator, Designer 

Security administration Allows modifications (view, edit, 

create, and delete for users, groups, 

and companies) to security settings 

in Report Designer. 

Administrator 

Undo building block checkout Allows you to undo a building block 

checkout and to view the list of 

building block checkouts from the 

Tools menu. Users without this 

permission can see the list of 

building block checkouts, but cannot 

change them. 

Administrator 

Unprotect protected building blocks Allows you to unprotect building 

blocks and to unprotect the building 

blocks from the Tools menu while 

you are viewing a building block. 

Users without this permission can 

protect a building block that they 

have modification access to, but they 

cannot unprotect any building 

blocks. 

Administrator 

Report queue administration Allows you to clear and view all 

reports in the Report Queue Status 

dialog box. 

Administrator 

 

See Also 

Security, user roles, and permissions 

Management Reporter administration 
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Manage users 

You must have the role of administrator to create user accounts and assign the appropriate permissions 

for a user’s work functions, add a user to a group, and provide access to specific companies. The 

administrator can also inactivate or delete a user account. 

Windows
®

 authentication verifies a user’s existing Windows credentials to allow access to Management 

Reporter. Rather than entering a user name and password, a user can click OK in the connection dialog 

box.  

Two levels of security are used in Management Reporter. Management Reporter always refers to a 

user’s Windows authentication when security is discussed. Windows users are added, as allowed, 

to use the application. However, to log on to a company and access the data that is needed to 

create reports, a user must also be set up as a valid user in the Microsoft Dynamics ERP system. 

Create a user account 

A user cannot use Management Reporter until they are set up as a valid user. As part of Management 

Reporter security, an administrator must assign a role for a user before the user can generate or view 

reports within Management Reporter. For more information about roles, see Users in Management 

Reporter. 

Some data provider integrations can create user accounts in Management Reporter based on user 

permissions in the Microsoft Dynamics ERP system. For more information about user roles and 

data integrations, see the data integration guide (http://go.microsoft.com/fwlink/?LinkID=162565) 

for your Microsoft Dynamics ERP system.  

1. Open Report Designer. On the File menu, click New, and then click User to open the New User 

dialog box. You can also select Security in the navigation pane, right-click in the results pane, and 

then select New User. 

2. On the General tab, in the User name field, type the domain and user name of the user to add, or 

click Search to browse for users. 

3. In the Management Reporter assigned role field, select a role for the user in Management Reporter. 

For more information about roles, see Users in Management Reporter. 

4. To grant permission to modify building blocks that are part of a report schedule, select the Edit 

scheduled building blocks check box. 

5. To add this user to a group, click the Groups tab. In the Member of list, select the Access check box 

next to the group name or names to associate with this user. To remove access, clear the Access 

check box or boxes. 

6. To grant access to companies, click the Company Access tab. In the Access column, select the check 

box next to each company that the user should have access to. The Inherited from group check box 

indicates any companies that the user inherits access to based on the user group settings.  

7. Click OK to save the new user settings. 

Security Note 

Note 

http://go.microsoft.com/fwlink/?LinkID=162565
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Modify a user account  

1. Open Report Designer. In the navigation pane, click Security, and then click Users. 

2. Right-click a user name and select Modify User to open the Modify User dialog box. 

3. Change the appropriate settings. 

4. Click OK. 

Inactivate a user account 

You can inactivate a user account without deleting the user information in Management Reporter. This 

can be helpful if you have a limited number of Management Reporter licenses and you want to 

temporarily allow access to another user. 

1. Open Report Designer. In the navigation pane, click Security, and then click Users. 

2. Right-click a user name and select Modify User to open the Modify User dialog box. 

3. On the General tab, select the Account is disabled check box. 

4. Click OK. 

Delete a user account 

1. Open Report Designer. In the navigation pane, click Security, and then click Users. 

2. Right-click a user name, and then select Delete. 

3. Click Yes to permanently delete the user account. 

See Also 

Manage user groups 

Manage access to a company 

Security, user roles, and permissions 

Management Reporter administration 

Manage user groups 

Assigning users to a group allows a Management Reporter administrator to create access settings that are 

tailored to specific work functions. Members of a user group inherit the permissions assigned to the 

group. This approach helps to minimize the maintenance activities for user accounts. 

The administrator can use groups to prevent or permit user access to certain companies or 

specific folders or sets of data within the report library. 

Create a group 

1. Open Report Designer. On the File menu, click New, and then click Group.  

2. Enter a unique name and description for the user group.  

3. To add a user to the group, click Add, and then select the users to add to the group. To select more 

than one name, hold down the Ctrl key as you select user names. 

Security Note 
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4. To select group access to companies, click the Company Access tab, and then select the Access 

check box for each company that members of the group should have access to. All users in a group 

inherit access to the selected companies. 

5. Click OK to save the group settings. 

Modify a group 

1. Open Report Designer. In the navigation pane, click Security, and then click Groups. 

2. Double-click a group name to open it. 

3. Modify any settings. 

4. Click OK to save the group settings. 

Delete a group 

1. Open Report Designer. In the navigation pane, click Security, and then click Groups. 

2. Right-click a group name, and then click Delete. 

3. Click Yes to permanently delete the group. 

 

See Also 

Manage users 

Manage access to a company 

Report library security 

Security, user roles, and permissions 

Management Reporter administration 

Report library security 

To maintain report library security, by default, only users who have the role of administrator can generate 

or view reports in the root library folder. Other users and groups must be granted permission to view, 

create, edit and delete an item in the report library. You must have the role of administrator to grant or 

modify these user and group permissions. For more information about how to change user and group 

permissions to the report library, see Change report library permissions.  

Because all users are assigned to the Public folder, the administrator can change the default location of 

generated reports to be the Public folder, instead of granting various permissions to each user and group 

for access to the report library folder. For more information, see Everyone group and Public folder. 

For more information about what a user may see in the report library at different security levels, see 

MSDN Blog (Dynamics Corporate Performance Management) 

(http://blogs.msdn.com/b/dynamicscpm/archive/2010/12/07/management-reporter-get-more-out-of-

security-using-reporting-tree-and-report-library-security.aspx). 

Security and user groups 

When validating a user’s access to a folder or report, the user’s group memberships are considered. For 

example, if you grant access to a report in the library to a group, and then later add users to the group, 

http://blogs.msdn.com/b/dynamicscpm/archive/2010/12/07/management-reporter-get-more-out-of-security-using-reporting-tree-and-report-library-security.aspx
http://blogs.msdn.com/b/dynamicscpm/archive/2010/12/07/management-reporter-get-more-out-of-security-using-reporting-tree-and-report-library-security.aspx
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the new users will gain access to the existing report. Alternatively, if a user is removed from a group, that 

user will no longer have access to the report that is provided by the security group. For more information 

about how to add and delete users and groups, see Manage users and Manage user groups. 

Everyone group and Public folder 

By default, new users are added to the Everyone group. This is a system group and cannot be modified. 

There is also a Public folder that can be accessed by all users who are included in the Everyone group. By 

default, generated reports are sent to the report library. Users can change to this public folder location to 

generate reports because all users have access to it. If the Public folder is not used, it can be renamed or 

deleted. 

Granting permissions 

A user with the role of administrator can grant a user or a group permissions to all of the report library, or 

permissions to specific folders, reports, report versions, or external documents. If you grant permissions to 

all of the report library, those permissions cascade down into all folders, reports, and external documents 

in the report library. Similarly, if you grant permissions to a folder, those permissions cascade down into 

the subfolders, reports, report versions, and external documents for the folder. 

Access to some menu commands in Desktop Viewer requires a combination of the correct Management 

Reporter role and the correct permission on the folder in the report library. 

By default, the report library and all its folders and subfolders are visible to all Management Reporter 

users. Even though all users can see the names of all folders and subfolders in the report library, users can 

open and view only the reports and documents that they have view permissions for. 

For reporting trees, report library security works together with unit security. For example, if you grant user 

permissions to individual units in a reporting tree in Report Designer, that user is automatically granted 

permission to that report in the report library. In other words, if you grant permissions to a reporting tree 

in Report Designer, you do not have to grant those permissions again after the report is generated. 

For details about how to change user and group permissions, see Change report library permissions. 

Show Inherited Permissions option 

The Report Library Permissions dialog box, which an administrator modifies to grant user and group 

view, edit, create, and delete permissions to report library objects, has an option called Show inherited 

permissions. This option shows or hides permissions that are inherited by the selected item, such as a 

report library folder, report, report version, or external document. 

When the Show inherited permissions option is not selected, only permissions granted specifically for 

the selected object appear. 

When the Show inherited permissions option is selected, permissions granted specifically for the 

selected report or item appear, in addition to permissions that have been inherited from a group, role, or 

folder. If permission is inherited from more than one folder, each folder location is displayed separately. 

For more information about how to access the Report Library Permissions dialog box, see Change 

report library permissions. 
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See Also 

Security, user roles, and permissions 

Management Reporter administration 

Change report library permissions 

To give access to the contents of the report library to a user or a user group, you must have the role of 

administrator within Management Reporter. The administrator can grant View, Create, Edit, and Delete 

permissions for the entire report library or for just an item within it, such as a folder, a report, a version of 

a report, or an external document to users.  

Add report library permissions to a user or group 

1. In Desktop Viewer, click Report Library in the navigation pane. 

2. Open the Report Library Permissions dialog box in one of the following ways:  

 Right-click a report library item, such as a report, and then click Report Library Permissions. 

 Click the permissions icon in toolbar. 

 On Tools menu, click Report Library Permissions. 

3. In the Report Library Permissions dialog box, select Show inherited permissions to view inherited 

permissions from the report library or other library items. 

4. In the upper pane, select the report or document to modify permissions for.  

5. Click Add. 

6. In the Add Users or Groups dialog box, select the user or user group to add. To select more than one 

user or group, press Ctrl as you select users or groups.  

If a user or group does not appear in the Add Users and Groups dialog box, use 

Management Reporter security to add the user, and then return to Desktop Viewer to add 

permissions for the users and groups. For more information, see Manage users and Manage 

user groups.  

7. Click OK to close the Add Users or Groups dialog box. 

8. To modify the View, Edit, Create, or Delete permissions for individual users or groups, select or clear 

those options for a user or group in the lower pane of the Report Library Permissions dialog box. 

Some permissions are defined by default, depending on the user's assigned role. These options 

cannot be changed. For more information about user roles, see Users in Management Reporter. 

Modify report library permissions from a user or group 

1. In Desktop Viewer, click Report Library in the navigation pane.  

2. Right-click a report library item, such as a report, and then click Report Library Permissions.  

3. To view inherited permissions, select Show inherited permissions. 

Note 

Note 
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4. To modify access to one item in the report library, select the item in the upper pane of the Report 

Library Permissions dialog box, and make the appropriate modifications to the users and groups 

listed in the lower pane. 

5. To modify access to all of the contents of the report library, select Library in the upper pane, and 

make the appropriate modifications to the users and groups listed in the lower pane. 

6. To remove access to an item in the report library, select the item in the upper pane. The users and 

groups that have permission to that report are displayed in the lower pane. Select a user or group in 

the lower pane, and then click Remove.  

 A remove verification message is displayed. Click OK to remove the permission for the user or group. 

7. Click OK to close the Report Library Permissions dialog box and save settings. 

See Also 

Report library security 

Organize reports 

Security, user roles, and permissions 

Management Reporter administration 

Reset password for company access 

Depending on your company’s security policy, administrators often set an expiration date for a user’s 

password. If the credentials that you use to access company data have expired, or you save your 

credentials to access company data and must refresh those credentials, you must enter the credentials for 

that company again.  

Reset your password for company access 

1. Open Report Designer. From the Company menu, select Companies.  

2. In the Companies dialog box, click the company name, and then click Credentials. 

3. In the Connect to dialog box, type the user name and password. To avoid having to enter these 

credentials every time that you log on to a company, select Save my credentials. 

4. Click OK. 

See Also 

Change report library permissions 

Lock a building block 

Security, user roles, and permissions 

Management Reporter administration 

Lock a building block 

You can create a password to protect and lock a building block. Doing so adds a level of security to a 

report component without securing the entire system. This can protect building block information that is 

very important to your month-end reporting process. 
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A user in any role can protect a building block; however, a protected component is always available to 

users in a read-only capacity. Users can open, change, and save the protected component with a new 

name. A user who has the role of administrator can always access and change a protected building block. 

To use the locking function from any report building block, click the Protect/Unprotect icon in the 

toolbar. 

Protect a building block 

1. In Report Designer, open the report component to protect, such as a row definition, column 

definition, report definition, or reporting tree definition. 

2. In the menu, click the Protect/Unprotect icon to open the Protect dialog box. 

3. Type and confirm a password, and then click OK. 

See Also 

Report library security 

Security, user roles, and permissions 

Management Reporter administration 
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Maintaining company information (data provider) 
The data provider is the mechanism used to access data from the Microsoft Dynamics ERP system. When 

a company is imported into Management Reporter, it is associated with the company data in the 

Microsoft Dynamics ERP system. You must specify a default company, which is the company whose data is 

accessed when you create and generate reports. Additional companies can be defined, as needed. 

Create a company profile 

To access company information in Management Reporter, the company must be imported from the 

Microsoft Dynamics ERP system into Management Reporter. Only a Management Reporter administrator 

can import company information. 

For more information about importing company information, and for import procedures, see the 

Management Reporter installation guide (http://go.microsoft.com/fwlink/?LinkID=162565) and the data 

integration guide (http://go.microsoft.com/fwlink/?LinkID=162565) for your Microsoft Dynamics ERP 

system.  

Modify a company profile 

1. Open Report Designer. On the Company menu, click Companies. 

2. In the Companies dialog box, select a company, and then click Modify. 

3. In the Modify Company dialog box, change the values of the settings, as needed. For information 

about the company information settings, see Description of company definitions. 

4. Click OK to return to the Companies dialog box, and then click Close. 

Management Reporter automatically saves the company information when you close the 

Companies dialog box. 

Description of company definitions 

The following table describes the fields that are displayed in the company definition. 
 

Field Description 

Company name A unique name for the company. This name can be printed on reports.  

This field is based on the company information in the Microsoft Dynamics ERP source 

system and cannot be modified. 

Company description A short description of the company. This description can be printed on reports.  

This field is based on the company information in the Microsoft Dynamics ERP source 

system and cannot be modified. 

Source system The Microsoft Dynamics ERP system that provides real-time financial data that is 

associated with the company. 

Note 

http://go.microsoft.com/fwlink/?LinkID=162565
http://go.microsoft.com/fwlink/?LinkID=162565
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Field Description 

Building block group A collection of definitions for rows, columns, reporting trees, dimension sets, and 

reports. Each Management Reporter company can have its own building block group, 

or several companies can share a building block group. For information about building 

block groups, see Create and assign a building block group. 

Regional options The regional value identifies the region and currency symbol that is used to display the 

monetary amounts for the company. The currency symbol is the default symbol for the 

company and is used for every amount. A row or column definition can be used to 

override the symbol for an amount. 

Period description The period description appears in the header of a report. For example, if you enter 

Month Ending in the Period description box, the report header for December 2011 

would be For the Month Ending December 31, 2011. 

If you enter the description in uppercase, the whole date line is printed in uppercase in 

the report. 

Note 

Management Reporter accesses the regional settings of the Windows 

operating system for the period description information. For example, if you 

specify AutoText of @DateLong and the day of the week is displayed in your 

report headers but you do not want to display the day of the week, you must 

change the operating system regional settings and remove dddd (day of the 

week) from the Long Date definition. 

Period description (plural) The plural period description appears in the headers of reports that cover multiple 

reporting periods. For example, if you enter Months Ending in the Period description 

(plural) field, the report header for March 2012 would be For the Three Months 

Ending March 31, 2012. 

XBRL entity The XBRL entity specified is used to create an XBRL instance document. For more 

information about XBRL entities, see Create and maintain XBRL entities. 

 

See Also 

Select a default company 

Management Reporter administration 
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Select a default company 

If you have multiple company profiles, you must select one of the companies as the default company. 

Management Reporter uses the data files and the appropriate general ledger data from the default 

company to build row definitions, column definitions, reporting tree definitions, and to generate financial 

reports. By default, the company description in the report definition appears on all reports that are 

created in Management Reporter. 

A company cannot be selected as a default company until you have configured your Microsoft 

Dynamics ERP system. For more information about configuring the connection to your system, 

see the data provider documentation for your Microsoft Dynamics ERP system. 

Select a default company 

1. In Report Designer, close all building block definition windows that are open. 

2. On the Company menu, click Companies. 

The Companies dialog box displays a list of existing companies. 

3. Select a company, and then click Set As Default. A check mark appears next to the default company. 

If an existing company does not appear in the Companies dialog box, you do not have 

permission to access that company. 

See Also 

Maintaining company information (data provider) 

Management Reporter administration 

Manage access to a company 

A user who has an administrator role can grant or deny access to companies in Management Reporter. 

Granting or denying access in Management Reporter only prevents users from logging into a 

company or generating report data from a company in Management Reporter. Your Microsoft 

Dynamics ERP system may also have additional security measures to grant or prevent access to 

this data. 

Note 

Note 

Security Note 
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Manage user and group access to a company 

1. Open Report Designer. In the navigation pane, click Security, and then click Companies. 

2. Double-click a company name to open the Modify Company Access dialog box. 

 To add a user or group, click Add. In the Add Users and Groups dialog box, select one or more 

users or groups. To select more than one user or group name, hold down the Ctrl key as you 

select the user or group name. 

 To remove a user, select the user name, and then click Remove. 

3. Click OK. 

You can also set up multiple groups to manage security. A group can be used to manage multiple 

users who have access to specific companies or to specific groups of companies. For more 

information, see Manage user groups. 

See Also 

Security, user roles, and permissions 

Report library security 

Management Reporter administration 

 

Tip 



Management Reporter for Microsoft Dynamics ERP 

Management Reporter User Guide 25 

View log files 
Management Reporter provides client and server logs to disk and to Windows Event Viewer so your IT 

support staff can analyze technical information and troubleshoot error messages. The logs display error 

messages about the system, such as building blocks that were not imported, and provide details and 

direction regarding errors that occur in the application. Log files can be viewed in Windows Event Viewer 

or in Windows Explorer. 

To open log files in Windows Event Viewer, click Start, select Control Panel, select System and Security, 

select Administrative Tools, and then select Event Viewer. In the navigation pane, expand the 

Applications and Services Logs node to locate Management Reporter log files. 

In Windows Explorer, the log files are stored in the following location: 

C:\Users\UserName\AppData\Local\Microsoft\Management Reporter. If the AppData folder is not displayed, 

click Organize in Windows Explorer, select Folder and search options, and then click the View tab. In the 

Advanced settings section of the Folder Options window, select Show hidden files, folder, and drives, 

and then click OK. 

Log files 

The following log files are created on the client computer as a result of activity in Report Designer, 

Desktop Viewer, and the migration process on the client computer. 
 

Log file Description Location  

Report Designer  The Report Designer log file 

contains detailed information 

about errors encountered 

regarding the administration 

of users and of the reports 

you created. 

C:\Users\UserName\AppData\Local\Microsoft\Management 

Reporter\ManagementReporterDesigner.log 

Desktop Viewer  The Desktop Viewer log file 

contains detailed information 

about errors that occur as 

you are using Desktop 

Viewer. 

C:\Users\UserName\AppData\Local\Microsoft\Management 

Reporter\ManagementReporterViewer.log 
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Log file Description Location  

Migration  The Management Reporter 

migration log file contains 

details about all migration 

stages and steps. This 

includes messages about 

errors that occurred during 

the migration process. 

This log file is created only if 

you have migrated data from 

Microsoft FRx
®

. For more 

information, see Migrating 

from Microsoft FRx to 

Management Reporter. 

C:\Users\UserName\AppData\Local\Microsoft\Management 

Reporter\ManagementReporterMigration.log 

 

 Additional log files for the application service and process service are located on the server where 

Management Reporter is installed.  

See Also 

Management Reporter administration 
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Building blocks and reports 

The design philosophy behind Management Reporter is to break information down to the smallest 

component or building block, and then mix and match components, as needed. Therefore, your report 

formatting is completely separate from your financial data. As a result, you can change the design of a 

report without modifying the financial data in your Microsoft Dynamics ERP system. 

By using this building block approach, you can combine text, amounts, calculations, and to produce the 

reports that you need. Equally important, this flexibility encourages creativity by making it easy for you to 

look at your operations in different ways. 

The individual building blocks of a report definition work something like a three-dimensional spreadsheet, 

but with more power. A report definition specifies the row definition, column definition, and optional 

reporting tree definition to use for the report. It also includes information about where to store the 

generated report and how to format it. 

For greater reusability and sharing, you can also create a building block group, which is a collection of 

existing report definitions, row definitions, column definitions, reporting tree definitions, and dimension 

sets that are associated with a company in Management Reporter.  

 Building blocks of a report 

 Building block groups. 
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Building blocks of a report 
 

Building Block Description 

Row definition A row definition defines the descriptive lines, for example, salaries or sales, on a report. It 

also lists the segment values or dimensions that contain the values for each line item and 

includes row formatting and calculations. 

Column definition A column definition defines the period to use when extracting data from the financial 

dimensions. It also includes column formatting and calculations. 

Reporting tree definition A reporting tree definition is similar to an organizational chart. It contains individual 

reporting units that represent each box in the chart. The units can be either individual 

departments from the financial data or higher-level units that summarize data from other 

reporting units. 

Report definition A report definition uses a row definition, a column definition, and an optional reporting 

tree definition to build a report. It also provides additional options and settings to 

customize a report. 

 

If you are new to designing reports, it is helpful to use the report wizard to quickly create a report 

definition that you can customize later. If you have experience designing reports and want more flexibility 

for report design, you can combine new or existing building blocks to create a new report definition. 

You do not have to fully understand all available report definition options to produce quality reports. As 

you become familiar with designing reports, you can expand your report definitions to take advantage of 

more advanced features.  

After you have created a basic report, you can customize the report definition and any of the building 

blocks in the report definition. 

See Also 
Building block groups 

Create and manage report groups 

Building blocks and reports 
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Building block groups 
Building blocks are the row definitions, column definitions, reporting tree definitions, and report 

definitions that you create for a report. Building block groups are collections of the definitions and 

dimension sets that are associated with a company. Companies in Management Reporter can share 

building block groups, or each company can have a unique building block group assignment.  

 Create and assign a building block group 

 Maintain building block groups 

Create and assign a building block group 

Building blocks are the row definitions, column definitions, reporting tree definitions, and report 

definitions that you create for a report. Building block groups are collections of the definitions and 

dimension sets that are associated with a company in Management Reporter. Building block groups can 

be company specific, or several companies can share the same set of building blocks. If you have 

companies that have a different chart of accounts, you may consider using a different building block 

group per company. Alternatively, you can consider naming all of your individual building blocks to reflect 

with which company they are compatible. 

Create a building block group 

1. In Report Designer, on the Company menu, click Building block groups. 

2. In the Building block groups dialog box, click New. 

3. Enter a unique name and description for the building block group. Each field can contain a maximum 

of 256 characters, including spaces. 

4. Click OK to create the new building block group. 

Assign a building block group 

After you a create block group, you must assign it to a company or companies in order to be used. You 

can then create report, row, column, and reporting tree definitions and save them within the building 

block group. 

1. In Report Designer, on the Company menu, click Companies. 

2. In the Companies dialog box, select the company to assign a building block group to. 

3. Click Modify. 

4. In the Modify Company dialog box, in the Building block group field, select the building block 

group to assign to the company, or click New to create a new building block group. 

5. Click OK to assign the building block group. 

6. Click Close to exit the Modify Company dialog box. The building block group that you selected in 

step 4 is now assigned to the company. 

See Also 

Maintain building block groups 
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Maintain building block groups 

After a building block group is created and used, you can view all the building blocks assigned to a group, 

export or import a building block group, and perform additional maintenance on the building block 

groups.    

View a building block group 

You can view an existing building block group and examine its contents to determine if it meets your 

needs to create a report. 

1. In Report Designer, on the Company menu, click Building Block Groups. 

2. In the Building Block Groups dialog box, select the building block to view. Click View to open the 

View Building Block Group dialog box and view the contents of the building block group. 

3. Click Close to close the dialog boxes. 

Save a building block group with a new name 

You can save an existing building block group with a new name. Then you can modify the new building 

block group without changing the original building block group. 

1. In Report Designer, on the Company menu, click Building Block Groups. 

2. In the Building Block Groups dialog box, select the building block group to save with a new name. 

3. Click Save As. 

4. Enter a new name and description for the building block group. 

5. Click OK. The new building block group should appear in the Building Block Groups dialog box.  

Export a building block group 

You can export an entire building block group or specific report building blocks in a building block group 

for backup purposes or to be copied between building block groups or Management Reporter 

installations. Management Reporter includes the referenced font styles and dimension sets with the 

building block group. 

1. In Report Designer, on the Company menu, click Building Block Groups. 

2. In the Building Block Groups dialog box, select the building block group to export, and then click 

Export.  

3. In the Export dialog box, select the report definitions to export:  

 To export all of your report definitions and the associated building blocks, click Select All. 

 To export specific reports, rows, columns, trees, or dimension sets, click the appropriate tab and 

select the items to export. Press and hold the Ctrl key to select multiple items within a tab.  

When you select reports to export, the associated rows, columns, trees, and dimension 

sets are selected. 

4. When you have finished selecting items to export, click Export. 

5. In the Save As dialog box, select a location to export the building block group to. 

Note 
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6. In the File Name field, enter a name for the file. Management Reporter automatically adds a .tdbx file 

extension. 

7. Click Save. The building block group is saved to the location specified in step 5.  

Import a building block group 

You can import a building block group into an existing building block group, or you can create a new 

building block group for the data. For more information about how to create a new building block group, 

see Create and assign a building block group. All imported building block groups retain their original font 

styles and company references and include the relevant dimension sets. 

1. In Report Designer, on the Company menu, click Building Block Groups. 

2. In the Building Block Groups dialog box, select the building block to import a building block group 

into, and then click Import. 

3. In the Open dialog box, select the building block group to import, and then click Open.  

4. In the Import dialog box, select the report definitions to import: 

 To import all of the report definitions and the supporting building blocks, click Select All. 

 To import specific reports, rows, columns, trees, or dimension sets, select the reports, rows, 

columns, trees, or dimension sets to import. 

5. When you have finished selecting items to import, click Import. 

Undo the checkout of a building block 

When you open a building block, other users can only access that building block in read-only mode. 

Sometimes a user will forget to close a building block or will shut down their system without closing the 

building block. As a result, the building block is checked out and other users cannot open it. In these 

situations, a Management Reporter administrator can use the Checked Out Items dialog box to check in 

building blocks that any user has left in a checked out status. 

You must have the role of administrator to check in building blocks from the Checked Out Items 

dialog box. 

1. In Report Designer, on the Tools menu, click Checked Out Items.  

2. In the Checked Out Items dialog box, select Show items from all users. The list is updated to 

display all building blocks that are checked out and the users who have checked them out. 

3. Select a building block, and then click Undo Checkout. 

4. Click Yes to check in the building block.  

See Also 

Create and assign a building block group 

Lock a building block 

Select report building blocks in report definition 

Building blocks and reports 

Note 
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Row definitions 

A row definition is a report component, also called a building block, which specifies the contents of each 

row in a Management Reporter report. It can be combined with column definitions, reporting tree 

definitions, and report definitions to create a building block group that can be used by multiple 

companies. For more information about building block groups, see Building block groups. 

 Contents of a row definition 

 Row definition cells 
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Contents of a row definition 
A row definition can contain up to 20,000 financial dimension rows and includes the following 

information: 

 Descriptive text that adds meaning to the report by creating section headings, lines, and spaces, such 

as Cash or Total Revenue. 

 Links to financial data, which can include dimension values in the Microsoft Dynamics ERP system or 

cells in an Excel spreadsheet. 

You can set up a row definition to pull data from the financial dimensions system every time 

that the report is generated.  

 Row totals and formulas that are based on the linked financial data. 

Usually, each row in a row definition contains one of the following types of information: 

 References to the financial dimensions system. 

 Totals or calculations based on the data. 

 Formatting. 

You can enter information into a row definition in one of the following ways: 

 Enter row information manually into a new row definition. For details about the information to add to 

each cell, see Row definition cells. 

 Use Management Reporter to pull row information directly from the financial dimensions as described 

in the following topics: 

o Related formulas/rows/units 

o Format row and column text 

Open a row definition 
1. Open Report Designer. In the navigation pane, click Row Definition. 

2. Double-click the name of the report or object to open. For information about the elements of a row 

definition, see Contents of a row definition. 

Create a row definition 
1. Open Report Designer. In the navigation pane, click Row Definition. 

2. From the File menu, click New, and then select Row Definition. For more information about the 

content of each cell, see Row definition cells. 

 

Note 
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Row definition cells 
The topics in this section describe the information required for each cell within a row definition and how 

to enter it. 

 Specify a row code in row definition 

 Description cell in row definition 

 Add a format code 

 Related formulas/rows/units 

 Select Format Override cell in row definition 

 Change Normal Balance cell in row definition 

 Select print control in row definition 

 Column Restriction cell in row definitions 

 Row modifier in row definitions 

 Link to Financial Dimensions cell 

Specify a row code in row definition 

In row definitions, the numbers or labels in the Row Code cell identify each line in the row definition.  You 

can specify the row code to refer to data in calculations and totals. 

Row code requirements 

A row code is required for all rows. You can mix numeric, alphanumeric, and unset (empty) row codes 

within a row definition. 

The row code can be any positive integer (below 100,000,000) or a descriptive label that identifies that 

row. A descriptive label must adhere to the following rules: 

 A descriptive label must begin with an alphabetical character (a through z or A through Z) and can be 

any combination of numbers and letters up to 16 characters. 

A descriptive label can use the underscore (_) character, but no other special characters are 

allowed. 

 A descriptive label cannot use any of the following reserved words: AND, OR, IF, THEN, ELSE, PERIODS, 

TO, BASEROW, UNIT, NULL, or CPO, RPO. 

The following are examples of valid row codes: 

 320 

 TL_NET_INCOME 

 TL_NET_94 

Note 
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Specify a row code in a row definition 

To specify a row code, open a row definition in Report Designer, and then type the new value into the cell 

in the Row Code column. 

To reset numeric row codes, complete the following steps: 

1. In Report Designer, click Row Definitions, and then open the row definition to modify.  

2. On the Edit menu, and click Renumber Rows. 

3. Specify the new values for starting row code and row code increment. 

When you renumber row codes, Management Reporter automatically updates TOT and CAL 

references. For example, if a TOT row refers to a range that starts with row code 100 and you 

renumber starting with 90, the starting TOT reference changes from 100 to 90. 

You can reset the numeric row codes to equally spaced values. Management Reporter renumbers row 

codes that begin with numbers, for example, 130, 246, but does not renumber row codes that begin with 

letters, for example, INCOME_93, TP0693. 

See Also 

Contents of a row definition 

Row definitions 

Description cell in row definition 

The description cell provides the description of the financial data in the row of the report, such as 

Revenue or Net Income. The text in the Description cell appears on the report exactly as you type it in the 

row definition. 

The width of the description column in the report is set in the column definition. If the text in the 

row definition Description column is long, verify the width of the DESC column. For more 

information, see Add special formatting options. 

When you use the Insert Rows from dialog box, the values in the Description column are the segment 

values or dimension values from the financial data. You can insert rows to add descriptive text, such as a 

section heading or a section total, and to add formatting, such as a line before a total row. 

If the report includes a reporting tree, you can include the additional text that is defined for the reporting 

units in the reporting tree, and you can restrict the use of the additional text to a specific reporting unit. 

For information about how to create additional text entries in a reporting tree, see Build a reporting tree 

definition. 

Add the description for a line in a report 

1. In Report Designer, click Row Definitions, and then select a row definition to modify. 

2. Select the Description cell, and then type the name of the report row. 

3. Apply formatting. For more information, see Manage font styles. 

Note 

Note 
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Add additional text from a reporting tree in the description 

1. In Report Designer, click Row Definitions, and then select a row definition to modify. 

2. Type the additional text code and any other text into the Description cell. 

3. Apply formatting. For more information, see Manage font styles. 

The format of the additional text code is @UnitText#, where # specifies which additional text entry to 

extract from the reporting tree. The possible values depend on the number of additional text entries that 

are defined for a reporting unit. 

For example, @UnitText4 specifies the fourth additional text entry for the reporting unit. 

Restrict the additional text to a specific reporting unit 

1. In Report Designer, click Row Definitions, and then select a row definition to modify. 

2. Locate the row where additional text should be created, and then double-click the cell in the Related 

Formulas/Rows/Units column. 

3. In the Reporting Unit Selection dialog box, select a reporting tree in the Reporting tree field. 

4. In the Select reporting unit for restriction box, expand or collapse the reporting tree, and then 

select a reporting unit. 

See Also 

Related formulas/rows/units 

Specify a row code in row definition 

Contents of a row definition 

Row definitions 

Add a format code 

The Format Code cell offers a selection of preformatted choices for the content of that row. If the Format 

Code cell is blank, the row is interpreted as a financial data detail row. 

If a report contains non-amount formatting rows that relate to amount rows that have been 

suppressed, for example, because of zero balances, you can suppress the printing of title and 

format rows by using the Related Formulas/Rows/Units column. For more information, see 

Relate a format row to an amount row. 

Note 
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Add a format code to a report row 

1. In Report Designer, click Row Definitions, and then select a row definition to modify. 

2. Double-click the Format Code cell. 

3. Select a format code from the list. For a list of format codes and their actions, see the following table: 
 

Format Code Interpretation of Format Code Action 

(none)  Clears the Format Code cell. 

TOT Total Identify a row that uses mathematical operators in the Related 

Formulas/Rows/Units column. Totals contain simple operators, 

for example, + or -. 

For more information, see Use a row total in a row definition. 

CAL Calculation Identify a row that uses mathematical operators in the Related 

Formulas/Rows/Units column. Calculations contain complex 

operators, for example, +, -, *, /, and IF/THEN/ELSE statements. 

For more information, see Use a calculation formula in row 

definition. 

DES Description Identifies a heading line or an empty line in a report. 

LFT 

RGT 

CEN 

Left 

Right 

Center 

Aligns the row description text on the report page, regardless of 

its placement in the column definition. 

CBR Change Base Row Identifies a row that sets the base row for column calculations. 

For more information, see Select the base row for a column 

calculation. 

PAGE Page Starts a new report page. 

--- Single underline Places a single line under all amount columns in the report. 

=== Double underline Places a double line under all amount columns in the report. 

LINE1 Thin line Draws a single thin line across the page. 

LINE2 Thick line Draws a single thick line across the page. 

LINE3 Dotted line Draws a single dotted line across the page. 

LINE4 Thick line and thin line Draws two lines that appear as thick line followed by a thin line 

across the page. 

LINE5 Thin line and thick line Draws two lines that appear as a thin line followed by a thick 

line across the page. 

BXB 

BXC 

Boxed row Draw a box around the report rows that begin with the BXB row 

and end with the BXC row. 
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Format Code Interpretation of Format Code Action 

REM Remark Identifies a row that is a comment row and should not be 

printed on the report. For example, a remark row might explain 

your formatting techniques. 

SORT 

ASORT 

SORTDESC 

ASORTDESC 

Sort Sorts expenses or revenues, sequences an actual or budget 

variance report by the largest variance, or sorts the row 

descriptions alphabetically. For more information about the 

sorting format codes, see Select a sorting code for a row 

definition. 

 

See Also 

Select Format Override cell in row definition 

Change Normal Balance cell in row definition 

Select print control in row definition 

Specify a row code in row definition 

Row modifier in row definitions 

Contents of a row definition 

Row definitions 

Related formulas/rows/units 

The Related Formulas/Rows/Units cell has multiple purposes. Depending on the type of row, a Related 

Formulas/Rows/Units cell can do one of the following functions:  

 Link a formatting row to an amount row to print the formatting only when the related amount is 

printed. For information, see Relate a format row to an amount row. 

 Restrict a row to a specific reporting unit. For information, see Restrict a row to a specific reporting 

unit. 

 Define the base row for calculations when you use the BASEROW format code. For information, see 

Select the base row for a column calculation. 

 Define the rows to sort when you use any of the sorting format codes. For information, see Select a 

sorting code for a row definition. 

 Define the rows to include in a calculation when you use a TOT format code or a CAL format code. 

See Also 

Add a format code 

Change Normal Balance cell in row definition 

Contents of a row definition 

Row definitions 



Management Reporter for Microsoft Dynamics ERP 

Management Reporter User Guide 39 

Use a row total in a row definition 

Use a row total formula to add or subtract amounts in other rows. A formula for creating a row total can 

include the + and - operators to combine individual row codes and ranges, indicated by a colon (:). The 

formula can be up to 1024 characters. 

The following is an example of a standard totaling formula: 

400+420+430+450+460LIABILITIES+EQUITY520:546520:546-LIABILITIES 

Components of a row total formula 

When you create a row total formula, you must use row codes to specify which rows to add or subtract in 

the current row definition, and use operators to specify how the rows are combined. Total rows and 

amount rows can be used in any combination. 

All total rows that are within a range are excluded. To create a grand total, you can specify the 

entire range of rows. If the first row of a range is a total, that row is included in the new total. 

The following table describes how operators are used in row total formulas:  
 

Operator Example formula Description 

+ 100+330 Adds the amount in row 100 to the amount in row 330. 

: 100:330 Sums the totals of all rows between row 100 and row 330. 

- 100-330 Subtracts the amount in row 100 from the amount in row 330. 

 

Create a row total 

1. In Report Designer, click Row Definitions, and then open the row definition to modify.  

2. Double-click the Format Code cell in the row definition, and select TOT. 

3. In the Related Formulas/Rows/Units cell, type the total formula. 

See Also 

Use a calculation formula in row definition 

Related formulas/rows/units 

Contents of a row definition 

Row definitions 

Note 
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Relate a format row to an amount row 

In the Format Code column in a row definition, the DES, LFT, RGT, CEN, ---, and === format codes apply 

formatting to non-amount rows. To avoid printing this formatting when the related amount rows are 

suppressed, because the amount rows contain zero values, you must relate the format rows to the 

corresponding amount rows. This is helpful when you want to suppress the printing of headers or 

formatting related to subtotals when there is no detail to print for the period. 

You can also suppress the detailed amount rows from printing by clearing the option to display 

rows with no amounts, which is on the Settings tab of the report definition.  

Relate a format row to an amount row 

1. In Report Designer, click Row Definitions, and then select a row definition to modify. 

2. In the Related Formulas/Rows/Units cell in the formatting row, type the row code of the amount 

row to be suppressed. 

3. On the File menu, click Save. 

Example 

In the following example, Phyllis wants to suppress printing of the heading and underscores in the Total 

Cash row in her report because there was no activity in either of the cash accounts. She types 190, the 

amount row code to be suppressed, in the Related Formulas/Rows/Units cell in row 160, which is a 

formatting row because the Format Code is ---.  
 

 
 

See Also 

Restrict a row to a specific reporting unit 

Select the base row for a column calculation 

Select a sorting code for a row definition 

Related formulas/rows/units 

Contents of a row definition 

Row definitions 

 

Note 
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Select the base row for a column calculation 

In relational reporting, one or more base rows are assigned in the row definition by using the CBR 

(Change Base Row) format code. A base row is then referenced by a calculation in the column definition. 

Common examples of CBR calculations include the following: 

 Percentage of total revenue as it relates to individual revenue items. 

 Percentage of total expense as it relates to individual expense items. 

 Percentage of gross margin as it relates to division or department details. 

One or more base rows are defined in the row definition, and then the column definition determines the 

relationship that the base row is reported on. The code used in the column formula is BASEROW. The 

following basic mathematical operators are used with BASEROW: divide, multiply, add, or subtract, 

although the most common is divide by BASEROW, where the result is displayed as a percentage. 

Column calculations that use BASEROW in the formula use the row definition for the related base row 

code(s). CBR rows have the following characteristics: 

 CBR rows are not printed on the completed report. 

 The CBR format code and its related row code are positioned above the row or section that displays 

related calculations. 

In a column definition, the CALC column type indicates a column that specifies a formula in the Formula 

row. This formula operates on the data for this column of the report and uses the Baserow keyword to 

base calculations off of the CBR format code(s) in the row. 

In the row definition, the CBR format code defines the base row for columns that calculate a percentage 

of or multiply by the base row for each row in the report. You can have multiple CBRs in a row format, 

such as one with net sales, one with gross sales, and one with total expenses. Usually, the CBR is used to 

create a percentage for accounts that are compared to a total line. A base row is used for all calculations 

until another base row is defined. You must define a starting CBR and an ending CBR. 

For example, to determine expenses as a percentage of net sales, you could divide the value in each 

expense row by the value in the net sales row. In this case, the net sales row is the base row.  

Select the base row in a row definition for a column calculation 

You can define a column definition that reports current and year-to-date results, together with a base 

percentage of each. Start with a detailed income statement. 

1. In Report Designer, click Column Definitions, and then open the column definition for an income 

statement. 

2. Add a new column to the column definition with a column type of CALC. 

3. In the Formula cell of the new column, enter the formula of X/BASEROW, where X is the FD column 

type that you want to see a percentage of. 

4. Double-click the Format/Currency Override cell to open the Format Override dialog box. Select 

Percentage in the Format Category list, and then click OK. 

5. On the File menu, click Save As to save the column definition with a new name. Append the current 

file name with CBR, such as CUR_YTD_CBR. This is your baserow column definition. 

6. In Report Designer, click Row Definitions, and then open the row definition to modify with the 

baserow calculation. Insert a new row above where the baserow calculation should start. 
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7. Double-click the Format Code cell of the row definition, and then select CBR. 

8. In the Related Formulas/Rows/Units cell, type the Row Code number for the base row.  

Example 

In the following row definition example, row 100 shows that the base row for calculations is row 340. 
 

 
 

 

In the following column definition example, the calculations use the CBR code. The calculation in column 

C has the effect of dividing the value in column B of the report by the value in row 340 of column B. The 

format override in column B prints the result of the calculation as a percentage. Similarly, each amount in 

column E is the amount in column D expressed as a percentage of net sales. 
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As a result of the previous calculations, the following sample report could be generated. 
 

 
 

See Also 

Restrict a row to a specific reporting unit 

Related formulas/rows/units 

Row definitions 

Select a sorting code for a row definition 

Sorting codes sort accounts, values, sequence an actual or budget variance report by the largest variance, 

or sort the row descriptions alphabetically. The following sorting codes are available: 

 SORT – Sorts the report in ascending order, based on the values in the specified column.  

 ASORT – Sorts the report by the absolute value of the values in the specified column in ascending 

order. In other words, the sign of each value is ignored in the sort. This format code sequences the 

values by the magnitude of the variance, whether positive or negative.  

 SORTDESC – Sorts the report in descending order, based on the values in the specified column.  

 ASORTDESC – Sorts the report in descending order by the absolute value of the values in the 

specified column.  

Specify a sorting code 

1. In Report Designer, click Row Definitions, and then open the row definition to modify. 

2. Double-click the Format Code cell, and then select a sorting code. 

3. In the Related Formulas/Rows/Units cell, type the range of row codes to sort. To specify a range, 

enter the first and last row codes separated with a colon. For example, 160:490 specifies the range 

160 through 490. 

4. In the Column Restriction cell, type the letter of the report column to be used for the sort. 

Include only amount rows in a sort calculation. 

Note 
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Example 

The following building block example shows an ascending sort on the values in column D of the report for 

rows 160 through 490. It also shows how a descending sort on the absolute values in column G of the 

report for rows 610 through 940 is set up. 
 

Row 

Code 

Description Format Code Related 

Formulas/Rows/Units 

Normal 

Balance 

Column 

Restriction 

Link to 

Financial 

Dimensions 

100 Sorted by 

Monthly 

Variance in 

Ascending 

Order 

DES         

130   SORT 160:490   D   

160 Sales     C   4100 

190 Sales Returns         4110 

  ...           

490 Interest 

Income 

    C   7000 

520   DES         

550 Sorted by YTD 

Absolute 

Variance in 

Descending 

Order 

DES         

580   ASORTDESC 610:940   G   

610 Sales     C   4100 

640 Sales Returns         4110 

  ...           

940 Interest 

Income 

    C   7000 
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The report resembles the following illustration: 
 

Variance Analysis (Sorted by Variance) 

Beijing and Atlanta Regions 

For the Seven Months Ending July 31, 2007 

 July YTD 

  Actual Budget Variance Actual Budget Variance 

Sorted by Monthly Variance in Ascending Order 

COGS 873,872 236,144 (637,728) 4,864,274 1,590,315 (3,273,959) 

Salaries and Wages 97,624 65,573 (32,051) 653,884 441,664 (212,220) 

Sales Discounts 36,383 24,152 (12,231) 241,562 162,670 (78,892) 

Sales Returns 10,917 7,246 (3,671) 62,809 48,803 (14,006) 

Rent Expense 12,052 9,019 (3,033) 80,444 60,748 (19,696) 

Office Expense 5,023 3,291 (1,732) 33,420 22,098 (11,322) 

Travel Expense 7,656 7,641 (15) 51,062 51,469 407 

Sales 1,240,119 410,389 829,730 7,139,288 2,764,549 4,374,739 

Sorted by YTD Absolute Variance in Descending Order 

Sales 1,240,119 410,389 829,730 7,139,288 2,764,549 4,374,739 

Travel Expense 7,656 7,641 (15) 51,062 51,469 407 

Office Expense 5,023 3,291 (1,732) 33,420 22,098 (11,322) 

Sales Returns 10,917 7,246 (3,671) 62,809 48,803 (14,006) 

Rent Expense 12,052 9,019 (3,033) 80,444 60,748 (19,696) 

Sales Discounts 36,383 24,152 (12,231) 241,562 162,670 (78,892) 

Salaries and Wages 97,624 65,573 (32,051) 653,884 441,664 (212,220) 

COGS 873,872 236,144 (637,728) 4,864,274 1,590,315 (3,273,959) 

 

See Also 

Relate a format row to an amount row 

Restrict a row to a specific reporting unit 

Select the base row for a column calculation 

Related formulas/rows/units 

Row definitions 
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Select Format Override cell in row definition 

The Format Override cell specifies the print format for the row. This numerical format overrides the 

formatting that is specified in the column definition and the report definition, which, by default, is 

currency. If the report lists the number of assets in one row, such as number of buildings, and their 

monetary value in another row, you can override the currency formatting and enter numeric formatting 

for the row that specifies the number of buildings. 

Specify this information in the Format Override dialog box. The available options depend on the format 

category that you select. Example formats are displayed in the Sample area of the dialog box. 

The available format categories are: 

 Currency formatting 

 Numeric formatting 

 Percentage formatting 

 Custom formatting 

Override cell formatting 

1. In Report Designer, open the row definition to modify.  

2. Double-click a cell in the Format Override column. 

3. In the Format Override dialog box, select the formatting options to use in the report. 

4. Click OK. 

Currency formatting 

Currency formatting applies to a fiscal amount and includes the currency symbol. The following options 

are available: 

 Currency symbol – The currency symbol for the report. This value overrides the Regional Options 

setting for the company information. 

 Negative numbers – Negative numbers can be displayed with the minus sign (-) or in parentheses ( ). 

 Decimal places – The number of digits to show after the decimal point. 

 Zero value override text – The text to include in the report when the amount is zero. This text 

appears as the last line in the Sample area. 

If printing is suppressed for zero values, this text is also suppressed. 

Note 
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Numeric formatting 

Numeric formatting applies to any amount and does not include a currency symbol. The following options 

are available: 

 Negative numbers – Negative numbers can be displayed with the minus sign (-) or in parentheses ( ). 

 Decimal places – The number of digits to show after the decimal point. 

 Zero value override text – The text to include in the report when the amount is zero. This text 

appears as the last line in the Sample area. 

If printing is suppressed for zero values, this text is also suppressed. 

Percentage formatting 

Percentage formatting includes the percent sign (%). The following options are available: 

 Negative numbers – Negative numbers can be displayed with the minus sign (-) or in parentheses ( ). 

 Decimal places – The number of digits to display after the decimal point. 

 Zero value override text – The text to include in the report when the amount is zero. This text 

appears as the last line in the Sample area. 

If printing is suppressed for zero values, this text is also suppressed. 

Custom formatting 

Use the custom format category to create a custom format override. The following options are available: 

 Type – The custom format. 

 Zero value override text – The text to include in the report when the amount is zero. This text 

appears as the last line in the Sample area. 

The type should represent both the positive, and then the negative value. Typically, you enter a similar 

format differentiating between positive and negative values. For example: 0.00;(0.00) 

Note 

Note 
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The following table shows custom formats that can be used to control how your values should be 

formatted. These examples start with a value of 1234.56. 
 

 Positive Negative Zero 

0 1235 -1235 0 

0;0 1235 1235 0 

0;(0);- 1235 1235 - 

#,###;(#,###);“” 1,235 (1,235) (blank) 

#,##0.00;(#,##0.00);zero 1,234.56 (1,234.56) zero 

0.00%;(0.00%) 123456.00% (123456.00%) 0.00% 

 

 

If printing is suppressed for zero values, this text is also suppressed. 

See Also 

Add a format code 

Contents of a row definition 

Row definitions 

Change Normal Balance cell in row definition 

The Normal Balance cell within a row definition controls the sign of the amounts in a row. To reverse the 

sign of a row, or if the normal balance of an account is a credit, enter a C in the Normal Balance cell for 

that row. Management Reporter for Microsoft Dynamics ERP reverses the sign on all credit balance 

accounts in that row. When Management Reporter converts these accounts, it removes the debit/credit 

characteristic from all amounts, which makes totaling very straightforward. For example, to calculate net 

income, you subtract expenses from income. 

Totaled and calculated rows typically are not affected by a C code. The exception is that the XCR print 

control in the column definition reverses the sign of any row that contains a C in the Normal Balance 

column. This formatting is especially important when you want to show all unfavorable variances as 

negative amounts. If a totaled or calculated number displays the wrong sign, place a C in the Normal 

Balance cell for the row to reverse the sign. For more information about the column definition Print 

Control, see Select print control in row definition. 

See Also 

Row modifier in row definitions 

Contents of a row definition 

Row definitions 

Note 
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Row modifier in row definitions 

The content of the Row Modifier cell in a row definition overrides the fiscal years, periods, and other 

information that is specified in the column definition for that row. The selected modifier applies to every 

account in the row. 

You can modify each row with one or more of the following types of modifiers: 

 Account modifiers 

 Book code modifiers 

 Account and transaction attributes 

Account modifiers 

Usually when you select a specific account, Management Reporter combines the account with the fiscal 

years, periods, and other information that you specify in the column definition. You can use different 

information, such as different fiscal periods, for specific rows. 

The following account modifiers are available. Replace the number sign (#) with a value equal to or less 

than the number of periods in a fiscal year. 
 

Account Modifier What is Printed 

/BB Beginning balance for an account. 

/# Balance for the specified period. 

/-# Balance for the period that is # periods before the current period. 

/+# Balance for the period that is # periods after the current period. 

/C Balance for the current period. 

/C-# Balance for the period that is # periods before the current period. 

/C+# Balance for the period that is # periods after the current period. 

/Y Year-to-date balance through the current period. 

/Y-# Year-to-date balance through the period that is # periods before the current period. 

/Y+# Year-to-date balance through the period that is # periods after the current period. 

 

Book code modifiers 

You can limit a row to an existing book code. The column definition must include at least one FD column 

with a book code. 

 The book code restriction for a row overrides the book code restrictions in the column definition 

for that row. 

Note 
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Account and transaction attributes 

Some accounting systems support account attributes and transaction attributes in the financial data. 

These attributes function like virtual account segments and can carry additional information about the 

account or transaction, which might be, for example, account ID, batch ID, postal codes, or other 

attributes. 

If your accounting system supports attributes, you can use account attributes or transaction attributes as 

row modifiers in the row definition. For information about how to override row information, see Use row 

modifier to override row information. 

For information about how to use account attributes and transaction attributes in the column definition, 

see the ATTR column type in Specify a column type in a column definition. For information about how to 

use attribute filters in the column definition, see Apply an attribute filter in a column definition. 

See Also 

Specify a row code in row definition 

Contents of a row definition 

Row definitions 

Use row modifier to override row information 

The content of the Row Modifier cell in a row definition overrides the fiscal years, periods, and other 

information that is specified in the column definition for that row. The selected modifier applies to every 

account in the row. For definitions of the options in the Row Modifier dialog box, see Row modifier in 

row definitions. 

Override row information 

When necessary, replace the number sign (#) with a numeric value. 

1. In Report Designer, open the row definition to modify.  

2. Double-click the Row Modifier cell in the row where you want to override the column definition. The 

Row Modifier dialog box opens. 

3. Select an option in the Account modifier field. For a list of options, see Account modifiers. 

4. In the Book code modifier field, select the book code to use for the row. 

5. Under Attributes, add an entry for each attribute to be included with the row code as follows: 

 Double-click the Attribute cell, and select an attribute name. 

 Double-click the From cell, and type the first value for the range. 

 Double-click the To cell, and type the final value for the range. 

6. Click OK. 

See Also 

Apply an attribute filter in a column definition 

Contents of a row definition 

Row definitions 
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Link to Financial Dimensions cell in a row definition 

The Link to Financial Dimensions cell contains links to the financial data to include in each row of a 

report. This cell contains dimension values, but you can specify cells in an Excel worksheet instead of, or in 

addition to, segment values or dimension values. For information about how to link to Excel worksheets, 

including how to change the type of link, see Link reports to Microsoft Excel.  

To open the Dimensions dialog box, double-click the Link to Financial Dimensions cell. 

Report Designer cannot select any account, dimension, or field from the Microsoft Dynamics ERP 

system that includes the following reserved characters: & * [ ]. 

To specify information for a row that is already in the row definition, add the information in the Link to 

Financial Dimensions cell. To add new rows that link to the financial data, use the Insert Rows from 

dialog box to create new rows in the report definition. 

The column title changes depending on how the column is configured, as shown in the following table. 
 

When this link type is selected The description on the Link column changes to 

Financial Dimensions Link to Financial Dimensions 

External Worksheet Link to Worksheet 

Financial Dimensions + Worksheet Link to Financial Dimensions + Worksheet 

Management Reporter Report Management Reporter Report 

 

Specify a dimension or range 

1. In Report Designer, open the row definition to modify. Double-click a cell in the Link to Financial 

Dimensions column. 

2. In the Dimensions dialog box, double-click a cell under the dimension name. 

3. In the dialog box for the dimension, select Individual or range. 

4. Enter the starting dimension in the From field, or click  to search for available dimensions. To 

enter a range of dimensions, enter the ending dimension in the To field. 

5. Click OK to close the dialog box for the dimension. The updated dimension or range is displayed in 

the Dimensions dialog box. 

6. Click OK to close the Dimensions dialog box. 

See Also 

Display zero balance accounts in a row definition 

Wildcards and ranges in row definitions 

Add or subtract from other accounts in a row definition 

Add dimension sets in a row definition 

Use additional file types with Management Reporter 

Note 
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Contents of a row definition 

Row definitions 

Display zero balance accounts in a row definition 

By default, Management Reporter suppresses the printing of any row that does not have a corresponding 

balance in the financial data. Therefore, you can create one row definition that includes all natural 

segment values or all dimension values, and then use that row definition with any of your departments. 

The following formatting settings apply to the printing of zero amounts: 

 Display blanks for zero amounts 

 Display rows with no amounts 

 Display reports with no active rows 

Modify zero balance settings 

1. In Report Designer, open the report definition to modify.  

2. Click the Settings tab. 

3. Under Other formatting, select options for the row definition that is used in the report definition. 

4. To save these options, click Save on the File menu. 

See Also 

Add or subtract from other accounts in a row definition 

Add dimension sets in a row definition 

Wildcards and ranges in row definitions 

Link to Financial Dimensions cell in a row definition 

Row definitions 

Wildcards and ranges in row definitions 

When you enter a natural segment value in the Dimensions dialog box, you can place a wildcard 

character (? or *) in any position of a segment. Management Reporter extracts all of the values for the 

defined positions without regard to the wildcard numbers. For example, if the row definition contains only 

natural segment values, assuming a four-character natural segment, entering 6??? in a row instructs 

Management Reporter to include all accounts whose natural segment value begins with a 6. Entering 6* 

would return the same results, but would also include variable width values, such as 60 and 600000. 

Management Reporter replaces each wildcard character (?) with the complete range of possible values, 

including letters and special characters. For example, in the range from 12?0 through 12?4, the wildcard 

character in 12?0 is replaced with the lowest value in the character set, and the wildcard character in 12?4 

is replaced with the highest value in the character set.  

The use of wildcard characters should be avoided for the starting and ending accounts in ranges. 

If you use wildcard characters in either the starting account or the ending account, you might 

return unexpected results. 

Note 
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Single-segment or single-dimension ranges 

You can specify a range of segment values or dimension values. The benefit of specifying a range is that 

you do not have to update the row definition every time that a new segment value or dimension value is 

added to the financial data. 

For example, the range +Account=[6100:6900] pulls the values from Account 6100 through 6900, 

inclusively, into the row amount. 

When a range includes a wildcard character (?), Management Reporter does not evaluate the range on a 

character-by-character basis. Instead, the low and high ends of the range are determined, and then all 

values between those ends are included, inclusive.  

Report Designer is unable to select any account, dimension, or field from the Microsoft Dynamics 

ERP system that includes the following reserved characters: & * [ ]. You can add an ampersand 

(&) only when you are automatically building row definitions by using the Insert Rows from 

dialog box. For more information, see the Management Reporter Help documentation.  

Multiple-segment or multiple-dimension ranges 

When you enter a range by using combinations of multiple dimension values, the range comparison is 

accomplished on a dimension-by-dimension basis. The range comparison cannot be accomplished on 

either a character-by-character basis or a partial segment basis. 

For example, the range +Account=[5000:6000], Department=[1000:2000], Cost center=[00] includes 

only the accounts that match each segment. In this scenario, the first dimension must be in the range 

from 5000 through 6000, the second dimension must be in the range from 1000 through 2000, and the 

last dimension must be 00. (For example, +Account=[5100], Department=[1100], Cost center=[01] 

would not be included in the report because the last segment is out of the specified range.) 

If a segment value includes spaces, enclose that value in square brackets [ ]. The following values are valid 

for a four-character segment: [ 234], [123 ], [1 34] 

Dimension values should be enclosed in square brackets, which Management Reporter will do for you. 

When a multiple-segment or multiple-dimension range includes wildcard characters (? or *), the low and 

high ends of the whole multiple-segment or multiple-dimension range is determined, and then all values 

between those ends are included, inclusively. If you have a large range, such as the whole range of 

accounts 40000 to 99999, you should specify a valid starting and ending account, when it is possible. 

Report Designer is unable to select any account, dimension, or field from the Microsoft Dynamics 

ERP system that includes the following reserved characters: & [ ]. You can add an ampersand (&) 

only when you are automatically building row definitions by using the Insert Rows from dialog 

box. For more information, see the Management Reporter Help documentation. 

See Also 

Add or subtract from other accounts in a row definition 

Add dimension sets in a row definition 

Display zero balance accounts in a row definition 

Link to Financial Dimensions cell in a row definition 

Note 

Note 
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Add or subtract from other accounts in a row definition 

To add or subtract monetary amounts in one account from the monetary amounts in another account, 

you can use the plus sign (+) and the minus sign (-) in the Link to Financial Dimensions cell. 

The following table shows acceptable formats for adding and subtracting links to financial data. 
 

To do this: Use this format: 

Add two fully-qualified accounts 1205-2000-000+1205-2100-000 

+Division=[000], Account=[1205], Department=[00] 

+Division=[100], Account=[1205], Department=[00] 

Add two segment values 1205+1210 

+Account=[1205]+Account=[1210] 

Add segment values that include wildcard characters 120?+11?? 

+Account=[120?+Account=[11??] 

Add a range of fully-qualified accounts +(1205-1000-000:1205-2000-000) 

+Division=[000:100], Account=[1205], Department=[00] 

Add a range of segment values +(1200:1205) 

+Account=[1200:1205] 

Add a range of segment values that include wildcard 

characters 

+(120?:130?) 

+Account=[120?:130?] 

Subtract one fully-qualified account from another fully-

qualified account 

1205-2100-000-(1205-2000-000) 

+Division=[000], Account=[1205], Department=[00]-

Division=[100], Account=[1205], Department=[00] 

Subtract one segment value from another segment value 1210-(1205) 

+Account=[1205]-Account=[1210] 

Subtract a segment value that includes a wildcard 

character from another segment value 

1100-(120?) 

+Account=[1200]-Account=[11??] 

Subtract a range of fully-qualified accounts -(1205-1000-000:1205-2000-000) 

-Division=[000:100], Account=[1200:1205], 

Department=[00:01] 

Subtract a range of segment values -(1200:1205) 

-Account=[1200:1205] 

Subtract a range of segment values that include wildcard 

characters 

-(120?:130?) 

-Account=[120?:130?] 

 

Although you can modify the accounts directly, you can also use the Dimensions dialog box to apply the 

correct formatting to your financial data links. Any of the values can include wildcard characters (? or *). 
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Report Designer cannot select any account, dimension, or field from the Microsoft Dynamics ERP system 

that includes the following reserved characters: & * [ ]. 

To subtract values, you must put parentheses around those values. For example, if you enter 

450?-(4509), +Account=[4509]-Account=[450?], you are instructing Management Reporter to 

subtract the amount for account segment 4509 from the amount for any account segment that 

starts with 450. 

Add or subtract accounts from other accounts 

1. In Report Designer, open the row definition to modify.  

2. Double-click a cell in the Link to Financial Dimensions column. 

3. In the first row of the Dimensions dialog box, follow these steps: 

 In the Operator +/- cell, select the operation (+ or -) that applies to one or more segment values 

or sets in the row. 

 Double-click the cell in the Division column. In the Division dialog box, select Individual or 

range, and then enter a segment value in the From column.  

4. Repeat steps 2 and 3 to add more operations. 

The operator always applies to the dimensions in the same row. 

See Also 

Add dimension sets in a row definition 

Wildcards and ranges in row definitions 

Display zero balance accounts in a row definition 

Link to Financial Dimensions cell in a row definition 

Row definitions 

Add dimension sets in a row definition 

A dimension value set is a named group of dimension values. A dimension value set can contain values in 

a single dimension only, but you can use a dimension value set in multiple row definitions, column 

definitions, reporting tree definitions, and report definitions. You can also combine dimension values sets 

in a report definition. 

For more information about dimension values, see Link to Financial Dimensions cell in a row definition. 

When a change to your financial data requires that you change the dimension value set, you can update 

the dimension value set definition, and that update applies to all areas that use the dimension value set. 

For example, if you frequently indicate a range of values to link to your financial data, such as the values 

from 5100 through 5600, you might assign this range to an account set titled Sales. 

After you create a set of dimension values, you can select that set as your financial data link. 

In another example, if you have the value range of 5100 through 5600 assigned to Sales and 4175 

assigned to Discounts, you can determine total sales by subtracting Discounts from Sales indicated as 

(5100:5600)-4175. 

Note 

Note 
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Create a set of dimension values 

1. In Report Designer, open the row, column or tree definition to modify. 

2. On the Edit menu, click Manage Dimension Value Sets. 

3. In the Manage Dimension Value Sets dialog box, select the type of dimension value set to create in 

the Dimension field, and then click New. 

4. In the New dialog box, type the name and description for the set.  

5. In the From column, double-click inside a cell to open the Account dialog box. Select the account 

name from the list, or search for the entry in the Search field. Click OK. 

6. Repeat step 5 in the To column to design a formula for that operator.  

7. When the formula is completed, click OK. 

8. In the Manage Dimension Sets dialog box, click Close. 

Update a set of dimension values 

1. In Report Designer, open the row, column, or tree definition to modify. 

2. On the Edit menu, click Manage Dimension Value Sets. 

3. In the Manage Dimension Value Sets dialog box, select the dimension type in the Dimension field. 

4. Select the dimension value set to update from the list, and then click Modify. 

5. In the Modify dialog box, modify the formula values to include in the set. 

If you add new accounts or dimensions, make sure that you modify the existing dimension 

value sets to incorporate the changes. 

6. Double-click the cell to select the appropriate Operator, From account, and To account. 

7. Click OK to close the Modify dialog box and save changes. 

Copy a dimension set 

1. In Report Designer, open the row, column, or tree definition to modify. 

2. On the Edit menu, click Manage Dimension Value Sets. 

3. In the Manage Dimension Value Sets dialog box, select the dimension type in the Dimension field. 

4. Select the set to copy from the list, and then click Save As. 

5. Enter a new name for the copied set, and then click OK. 

Delete a dimension set 

1. In Report Designer, open the row, column, or tree definition to modify.  

2. On the Edit menu, click Manage Dimension Value Sets. 

3. In the Manage Dimension Value Sets dialog box, select the dimension type in the Dimension field. 

4. Select the set to delete, and then click Delete. Click Yes to permanently delete the dimension value 

set.  

See Also 

Add or subtract from other accounts in a row definition 

Note 
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Wildcards and ranges in row definitions 

Display zero balance accounts in a row definition 

Link to Financial Dimensions cell in a row definition 

Row definitions 
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Column definitions 

A column definition is a report component, also called a building block, which defines the contents of 

columns in a report. Like row definitions, a basic column definition can be used in multiple reports.  

A column definition can contain 2 to 255 columns. 

 Contents of a column definition 

 Specify a column type in a column definition 

 Column restrictions 
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Contents of a column definition 
A column definition includes the following information: 

 A column that displays the descriptions from the row definition. 

 Amount columns that display data from the financial data, an Excel spreadsheet, or calculations on 

other data in the column definition. 

 Formatting columns. 

 Attribute columns. 

This information appears in the following two sections in the column definition: 

 The headers area of the column definition contains the heading text and formatting that appears in 

the report. A header can apply to a single column of data, spread across multiple columns, or apply to 

columns on a conditional basis. For more information about column headers, see Create column 

headers. The column definition can include as many column header rows as you need. 

Column headers apply to each column of data in the report. Report headers apply to the 

whole report. Define report headers on the Headers and Footers tab of the report definition.  

 Column detail rows are the rows under the header rows in the column definition. Column detail 

rows define the information to include in the report. The following table lists and describes the 

column detail rows. 

Column detail row name Description 

Column Type Specifies the type of data in this column. For more information, see Specify a 

column type in a column definition. This is a required component. 

Book Code/Attribute Category Specifies financial data information for FD and ATTR column types. For more 

information, see Financial Dimensions column. 

Fiscal Year 

Period 

Periods Covered 

Specify financial data information for FD column types. For more information, 

see Financial Dimensions column. 

Formula Specifies a calculation formula for CALC column types. For more information, 

see Calculation column in a column definition. 

Column Width 

Extra Spaces Before Column 

Format/Currency Override 

Print Control 

Specify special format options. For more information, see Add special 

formatting options or Adjust columns while designing reports. 

Column Restrictions Restricts data. For more information, see Add a column restriction. 

Reporting Unit Restricts the column to show data for the specified reporting unit only. For 

more information, see Build a reporting tree definition. 

Note 
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Column detail row name Description 

Currency Source 

Currency Filter 

Format currency. For more information, see Format a multiple currency report 

in a column definition. 

XBRL Currency 

XBRL Dimension 

Specifies XBRL currency and dimensional data. For more information about 

the XBRL Dimensions dialog box, see Link to XBRL taxonomies. Dimensions 

not defined in the column definition must be defined in the reporting tree 

definition. 

Dimension Filter Specifies a filter to limit data to certain financial data reporting units. For more 

information, see Apply a dimension filter in a column definition. 

Attribute Filter Specifies a filter to limit the financial data. For more information, see Apply an 

attribute filter in a column definition. 

Start Date 

End Date 

Restrict the financial data to specific dates. For more information, see Restrict 

a column to specific dates in a column definition. 

Justification Justifies the description text that is specified in the row definition. For more 

information, see Apply column justification in a column definition. 

 

Create a column definition 
1. In Report Designer, click Column Definitions. 

2. On the File menu, click New, and then select Column Definition.  

3. Add the information that is defined in the Contents of a column definition section in this topic. 

Open a column definition 
1. Open Report Designer. In the navigation pane, click Column Definitions. 

2. Double-click a column definition to open it. 

Add a column to a column definition 
1. In Report Designer, click Column Definitions, and then open the column definition to modify. 

2. Select a column where a new column should be inserted. 

3. On the Edit menu, click Insert Column. The new column appears to the left of the column that you 

selected. 

Delete a column from a column definition 
1. In Report Designer, click Column Definitions, and then open the column definition to modify. 

2. Select the column to delete. 

3. On the Edit menu, click Delete Column. 
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See Also 
Link to XBRL taxonomies 

Column definitions 
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Specify a column type in a column definition 
The type of information that is included in each column within a report is specified by the value in the 

Column Type row in the column definition. Each column definition must contain at least one description 

(DESC) column and one amount (FD, WKS, or CALC) column. For a definition of each column type, see 

Column types. 

The Column type codes do not apply to all accounting systems. If you select a type that is not 

valid with your accounting system, that column appears blank in the report. 

Specify a column type 

1. In Report Designer, open the column definition to modify. 

2. Double-click a cell in the Column Type row in the appropriate column. 

3. Select a column type from the list. For a description of column types, see Column types. 

Column types 
 

Column type code Description 

FD Use this code to display financial data, or to display data from an Excel spreadsheet when 

you use a Link to Financial Dimensions column or a Link to Worksheet column in the 

row definition. 

When you select the FD column type, default settings are automatically specified in the 

following rows:  

 Book Code/Attribute Category – ACTUAL 

 Book Code/Attribute Category – ACTUAL 

 Fiscal Year – BASE 

 Period – BASE 

 Periods Covered – PERIODIC 

 Column Width – 14 

These default settings can be changed. For more information, see Financial Dimensions 

column. 

CALC Use this code to display the result of a simple or complex calculation. For more 

information, see Calculation column in a column definition. 

DESC Use this code to place the row description from the row definition. Although this column is 

frequently the first column in the report, the description column can be in any position. 

ROW Use this code to display the individual row codes for financial rows from the Row Code 

column in the row definition. 

For more information, see Specify a row code in row definition. 

Note 
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Column type code Description 

ACCT (Account codes) Use this code to display the concise financial data segment values or dimension values 

that apply to each row. For account and transaction detail reports, the fully-qualified 

account is printed, for example, 110140-070-0101. If ranges have been specified in the 

Link to Financial Dimensions column in an associated row definition, the range is 

enclosed in square brackets and is treated as if it were a single value. For example, 

[110140:110700]-070-[0101:0200]. For financial reports and high-level reports that may be 

a combination of several accounts, the financial data link from the row definition is 

printed, for example, 1100:1200. 

FILL Use this code to fill the cell with a character that is enclosed in single quotation marks. If 

you do not enter a character, the column blank is left blank. For example, to fill a column 

with an ellipsis (...), enter FILL '.'. 

PAGE Use this code to insert a vertical page break in the report. The columns that are to the 

right of the PAGE column appear on a different page. 

WKS Use this code to display data that is pulled from an Excel spreadsheet. 

ATTR If your accounting system supports the use of attributes, use this code to display an 

account or transaction attribute in the column. An attribute, which must apply to a single 

full account, extracts underlying account or transaction information from the financial 

data. Account-level attributes display data from the account and transaction-level 

attributes display data that occurred at the time the transaction was posted. For more 

information about how to use attributes together with a row definition, see Row modifier 

in row definitions. 

When you select ATTR as the column type, specify the Attribute Category in the Book 

Code/Attribute Category detail row of the column definition. 

For more information about attribute filters, see Apply an attribute filter in a column 

definition. 

XBRL ELEMENT If you are using XBRL, use this code to display the XBRL element that is associated with 

this column type. For more information about XBRL, see XBRL and Management Reporter. 

 

See Also 

Financial Dimensions column 

Calculation column in a column definition 

Apply an attribute filter in a column definition 

Apply a dimension filter in a column definition 

Format a multiple currency report in a column definition 

Contents of a column definition 

Column definitions 
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Financial Dimensions column 

The following Column Definition row definitions apply to columns with the Column Type FD (Amounts 

from Financial Dimensions). 

Book Code/Attribute Category 

The Book Code/Attribute Category cell identifies the book code for the data in the FD column. A 

column definition can include multiple actual, budget, and statistical columns, and can display different 

periods, such as current or year-to-date, and different amounts. 

The list of book codes reflects the actual, budget, and statistical (non-financial) options that have been 

established in your financial data. 

Period 

The Period cell identifies the fiscal periods to include in this column. The period can be relative to the 

base period that is specified when the report is generated. The following options are available:  
 

Option Description 

BASE Use the base period. 

BASE+# Use the period that is # periods after the base period. For example, to use the third period after 

the base period, type BASE+3. 

BASE-# Use the period that is # periods before the base period. For example, to use the prior period, 

type BASE-1. 

BASE-#:BASE Use multiple periods from before the base period through the base period. For example, to use 

the three prior periods and the base period, type BASE-3:BASE. 

BASE:BASE+# Use multiple periods from the base period through a number of periods after the base period. 

For example, to use the base period and the following two periods, type BASE:BASE+2. 

BASE-#:BASE+# Use multiple periods from before the base period to after the base period. For example, to use 

the three prior periods, the base period, and the following two periods, type BASE-3:BASE+2. 

1:BASE Use multiple periods from the first period through the base period. 

# Always use a specific period number. We do not recommend using this option because it 

reduces the flexibility of the column definition. 

#:# Always use a specific range of periods. We do not recommend using this option because it 

reduces the flexibility of the column definition. 

 

You can go beyond fiscal year boundaries in any of the period specifications, and you can mix years within 

a range of periods. For example, if you specify the periods BASE- 5 (representing the past 6 periods) and 

run the report with a base period of 2, the report will show data for the first two periods of the specified 

fiscal year and the last four periods of the previous fiscal year. 
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Specify the periods for an FD column 

1. In Report Designer, open the column definition to modify. 

2. In an FD column, double-click the cell in the Period row, and then select an option in the list. 

3. In the formula bar (above the menu bar), complete the formula: 

 If you selected a BASE option in step 1, replace the number sign (#) character with the number of 

periods to offset the data. 

 If you selected the # or #:# option in step 1, replace each number sign (#) character with a 

specific period value. 

Alternatively, you can type the entire formula into the Period cell. 

Periods Covered 

The Periods Covered cell identifies the amount to display in this column. This amount is relative to the 

value in the Fiscal Year and Period cells for this column. The following options are available:  
 

Option Description 

PERIODIC Displays the sum of the activity for the current period or range of periods. 

PERIODIC/BB Displays the beginning balance for the current period or range of periods. 

YTD Displays the sum of the year-to-date activity. 

YTD/BB Displays the beginning balance for the year. 

 

Specify the periods covered for an FD column 

1. In Report Designer, open the column definition to modify. 

2. In an FD column, double-click the cell in the Periods Covered row. 

3. Select an option in the list. 

See Also 

Apply an attribute filter in a column definition 

Apply a dimension filter in a column definition 

Format a multiple currency report in a column definition 

Specify a column type in a column definition 

Contents of a column definition 

Column definitions 

 

 

Note 
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Apply an attribute filter in a column definition 

Attributes are financial data values that further define an account or transaction. Account attributes may 

include Asset, Liability, Revenue, and Expense. Transaction attributes may include Transaction Description 

and Transaction Apply Date. Attribute support may differ between Microsoft Dynamics ERP systems. 

The Attribute Filter cell restricts data in FD columns to specific values or ranges for attribute categories. 

This can be used in conjunction with an ATTR column, but the ATTR column is not required. In the FD 

column, there is a limit on which accounts or transactions will be included in the report from the attribute 

filter. 

To see which attributes your ERP system supports, see the integration guide for your system. 

For information about using account attributes and transaction attributes in the row definition, see Row 

modifier in row definitions. 

Apply an attribute filter for an FD column in a report 

1. In Report Designer, open the column definition to modify. 

2. Double-click the Attribute Filter cell for an FD column. 

3. In the Attribute Filter dialog box, double-click a cell in the Attribute column, and then select the 

filter type. 

4. To further limit the results, enter a range in the From and To columns. The From cell must contain a 

value. 

5. Click OK. 

Example 

The following table shows an account attribute in the Attribute Category row. The Attribute Filter for 

this column specifies the range of values to include in the report. 
 

  A B 

Column Type DESC FD 

Book Code/Attribute Category   ACTUAL 

Fiscal Year   BASE 

Period   1:BASE 

Periods Covered   PERIODIC 

...     

Column Width 30   

...     

Attribute Filter    Reference=[01:10] 

 

Note 
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See Also 

Specify a column type in a column definition 

Financial Dimensions column 

Contents of a column definition 

Column definitions 

Apply a dimension filter in a column definition 

A dimension filter is used to restrict the FD column to specific dimension values. 

The filter can include a single dimension, a range of dimensions, or a group of dimensions. The filter can 

also include dimension value sets. Because dimension values can vary, a dimension-based system does 

not have to adhere to an exact length. 

The filter is applied, regardless of whether the report includes a reporting tree. 

You can use a wildcard character (? or *) in any position. When you specify multiple accounts, place a 

comma between accounts, as in the following example: 

+Account=[1200], +Account=[1100], Department=[01?] 

To receive all departments for a specific account, you can exclude the Department dimension in the 

dimension filter. For example,  

+Account=[1100],Department 

is treated the same as: 

+Account=[1100] 

You can also use any combination of alphanumeric characters for exact matching, and you can define 

partial dimensions. For example, Location = [10*] includes all location dimension values that begin with 

10. 

Apply a dimension filter for a column in a report 

1. In Report Designer, open the column definition to modify. 

2. Double-click the Dimension Filter cell for an FD column. 

3. In the Dimensions dialog box, enter the filter(s) to apply. 

4. Click OK. 

See Also 

Apply an attribute filter in a column definition 

Specify a column type in a column definition 

Financial Dimensions column 

Contents of a column definition 

Column definitions 
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Format a multiple currency report in a column definition 

A multiple currency report can display amounts in the natural (local), functional (default), or reporting 

currency. A company’s functional currency is defined in the Microsoft Dynamics ERP system. Do not 

confuse this ERP setting with the operating system regional options setting where you can configure the 

default currency symbols to be used on reports. 

The following currency-related cells are in the column definition: 

 Currency Source – Specifies the type of currency (natural, functional, or reporting) in which the 

transactions are displayed. This functionality is sometimes called currency translation, which is the 

ability to report general ledger amounts in a currency that may not be the functional currency of the 

company, and it may not be the currency in which the transaction was entered. 

 Currency Filter – Specifies a currency filter. Only transactions entered in the selected currency are 

displayed in the report. 

To determine a company’s functional currency, do the following: 

1. In Report Designer, on the Company menu, click Companies to open the Companies dialog box. 

2. Select a company, and then click View. The View Company dialog box opens. The currency defined 

for this company is shown under Regional options. 

For more information about creating a multiple currency report, see the Management Reporter Help 

documentation. 

Specify the currency in a multiple currency report 

1. In Report Designer, open the column definition to modify.  

2. Double-click the Currency Source cell in an FD column.  

3. Select an option for displaying currency information: Natural/originating currency, Functional 

currency from company information, or the reporting currency. 

4. Double-click the Currency Filter cell in the FD column, and then select the appropriate currency code 

in the list. Only transactions entered in this currency are displayed in the report. 

The options described here may differ based on the ERP system. For more information, see data 

integration guide for your ERP system. 

Example 

Phyllis has made the following currency selections in her column definition: 

 Currency Source – Functional (U.S. dollars) 

 Currency Filter – Canadian dollars 

Because of the currency filter selection, the report prints only transactions that were entered in Canadian 

dollars. Because of the currency source selection, the report displays those transactions in the functional 

currency (U.S. dollars). 

 

 

 

 

Note 
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Currency filter and currency source combinations 

The following table illustrates the report results for various combinations of Currency Source and 

Currency Filter. The functional currency is U.S. dollars (USD). 
 

Currency Source Currency Filter Report Result 

Natural/originating currency YEN Y6,000 

Functional currency from company information YEN $60* 

Functional currency from company information empty $2,310** 

Natural/originating currency USD $2,250 

 

* Conversion rate at approximately 100 yen per U.S. dollar. 

** Functional currency from company information currency source with an unset currency filter displays 

the sum of all transactions. 

See Also 

Specify a column type in a column definition 

Financial Dimensions column 

Contents of a column definition 

Column definitions 
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Calculation column in a column definition 

A calculation column (CALC) in a column definition supports complex calculations, and can include the +, 

-, *, and / operators, along with IF/THEN/ELSE statements. Additionally, a calculation column can refer to 

any other column, including subsequent columns. The formula can be up to 1024 characters long. 

To express the calculation result as a percentage, use a special format mask. 

The results of calculation formulas do not include the values in nonprinting column ranges. For 

example, A:D will print zero, whereas A+B+ C for nonprinting values will calculate the value. 

Operators in calculation columns 

To add, subtract, multiply, or divide columns, type the column letters in the order of computation, and 

then use the appropriate operator to separate each column letter. The following table explains the 

operators that you can use in a calculation column: 
 

Operator Example calculation Description 

+ A+C Add the amount in column A to the amount in column C.  

: A:C 

A:C-D 

Add a range of consecutive columns.  

For example, the formula A:C adds the sum of columns A through C, and the 

formula A:C-D adds the sums of columns A through C, and then subtracts the 

amount in column D. 

- A-C Subtract the amount in column A from the amount in column C. 

Note 

You can also use the minus sign (-) to reverse the signs in a column. 

For example, use -A+B to add the reverse amount of column A to 

column B. 

* A*C Multiply column A by column C. 

/ A/C Divide the amount in column A by the amount in column C. 

 

Use a calculation formula in a column definition 

1. In Report Designer, open the column definition to modify. 

2. In a CALC column, type a formula in the Formula cell. 

Complex calculations 

A complex calculation can contain any combination of cell references, operators, values, and levels of 

nested parentheses.  

For example, to compute the average of columns A and B, use the calculation formula of ((A+B)/2). 

Note 
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See Also 

IF/THEN/ELSE statements in a column definition 

Specify report cells in a column calculation 

Multiply or divide in a column calculation 

Specify a column type in a column definition 

Use a calculation formula in row definition 

Column definitions 

Specify report cells in a column calculation 

You can refer to a specific report cell by typing a column letter and a row code. For example, B.100 refers 

to column B, row code 100. 

You can divide a whole column by a specific report cell amount that is in the same column. For example, 

the calculation B/B.100 means that the entire column B should be divided by the value in column B, row 

code 100. 

If the calculation references a column that is dependent on another column, the dependent column is 

resolved first. If you refer a column to another column that, in turn, refers back to the first column, a 

circular reference error results.  

This calculation might be incorrect if you change the calculation priority for the report. You can 

set the calculation priority on the Settings tab of the report definition. 

See Also 

Select report columns in a row definition 

Calculation column in a column definition 

Multiply or divide in a column calculation 

To multiply and divide columns, type the column letters in the order of computation, and then use the 

appropriate operator to separate each column letter. For more information about operators in a 

calculation column, see Calculation column in a column definition 

Multiply or divide a column by base row 

You can create a column that displays all of the values in a specified column as a percentage of a base 

number. This provides a method to show relationships between rows, such as a percentage of a sales row 

or a percentage of a total expenses row.  

To multiply or divide each row in a specific column by a base row, type the column that will be used in the 

calculation, and then type *BASEROW or /BASEROW. For example, C*BASEROW or C/BASEROW. 

When you use a base row calculation in a column definition, make sure that each row definition 

that is used with this column definition contains at least one base row for calculations. For more 

information, see Select the base row for a column calculation. 

Note 

Note 
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Divide amount in column by the number of periods 

You can divide the amount in a column by a specified number of periods. For example, the calculation 

B/Periods divides the value in column B by the number of periods in column B. If the calculation spans 

multiple columns, specify the number of periods to use in the calculation. 

For example, the (B+C)/Periods formula means to add the amounts in columns B and C, and then divide 

the result by the value of the Period for this column. 

See Also 

Calculation column in a column definition 

Operators in calculation columns 

Column definitions 
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Column restrictions in a column definition 
You can use column restrictions to specify how a column definition uses data or calculates information. 

You can also restrict a report column to a specific unit or for specific dates.  

 Add a column restriction 

 Restrict column to reporting unit in column definition 

 Restrict a column to specific dates in a column definition 

Add a column restriction 

The Column Restrictions cell can include codes that restrict or suppress information, such as row 

formatting, details, and amounts, for that column. 

A Column Restriction code overrides any conflicting setting that is assigned in the row 

definition. 

Add a column restriction in a column definition 

1. In Report Designer, open the column definition to modify.  

2. Double-click the Column Restrictions cell for the column that you want to restrict. 

3. In the Column Restrictions dialog box, select one or more codes in the list, and then click OK.  

Column restriction codes 

The following table describes the column restriction codes. 
 

Column Restriction Code Description 

SU Suppresses the underscore for a column for which either an underscore command        

( --- ) or a double underscore command ( === ) is entered in the row definition. For 

example, you might not want to underline amounts that are the result of a percentage 

calculation. 

ST Suppresses totals and shows only details in this column, for example, in statistical 

columns. 

SD Suppresses details and shows only TOT and CAL rows, from the row definition, in this 

column. 

DR Restricts the amounts in an FD column to debit amounts. 

CR Restricts the amounts in an FD column to credit amounts. 

ADJ Restricts the amounts in the column to period adjustment amounts, if available. 

XAD Restricts the amounts in the column to exclude the period adjustment amounts (if 

available). 

Note 
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Column Restriction Code Description 

PT Restricts the amounts in the column to include posted transactions only, if available. 

UPT Restricts the amounts in the column to include unposted transactions only, if available. 

Note 

Not all data providers support unposted transactions. For more information, 

see the data integration guide for your Microsoft Dynamics ERP system. 

 

See Also 

Column restrictions in a column definition 

Contents of a column definition 

Column definitions 

Restrict column to reporting unit in column definition 

You can use the Reporting Unit cell to restrict an FD (Amounts from Financial Dimensions) column to a 

specific reporting unit in the reporting tree. For example, you can display reporting units side by side, such 

as in departmental comparison reporting. 

If you specify a reporting unit in the column definition, you must specify the same reporting tree 

in the report definition, or the columns will be empty on the report. 

Restrict a report column to a reporting unit 

1. In Report Designer, open the column definition to modify.  

2. Double-click the Reporting Unit cell for the column to be restricted. 

3. In the Reporting Unit Selection dialog box, select a tree in the Reporting tree list. 

4. Expand or collapse the list of units, and then select a reporting unit and then click OK. 

See Also 

Financial Dimensions column 

Column restrictions in a column definition 

Contents of a column definition 

Column definitions 

Note 
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Restrict a column to specific dates in a column definition 

The Start Date and End Date cells restrict data in FD columns to specific dates. This restriction is useful 

for daily or weekly sales reporting, cash analysis needs, and other date-sensitive reports. 

You can enter a specific day of the period. For example, you can enter 3 to indicate the third day of the 

period. The ability to add a specific day of the period adds flexibility because you do not have to select 

the actual dates again when you run the report for the next period. 

Enter a starting and ending date 

1. In Report Designer, click Column Definitions in the navigation pane, and open the column definition 

to modify. 

2. Double-click the Start Date cell in an FD column, and then select a date on the calendar. 

3. Double-click the End Date cell for the same FD column, and then select a later date on the calendar. 

Example 

The following entry is valid. 
 

Start Date  1 16 4/1/2017 

End Date  15 30 4/30/2017 

 

The following entry is not valid. 
 

Start Date  04012017 

End Date  04302017 

 

See Also 

Financial Dimensions column 

Column restrictions in a column definition 

Contents of a column definition 

Column definitions 
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Reporting tree definitions 

A reporting tree definition is report component, also called a building block, which helps define the 

structure and hierarchy of your organization. It is a cross-dimensional hierarchical structure based on the 

dimensional relationships within your financial data. It provides information at the reporting unit level and 

at a summary level for all units in the tree.  

In Management Reporter, a reporting unit is used for each box in an organizational chart. A reporting unit 

can be an individual department from the financial data, or it can be a higher-level summary unit that 

combines information from other reporting units. For a report definition that includes a reporting tree, 

one report is generated for each reporting unit and for the summary level. All of these reports use the row 

and column definitions that are specified in the report definition, unless the report definition specifies to 

use the reporting tree from the row definition. 

Row and column definitions are important components in the design and functionality of financial reports. 

Reporting trees increase the power of the components and support flexible reporting as the business 

structure changes. 

Financial reports that are not based on a reporting tree use only some of the capabilities of Management 

Reporter. You can use multiple reporting tree definitions with the same row and column definitions to 

view your organization in various ways. 

 Rolling up data in a reporting tree 

 Multiple reporting trees 

 Create and modify a reporting tree definition 
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Rolling up data in a reporting tree 
By using a reporting tree, Management Reporter can aggregate amounts from child reporting units at the 

parent reporting unit level. This inclusion is called rolling up the data. 

The following rules are used to roll up amounts to parent units in a reporting tree: 

 Within a reporting tree, child units must contain dimensions, unless it is a single-level tree. Parent 

units usually do not contain dimensions in a reporting tree. 

Specifying dimensions for both child units and parent units can cause duplication of data in 

the report. 

 Reporting units that contain dimensions in the reporting tree correspond to the dimensions that are 

used in the row and column definitions. The combination of dimensions determines the amounts 

returned for that unit. For example, lines 6 and 7 in Example 2 will return only the values for 

department 00 and 01, respectively. 

 The amounts for parent reporting units that do not contain dimensions in the reporting tree are 

determined from the child unit report and roll up the amount to the specified parent unit. For 

example, if the parent unit (see Total TWO in Example 2) has two child units (00 and 01) and does not 

contain dimensions, a report is generated for each child and the parent. The parent total is the sum of 

the two child amounts. 

Examples 

The following examples show possible information that is used in a reporting tree definition for an 

example of rolling up data. 

Example 1 

 

 

 

 

 

 

 

Note 
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Example 2 

 

See Also 

Multiple reporting trees 

Reporting unit structure 

Reporting tree definitions 
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Multiple reporting trees 
You can create an unlimited number of reporting trees to view your organization in various ways. Each 

reporting tree can contain any combination of departments and summary units. 

 A report definition can contain a link to only one reporting tree at a time. 

By rearranging the structure among the reporting units, you can create different reporting trees. You can 

then use the same row and column definition with each reporting tree, which lets you create different 

financial report layouts very quickly. 

For example, the following diagram shows a reporting tree that is basically the same as the reporting tree 

that is shown in Reporting unit structure. The difference is that the reporting structure displays an 

organizational structure that is divided by business function instead of by location. These two reporting 

trees demonstrate different perspectives on company operations. 
 

 
 

If you create several different reporting trees, you can print a series of financial statements each month 

that analyze and present your company's operations in a variety of ways. 

Note 
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See Also 

Reporting unit structure 

Rolling up data in a reporting tree 

Reporting tree definitions 
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Create and modify a reporting tree definition 
Management Reporter supports flexible reporting so it is easy to make changes as your business structure 

changes. Reporting tree definitions can be combined with column definitions and report definitions to 

create a building block group that can be used by multiple companies. For more information about 

building block groups, see Building block groups. 

Management Reporter for Microsoft Dynamics ERP displays each reporting tree definition in a graphical 

view for visualizing the parent/child hierarchy, and in a worksheet view that shows the specific information 

for each reporting unit. The graphical view and the worksheet view are connected. When you select a 

reporting unit in one view, it is also selected in the other view. 

You can build cross-dimensional hierarchies based on the dimensional relationships within your financial 

data. When you create a reporting tree definition, you can use the same row definitions repeatedly, 

whether you are generating a departmental income statement or a consolidated summary income 

statement. 

The dimensions that are defined in the row definition can be combined with dimensions in the reporting 

tree definition to provide highly flexible views of your organization's performance. 

Reporting tree definition columns 

The reporting tree definition contains the following columns: 
 

Reporting Tree Column Description 

Company The company name for the reporting unit. The @ANY value, which is typically assigned 

only to the summary level, enables the reporting tree to be used for all companies. All 

child branches have a company assigned to them. 

Unit Name The code that identifies this reporting unit in the graphical reporting tree. For ease of 

use, establish a unique coding system that is consistent and is easily understood by 

users. 

Unit Description The reporting unit title appears in the report header or footer if you enter UnitDesc as a 

code on the Headers and Footers tab of the report definition. The title appears in the 

report row description if you enter UnitDesc in the Description cell of the row 

definition. 

Dimensions Every detail reporting unit row must have a dimension in this column. 

You can also place a dimension in a summary unit row, for example, for expenses directly 

related to that unit. If you enter a dimension in a summary unit row, accounts that are 

used in parent units should not be used in child units to avoid duplicated amounts. 

For more information, see the Management Reporter Help documentation.  
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Reporting Tree Column Description 

Row Definitions The name of the row definition for the reporting unit. The same row definition is used for 

each unit of the reporting tree. When you generate a report, this row definition is used 

for each reporting unit. 

The row definition can include multiple financial dimensions links. 

If a row definition is specified in the reporting tree, select the Use row definition from 

reporting tree check box on the Report tab of the report definition. 

Row link The row link to use for the reporting unit. Row links are defined for the row definition to 

identify the financial dimensions to link to.  

External link The row link to use for this reporting unit. Row links are defined for the row definition to 

identify the Excel spreadsheet file or the Management Reporter report to link to. 

External file The file path to the Excel spreadsheet or Management Reporter worksheet to pull data 

from. For more information, see Identify an Excel file in a reporting tree. 

XBRL Dimension Defines XBRL dimensions and labels. For more information about the XBRL Dimensions 

dialog box, see Link to XBRL taxonomies. Dimensions that are not defined in the 

reporting tree definition must be defined in the column definition. 

Page Options Controls whether the detail for the reporting unit is suppressed from viewing or printing. 

Rollup % The percentage of the reporting unit that is to be allocated to its parent unit. The 

percentage that you enter in this column applies to each row of the row definition before 

the value in the row is added to the parent report. For example, if a child unit is to be 

divided evenly between two departments, the amounts in each row would be multiplied 

by 50 percent before being added to the department report. 

One reporting unit cannot have two parent units. To allocate the amounts from a 

reporting unit to two parent units, create another reporting unit with the same 

dimension to roll up the additional 50 percent. 

Type whole percentages without a decimal point. For example, .25 equals .25% 

allocation to the parent, and 25 equals 25% allocation to the parent. To use a 

percentage that is less than one percent, use the Allow Rollup <1% option in the report 

definition. This option is on the Additional Options tab in the Report Settings dialog 

box. Access this dialog box from the Other button on the Settings tab of the report 

definition. 

Unit Security Restrictions on which users and groups can access the information for the reporting unit. 

For more information, see Restrict access to a reporting unit. 

Additional Text Text that is included in the report. For more information, see Additional text for reporting 

unit. 
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Create a reporting tree definition 

1. Open Report Designer. 

2. On the File menu, click New, and then click Reporting Tree Definition. A new reporting tree 

definition opens. 

3. Enter the information as explained in Reporting tree definition columns. 

Open an existing reporting tree definition 

1. In Report Designer, click Reporting Tree Definitions in the navigation pane. 

2. Double-click a name in the reporting tree list to open it. For a description of the columns and the 

information that is required, see Reporting tree definition columns. 

See Also 

Build a reporting tree definition 

Insert Reporting Units From Dimensions dialog box 

Organize reporting units 

Additional text for reporting unit 

Restrict access to a reporting unit 

Multiple reporting trees 

Rolling up data in a reporting tree 

Reporting tree definitions 

Reporting unit structure 

The following types of reporting units are used in Management Reporter: 

 A detail unit draws information directly from the financial data, from an Excel spreadsheet file, or from 

another Management Reporter worksheet. 

 A summary unit summarizes data from lower-level units. 

A parent reporting unit is a summary unit that aggregates summarized information from a detail unit. A 

summary unit can be both a detail unit and a summary unit, which means that a summary unit can draw 

information from a lower unit, the financial data, or an Excel spreadsheet. A parent unit can be the child 

unit of a higher parent unit. 

A child reporting unit can be a detail unit that pulls information directly from the financial data or a 

spreadsheet. It can also be an intermediate summary unit, which is the parent unit to a lower unit and is 

also the child unit to a higher-level summary unit.  

The most common scenario for reporting units is to have parent units with a blank link in dimensions and 

to have child units with links to specific or wildcard dimension combinations. 
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Example 

The reporting unit structure in the following reporting tree is as follows: 

 The Beijing Office reporting unit is a parent unit to the Beijing Sales and Beijing Service child units. 

 The Beijing Sales division unit is both a child unit of the Beijing Office and a parent unit to the Retail 

Sales and Wholesale Sales units.  

 The lowest-level detail reporting units (Retail Sales, Wholesale Sales, Studio, and Lab) represent 

departments in the financial data. These reporting units are in the shaded area of the diagram. 

 The higher-level summary units summarize information from the detail units. 

 

See Also 

Multiple reporting trees 

Rolling up data in a reporting tree 

Reporting tree definitions 
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Build a reporting tree definition 

Before you build a reporting tree, you must first determine which reporting dimensions your legal entity 

or company requires. 

Consider how you have set up your structure, and then draw an organizational chart of your company. 

The organizational chart will help you visualize how to group the reporting units into one or more 

reporting trees.  

Start with the lowest available level of detail, such as the departments and projects that are defined in the 

financial data. Add as many boxes to the level of detail, as needed, to show higher-level divisions or 

regions. Each box represents a potential reporting unit in any reporting tree that you create. 

You must also consider the best way to build your trees. In Management Reporter, you can use an 

automated build process to create a reporting tree, or you can create a reporting tree manually. It is 

important to understand both methods before you design your trees. 

You can use the reporting units that are defined in your financial data system to add reporting units to 

the reporting tree definition. 

Build a reporting tree definition 

1. Open Report Designer. On the File menu, click New, and then click Reporting Tree Definition. 

2. On the Edit menu, click Insert Reporting Units from Dimensions. 

3. In the Insert Reporting Units from Dimensions dialog box, select the check box for each dimension 

to include in the reporting tree. 

4. To create additional segments, such as breaking one segment into two shorter segments, click the 

correct location in a Character position field, and then click Split Segments. 

5. To merge two segments into one segment, click within either of the segment boxes to merge, and 

then click Combine Segments. 

6. To change the hierarchy of the dimensions in the Segment hierarchy and ranges area, select the 

dimension to move, and then click Move Up or Move Down. 

The hierarchy defines both how dimensions report to each other and the range for each 

dimension. 

7. To specify a range of dimension values to add to the new reporting tree, in the Segment hierarchy 

and ranges area, perform the following steps: 

 In the From Dimension field for that dimension, type the first value in the range. 

 In the To Dimension field, type the last value to use for this dimension. 

8. For each dimension in the Segment hierarchy and ranges area, repeat step 7. 

9. After you have finished defining how your reporting units will be brought into the new reporting tree, 

click OK. 

10. On the File menu, click Save to save the reporting tree. Enter a unique name and description for the 

reporting tree, and click OK. 

Note 
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See Also 

Row definitions 

Insert Reporting Units From Dimensions dialog box 

Reporting tree definitions 

Insert Reporting Units From Dimensions dialog box 

You can build a reporting tree definition from the dimensions in your financial data, using the Insert 

Reporting Units from Dimensions dialog box. To open this dialog box, open a reporting tree definition 

in Report Designer, click Edit, and then select Insert Reporting Units from Dimensions.  

The Insert Reporting Units from Dimensions dialog box contains the following sections. To see example 

screenshots, see the example later in this topic. 
 

Section Description 

Reporting dimension segmentation Use the Split Segments and Combine Segments buttons to change the 

number and length of segments. 

Note 

You can only combine segments that you have split. To combine 

multiple dimensions, use wildcards in your dimension values. 

Include/Character position Lists the dimensions that are defined in the financial data and shows the 

number of characters in the longest defined value for each dimension. Select 

a check box to include that dimension in the reporting tree hierarchy. 

Segment hierarchy and ranges Shows the dimension hierarchy. You can move the dimensions in the list to 

change their reporting order. Specify a range of values within each 

dimension in the From Dimension and To Dimension boxes. If you do not 

specify a range, all dimension values are inserted into the reporting tree. 

Note 

If you are using more than one dimension, only dimension 

combinations that have been posted to will be returned in the 

results. 

 

 

 

 

 

 

 



Management Reporter for Microsoft Dynamics ERP 

Management Reporter User Guide 87 

Example 

In this example, the Insert Reporting Units from Dimensions dialog box contains the following 

information. The results will return the combination of departments equal to and greater than 00 for all 

divisions. 
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The resulting reporting tree definition is sorted by Division and then Department. The dimension for the 

third reporting unit is Division = [000], Department = [00] , which identifies a reporting unit for 

accounts that are specific to the 000 Division and 00 Department. 
 

 
 

See Also 

Reporting tree definitions 

Build a reporting tree definition 

Reporting tree definitions 

Organize reporting units 

You can rearrange the organizational structure of a reporting tree definition by moving reporting units in 

the graphical view. You can also promote reporting units to a higher level in the reporting tree and move 

them to a lower level in the reporting tree. 

Organize reporting units 

1. In Report Designer, open the reporting tree definition to modify. 

2. In the graphical view of the reporting tree definition, select a reporting unit. 

3. Drag the unit to a new position, or right-click and select Promote Reporting Unit or Demote 

Reporting Unit. 

4. Click File, and then select Save, or click  in the toolbar to save changes. 
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See Also 

Additional text for reporting unit 

Restrict access to a reporting unit 

Reporting tree definitions 

Additional text for reporting unit 

An additional text entry is a static text string, up to 255 characters, that adds information to the reporting 

tree definition, such as a short company description. You can create up to ten additional text entries for 

each reporting unit in a reporting tree definition. The additional text appears in the report for the 

reporting unit to which the text is assigned. 

You can add text entries from the Description column of the row definition and from the Headers and 

Footers tab in the report definition. For information about adding additional text to row definitions, see 

Description cell in row definition. For information about adding additional text to the headers and footers 

in reports, see Headers and footers in report definitions. 

Add additional text to a reporting unit 

1. In Report Designer, open the reporting tree definition to modify.  

2. Double-click the Additional Text cell for the reporting unit row. 

3. In the first empty row of the Additional Text dialog box, type the text. 

The first row that contains text is referenced as UnitText1, regardless of its position in the 

Additional Text dialog box. 

4. To add more text entries for this reporting unit, type the text in an empty row.  

5. Click OK. 

Remove additional text from a reporting unit 

1. In Report Designer, open the reporting tree definition to modify.  

2. Double-click the Additional Text cell for the reporting unit row. 

3. In the Additional Text dialog box, select the entry to remove, and then click Clear, or right-click and 

select Cut.  

4. Click OK. 

See Also 

Headers and footers in report definitions 

Organize reporting units 

Restrict access to a reporting unit 

Reporting tree definitions 

 

Note 
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Restrict access to a reporting unit 

You can prevent certain users and groups from accessing a reporting unit. You can also specify restrictions 

to include the child reporting units. 

For more information about security, see Report library security. 

Restrict access to a reporting unit 

1. In Report Designer, open the reporting tree definition to modify.  

2. Double-click the Unit Security cell for the reporting unit row to restrict access to. 

3. In the Unit Security dialog box, click Users and Groups. Select the users and/or groups that will have 

access to the restricted reporting unit, and then click OK. 

4. To restrict access to child reporting units, select the Add security to children reporting units check 

box. 

5. Click OK. 

Remove access to a reporting unit 

1. In Report Designer, pen the reporting tree definition to modify.  

2. Double-click the Unit Security cell for the reporting unit row to remove access to. 

3. In the Unit Security dialog box, select a name, and then click Remove. 

4. Click OK. 

See Also 

Additional text for reporting unit 

Organize reporting units 

Reporting tree definitions 

Note 
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Link to Management Reporter reports 

After you have created a Management Reporter report column in the row definition and have specified 

the Management Reporter report to include in the report, you must update the reporting tree with the 

linked column and the Management Reporter report information. A Management Reporter report can be 

imported into any unit in the reporting tree. 

Identify the Management Reporter report in a reporting tree 

1. In Report Designer, open the reporting tree definition to modify. 

2. Double-click the Row Definitions cell, and then select the row definition that contains information 

about the Management Reporter report. 

The cells in the Row Definitions column display information based on the selected row 

information, because the same row definition must be used in all units of the reporting tree. 

3. In the Worksheet Link cell for a reporting unit, select the link name that corresponds to the 

Management Reporter report. 

4. In the Workbook or Report Path cell for a reporting unit, type the name of the Management 

Reporter report or browse to select the Management Reporter report. 

5. To specify a worksheet in a Management Reporter report, type the name of the worksheet in the 

Worksheet name cell.  

6. Repeat steps 3 through 5 for each reporting unit that should receive data from a Management 

Reporter report. To prevent incorrect data from appearing in your report, make sure that the correct 

Management Reporter report names appear in the corresponding unit of the reporting tree. 

See Also 

Link reports to Microsoft Excel 

Match worksheets with fiscal periods 

Prepare a link column in a row definition 

Identify an Excel file in a reporting tree 

Reporting tree definitions 

Note 
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Report definitions 

A report definition is a report component, also called a building block, which uses a row definition, a 

column definition, and an optional reporting tree definition to create a report. In addition, the report 

definition provides additional options and settings for customizing a report.  

 Contents of a report definition 

 Select report components in a report definition 

 Change report settings in a report definition 
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Contents of a report definition 
The following table describes the tabs in a report definition and how the information is used. 
 

Tab Description 

Report Create a report, configure a report, or modify an existing report.  

For more information, see Select report components in a report definition. 

Output and Distribution Change the report output type and destination.  

For more information, see Generate reports. 

Headers and Footers Define and format the report headers and footers. For example, you can add text or 

images to the header or footer. Management Reporter supports .bmp, .jpg, and .png 

files for images. In addition, you can add AutoText codes to insert other information, 

such as a company name, a report name, or page number. 

For more information, see Headers and footers in report definitions 

Settings Specify formatting and rounding amounts, format detail reports, format reporting trees, 

generate an exception report, specify currency conversion, and subtotal and filter 

account details. 

For more information, see Change report settings in a report definition. 

 

Create a report definition 
After you define row and column definitions, you need to combine them in a report definition. At this 

point, you will also define additional aspects of the definitions, such as the detail level and report date, 

and then you can save and generate a report.  

Management Reporter offers the following levels of detail reporting: Financial, Account Only, Financial & 

Account, Transaction Only, or Financial, Account, & Transaction. However, depending on how data is 

stored in the Microsoft Dynamics ERP system, transaction details might not be available in reports. 

1. In Report Designer, on the File menu, click New, and then select Report Definition. 

2. Indicate or select the appropriate information in the Report, Output and Distribution, Headers and 

Footers, and Settings tabs. For more information about these tabs, see Contents of a report 

definition. 

See Also 
Select report components in a report definition 

Headers and footers in report definitions 

Change report settings in a report definition 

Report Settings dialog box 

Report definitions 
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Select report components in a report definition 
In the Report tab of a report definition, you specify the row definition, the column definition, and the 

optional reporting tree definition to use to build a report. 

You must also define additional aspects of the definitions, such as the detail level and report date, and the 

company information. 

 Select company name or code in report definition 

 Select report detail level in report definition 

 Specify a provisional code in report definition 

 Specify report periods and dates in report definitions 

 Select report building blocks in report definition 

See Also 

Report definitions 

Select company name or code in report definition 

Management Reporter uses the accounting calendar information for a legal entity or company, such as 

fiscal year and fiscal periods, to generate a report. You can have multiple companies defined in 

Management Reporter. If you select the company code @ANY, the default company is used to generate 

reports.  

Specify a company name 

1. In Report Designer, open the report definition to modify.  

2. Click the Report tab. 

3. In the Company name field, select the company to use for the report, or select @ANY to generate a 

report using the default company.  

If you are not logged on to the company, the Connect to dialog box opens. Enter a user name 

and password, and then click OK to log on to the company. 

See Also 

Select report detail level in report definition 

Specify a provisional code in report definition 

Specify report periods and dates in report definitions 

Select report building blocks in report definition 

Select report components in a report definition 

Report definitions 

Note 
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Select report detail level in report definition 

When you select a detail level in a report definition, the Report tab information does not change. 

However, the option that you select affects which options are available on the Print and Export screens. If 

you select the Account Only or Transaction Only detail level, the Financial and Account level reports 

cannot be printed in .xps format or in Microsoft Excel. 

You can specify the following levels of detail in a report in the report definition. To print the transaction-

related details for an FD column, you must have a PERIODIC column. 
 

Detail Level Description 

Financial A high-level summary report. You cannot drill down to accounts and 

dimensions, except for those added through a reporting tree. 

Account Only A report that contains only account detail balances. 

Financial & Account A report that contains a high-level summary and account details. 

Transaction Only A report that contains only transaction details. 

Financial, Account & Transaction A report that contains a high-level summary and transaction details. 

 

Specify a report detail level 

1. In Report Designer, open the report definition to modify. Click the Report tab. 

2. In the Detail level field, select the level of report detail. 

Examples 

The following illustrations show Management Reporter when different detail level options are selected. 

Financial detail level option example 

The following report shows the high-level financial detail that is generated when you select the Financial 

detail level option. 
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Account Only detail level option example 

The following illustration shows the high-level account detail that is generated when you select the 

Account Only detail level option. 
 

 
 

Drilldown detail level option example 

The following illustration shows the high-level financial detail, in addition to account transactions 

generated when you select the Drilldown detail level option. 
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Print screens 

The following illustrations show the Print dialog box for the report detail options. 

Account Only 
 

 
 

Financial & Account 

This option is similar to Account Only, but also provides a summary view. 
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The following is an example of a report that is generated when the Financial & Account detail option is 

selected. 
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Transaction Only 

The following is an illustration and example report when you select the Transaction Only report detail 

level option. 
 

 
 

 
 

See Also 

Select report components in a report definition 

Report definitions 
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Specify a provisional code in report definition 

The provisional reporting codes in a report definition determine whether posted, unposted, or both 

posted and unposted financial data transactions are included in the report. Posted transactions include 

activity from every module, for example, Accounts receivable or Accounts payable, that creates an 

unposted journal entry within the General ledger module of the Microsoft Dynamics ERP system. 

Not all data providers support unposted transactions. For more information, see the data 

integration guide for your Microsoft Dynamics ERP system. 

Specify a provisional code 

1. In Report Designer, open the report definition to modify. Click the Report tab. 

2. In the Provisional field, select the provisional code to use in the report. For a description of the 

provisional codes, see Provisional codes. 

Provisional codes 
 

Balance Option Description 

Posted activity only Includes only the transactions and balances that are posted in your financial data. 

Posted and unposted activity Includes all of the transactions and balances that are entered and posted in your 

financial data. 

Unposted activity only Includes only the transactions that are entered, but not yet posted, in your financial 

data. 

 

See Also 

Select report components in a report definition 

Report definitions 

Specify report periods and dates in report definitions 

You can indicate the base period, base year, and date for a report in the report definition. For definitions 

of the period and date fields, see Period and date options. 

Date information in the report definition is related to the default base period. For definitions of the 

default base period options, see Default Base Period options.  

By default, a new report definition displays the code S-1. The S codes are related to the system date on 

the computer. Therefore, using S-1 as the default base period, displays a report date as of the last day of 

the last period defined in the source system calendar. Many users save the S-1 setting for their reports so 

that they report on the prior month’s activity by default.  

Note 
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Another option available for the default date is CUR, or the C codes. These options are related to the 

current active period in the source system. 

The final option is to hard code a specific period as the default period. In this option, the reporting year is 

synchronized with the source system. 

Date information that is saved with the report definition can be overridden when the report definition is 

open. This lets users generate the report for a different time frame without changing the default base 

period. The following date information is not saved with the report definition: 

 Base period – The date is displayed with regard to the default base period, unless it is updated. If it is 

required, select an override from list. 

 Base year – The date is the same as the base period, except years are displayed. 

 Period covered – By default, the text Month or Months Ending is used with date-related header 

codes. The period covered text can be modified in the Entity dialog box. 

Specify report periods and dates 

1. In Report Designer open the report definition to modify. Click the Report tab. 

2. In the Base period field, select the base that period to use for the report. The period then appears in 

the Period covered field. 

3. In the Base year field, select the fiscal year to use in your report. The combination of the Base period 

and Base year appears in the Report date field. 

4. In the Default base period field, select a default base period or type a default base period. For 

example, to specify the base period as five periods before the current financial data period, type C-5. 

Period and date options 
 

Option Description 

Base period Determines the initial setting in the Base Period box. 

Changes to the base period are not saved with the report definition. To save the base period, 

assign a default base period in the Default Base Period box. 

Although you can type period numbers in the column definition, a column definition typically 

refers to the base period that you specify in the report definition. In the column definition, 

you typically set the period relative to the base period, and then define the specific period in 

the report definition. If you enter a specific period number in the column definition, that 

number overrides the base period setting. 

Base year Specifies the fiscal year to use for the report. Changes to the base year are for the current 

report and are not saved with the report definition. For more information, see the Default 

Base Period options. 
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Option Description 

Period covered Combines the base period with the Period Description or Plural Description, which used 

for multiple periods, that is specified in the Modify Company dialog box. For information 

about company information settings, see Maintaining company information (data provider). 

By default, the description in the Period covered box appears in the report headers. Use the 

@PeriodCoverage and @PeriodCoverage@DateLong codes in the Headers and Footers 

tab to include the Period Covered description in your report. 

Report date Combines the Base period and Base year boxes. By default, the report date appears in the 

report headers. 

Default base period Determines the initial settings for the Base Year and Base Period. This is the only setting 

that is saved with the report definition.  

 

Default Base Period options 

The Default Base Period setting determines the initial settings for the Base Year and Base Period. This is 

the only setting that is saved with the report definition. 

The following table describes the default base periods. 
 

Default Period Description 

SYS Base period is the current system period. 

S-1 Base period is one period before the current system period. 

S-2 Base period is two periods before the current system period. 

S+1 Base period is one period after the current system period. 

CUR Base period is the current processing period specified in the financial data. 

C-1 Base period is one period before the current financial data period. 

C-2 Base period is two periods before the current financial data period. 

C+1 Base period is one period after the current financial data period. 

01 Acceptable values for the Default base period box are based on the configuration of the 

Microsoft Dynamics ERP system. For example, to use a calendar year with 12 months, you can type 

01 for January and 12 for December. 

 

See Also 

Maintaining company information (data provider) 

Select report components in a report definition 

Report definitions 
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Select report building blocks in report definition 

Reporting definitions use the other report building blocks of a row definition, a column definition, and a 

reporting tree to help define the content of a report. You can also use a reporting tree to display 

information related to a dimension that is not used in the rows or columns of the design. For a description 

of the building blocks, see Building block settings. 

Depending on the type of report that you are creating, you might have to modify your row definition and 

column definition to display the report detail accurately. For example, you might have to adjust the 

rounding precision on your balance sheets. For more information, see Specify rounding options in a 

report definition. 

Select report building blocks 

1. In Report Designer, open the report definition to modify. Click the Report tab. 

2. In the Building blocks section, in the Row field, select a row definition. To verify that the row 

definition that you selected is the correct one, click  to open it. Then close the row definition to 

return to the Report tab of the report definition. 

3. If you created a report design that requires row formatting from a reporting tree, select the Use row 

definition from reporting tree check box. 

4. In the Column  field, select a column definition. To verify that the column definition that you selected 

is the correct one, click  to open it. Then close the column definition to return to the Report tab of 

the report definition. 

5. To use a reporting tree, in the Tree type field, select the structure of the reporting tree. When the 

Tree field is displayed, select the reporting tree definition. To verify that the reporting tree definition 

that you selected is the correct one, click  to open it. Then close the reporting tree definition to 

return to the Report tab of the report definition. 

6. To specify a starting unit in the reporting tree, click  to open the Starting Unit dialog box. Select 

a starting reporting unit, and then click OK. 

To generate a report for the whole reporting tree, leave the Starting Unit box empty, or 

select None in the Starting Unit dialog box. 

Note 
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Building block settings 

The following table describes the settings available under the Building block area of the Report tab in 

the report definition.  
 

Setting Description 

Row Specifies the row definition for the report. For more information about 

row definitions, see Row definitions. 

Use row definition from reporting tree If the reporting tree specifies the row definition to use in the report, 

select this check box. If you do not select this check box, the row 

definition that you selected in the Row field for every unit in the 

reporting tree is used. 

Note 

This is required only when you are using multiple links to FD in 

the row definition and with some methods of linking to 

external worksheets. For most reports, you do not need to 

select this check box. 

For more information about reporting trees and how to assign a row 

definition in the reporting tree, see Build a reporting tree definition. 

Column Specifies the column definition to use in the report. For more 

information about column definitions, see Column definitions. 

Tree type Specifies the structure of tree. Possible values are as follows: 

 Reporting tree – A hierarchy derived from available dimensions in 

the financial data.  

 Dimension hierarchy – A hierarchy in a dimension-based system 

that is not bound to a single segment. 

 None – Clears the Tree type setting. 

Tree Specifies the reporting tree definition to use in the report. For more 

information about reporting trees, see Reporting tree definitions. 

Starting unit Specifies a subsection of the reporting tree definition to use in the 

report. The Starting unit limits which branches of the tree appear when 

you generate the report. Click  to open the Starting Unit dialog 

box and browse for the starting unit. To run the report for the complete 

tree, in the Starting Unit dialog box, click None. 

 

See Also 

Build a reporting tree definition 

Select report components in a report definition 

Report definitions 
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Change report settings in a report definition 
In the Settings tab of a report definition, you can specify formatting and rounding amounts to use in the 

report, the calculation priority of rows and column calculations, the order that report components are 

processed, and select reporting units to use in the report. 

 Specify rounding options in a report definition 

 Specify calculation priority in a report definition 

 Adjust the processing order in a report definition 

 Reporting unit options in report definition 

 Specify other formatting in report definitions 

 Report Settings dialog box 

See Also 

Report definitions 

Specify rounding options in a report definition 

Rounding adjustments may be necessary if a report is generated in whole dollars or one of the other 

rounding options available in the report settings. How a report is displayed is also affected by the 

processing order of calculations in relation to rounding. 

You can specify a level of rounding for the numerical values in a report on the Settings tab of the report 

definition. 

If you select a rounding option for a report, you may have to make rounding adjustments, which involves 

setting the calculation priority and processing order.  

For example, if calculations are performed before rounding, the balance sheet may balance, but not foot. 

If rounding is performed before calculations, the balance sheet will foot. However, the two sections (assets 

compared to liabilities and equity) may not balance.  

The term foot means to total down to the row calculation. The term cross-foot means to total 

across, rolling up the child units to the parent unit. 

Change the level of rounding used in your report 

1. In Report Designer, open the report definition to modify. Click the Settings tab.  

2. In the Rounding precision field, select a rounding option for the report. For a description of 

rounding options and examples, see the rounding options and the example later in this topic. 

 

 

 

Note 
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Rounding options 

The following table describes the rounding options. 
 

Rounding Option Rounding Example 

No Rounding $1,117,691,601.48 

Whole Dollars $1,117,691,601 

Nearest Hundred $1,117,691,600 

Thousands (000.0) $1,117,691.6 

Whole Thousands (000) $1,117,692 

Millions $1,117.7 

Whole Millions $1,118 

Billions $1.1 

Whole Billions $1 

 

Examples 

When you round a report, you can select to round the report values before or after totaling, and you can 

select to round the reporting units before or after rolling up to the parent unit. The following table 

identifies the different rounding option combinations and the effect on rounding differences. 
 

Rounding Selections Foot? Cross-foot? 

Roll up Rounded Values in the Tree No Yes 

 

This section shows examples of how totals and roll ups perform using the different rounding option 

combinations. In all cases, Management Reporter consistently totals the parent unit rows after rolling up 

the child units. 

The following table displays report values that are not rounded. All reports foot and cross-foot to the 

Combined report. 
 

Accounts U.S. Canada Combined 

Cash 1413.48 1201.20 2614.68 

Accounts Receivable 287.37 100.40 387.77 

Prepaid Expenses 112.47 200.05 312.52 

Total Current Assets 1813.32 1501.65 3314.97 

 

 

 



Management Reporter for Microsoft Dynamics ERP 

Management Reporter User Guide 107 

The following table contains two examples that do not use rounded values in calculations and totals. 
 

 Example 1 Example 2 

 Roll up Rounded Values in the Tree  

  U.S. Canada Combined U.S. Canada Combined 

Cash 1413 1201 2614 1413 1201 2615 

Accounts 

Receivable 
287 100 387 287 100 388 

Prepaid 

Expenses 
112 200 312 112 200 313 

Total 

Current 

Assets 

1813 1502 3313 1813 1502 3315 

 

See Also 

Change report settings in a report definition 

Report definitions 

Specify calculation priority in a report definition 

If you select a rounding option for your report, you may have to make rounding adjustments that involve 

setting the calculation priority and processing order. For more information about processing order, see 

Adjust the processing order in a report definition. For example, if calculations are performed before 

rounding, a balance sheet may balance, but not foot. If rounding is performed before calculations, the 

balance sheet will foot. However, the two sections (assets compared to liabilities and equity) may not 

balance. You can use the calculation priority setting to indicate the order in which rows and columns are 

calculated. 

The term foot means to total down to the row calculation. The term cross-foot means to total 

across, rolling up the child units to the parent unit. 

 

Note 
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Specify calculation priority 

1. In Report Designer, open the report definition to modify. Click the Settings tab. 

2. Under Calculation priority, select one of the following options: 

 Perform column calculation first and then row – Perform the column calculations before the 

row calculations. This option might be necessary when a column calculation (CALC) intersects a 

total (TOT) or calculation (CAL) row, and the row calculation should overwrite the column 

calculation. 

 Perform row calculation first and then column – Performs the row calculation before the 

column calculations. This option works best for the following situations:  

o Report with a CALC column or with simple calculations 

o Row definition and column definition that use only simple mathematical operator (+ and 

-) 

See Also 

Specify rounding options in a report definition 

Use a calculation formula in row definition 

Calculation column in a column definition 

Change report settings in a report definition 

Report definitions 

Adjust the processing order in a report definition 

Use the Processing order options to specify the order in which rollups, calculations, and rounding are 

completed when a report is generated. The following processing order options are available: 
 

Option Description 

Rollup values in reporting tree Rounds the reporting unit values and then rolls up the results into the summary 

unit. When you use this option, every report in your tree correctly totals (foots). 

However, the totals in the summary report might not be the same as a similar 

summary report that does not use a reporting tree. 

Perform calculations Calculates rows and columns. 

Apply rounding Applies rounding to all values if you select any Rounding precision option other 

than None. 

 

Adjust the processing order 

1. In Report Designer, open the report definition to modify. Click the Settings tab. 

2. In the Processing order field, select a process, and then click Move Up or Move Down to indicate 

the processing order for the report. 
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See Also 

Specify calculation priority in a report definition 

Use a calculation formula in row definition 

Calculation column in a column definition 

Change report settings in a report definition 

Report definitions 

Reporting unit options in report definition 

You can specify the reporting units that are included in a report in the report definition Settings tab. 

Specify reporting units 

1. In Report Designer, open the report definition to modify. Click the Settings tab. 

2. Under Reporting unit selection, select one of the following options: 

 Select units at runtime - Displays the Select Reporting Units dialog box each time this report is 

generated. 

 Include all units - Includes all reporting units in the report. 

 Include specific number of levels down from starting unit: - Includes the specified number of 

reporting unit levels in the report. 

See Also 

Report Settings dialog box 

Change report settings in a report definition 

Report definitions 

Specify other formatting in report definitions 

You can control the formatting and rounding of amounts at the report level by modifying the settings on 

the report definition Settings tab. 

Specify other formatting options 

1. In Report Designer, open the report definition to modify. Click the Settings tab. 

2. Under Other formatting, select the formatting to use in the report. For descriptions of the options, 

see the formatting options later in this topic. 
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Other formatting options 

The following table describes the available formatting options. 
 

Option Description 

Use parentheses for negative numbers Indicates negative numbers by using parentheses ( ). If you do not 

select this option, the report indicates negative numbers with a minus 

sign (-). 

Display negative numbers in red Displays negative numbers in red. If you do not select this option, the 

negative numbers appear in the color that was selected for that row. 

Display digit separators Displays digit separators, for example, 120,346,000. 

Display currency symbol on first row Displays a currency symbol in all amount columns on the first row of 

each page. If you select this option, you do not have to enter a CS print 

control in the first row of the row definition. The actual format that is 

used is specified in the Amount with Currency Symbol box in the 

International Formats dialog box. 

Display blanks for zero amounts Displays spaces instead of zeros for all zero balances in the whole 

report. 

Display rows with no amounts Displays rows with zero balances. By default, Management Reporter for 

Microsoft Dynamics ERP suppresses rows with zero balances in all 

amount columns. 

Display reports that have no active rows Generates a report for every unit of a reporting tree, even if no 

amounts appear. 

Empty reports might appear if title rows or other format rows are 

present. To prevent extraneous titles from printing on a report without 

amounts, relate each descriptive row to an amount row. For more 

information about relating rows, see Relate a format row to an amount 

row. 

Extra lines between rows Changes the number of lines that are printed between the report rows. 

Spaces between columns Changes the default number of spaces that are printed between the 

report columns. 

In addition, in the Extra Spaces Before Column cell in the column 

definition, you can enter the number of spaces to use before a column. 

For more information, see Add special formatting options in a column 

definition. 
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See Also 

Relate a format row to an amount row 

Change report settings in a report definition 

Report definitions 
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Formatting options for reports 

Management Reporter has several tools to customize the appearance of your reports. 

For additional formatting options, see Advanced formatting options. 

 Format row and column text 

 Create column headers 

 Apply column justification in a column definition 

 Add special formatting options 

 Headers and footers in report definitions 

 Report Settings dialog box 
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Format row and column text 
You can customize the appearance of your reports by changing fonts and formatting text. The following 

topics explain how to format the appearance of rows and columns in reports. 

 Manage font styles 

 Format row text 

 Adjust columns while designing reports 

Manage font styles 

You can create and modify font styles for your report and apply these styles to the entire document or to 

a specific row or column within a report. 

Create a font style 

1. In Report Designer, on the Format menu, click Styles and Formatting. 

2. Click New in the Styles and Formatting dialog box, and then enter a unique name for the new style.  

3. Make your font selections, and then click OK. 

Modify a font style 

1. In Report Designer, on the Format menu, click Styles and Formatting. 

2. Select a style to modify in the Styles and Formatting dialog box, and then click Modify. 

3. Make your font selections, and then click OK. 

Apply a font style 

1. Open Report Designer. In a row definition or column definition, or in headers and footers, select one 

or more cells. 

2. In the Style list on the toolbar, select a font style. 

See Also 

Adjust columns while designing reports 

Formatting options for reports 
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Format row text 

The formatting specified in the row definition overrides formatting specified in the column definition and 

the report definition. 

You can modify text format by using the controls on the formatting toolbar. These controls are standard 

Microsoft Windows controls. 

Format row text 

1. In Report Designer, open the row definition to modify. 

2. Select the cells to format. To select multiple cells, press the Ctrl key while you select the cell. 

3. Click the toolbar button of the format to apply. For example, to indent a row, select the row, and then 

click  in the toolbar. 

See Also 

Manage font styles 

Adjust columns while designing reports 

Formatting options for reports 

Adjust columns while designing reports 

To make it easier to view the columns that you are working on in the row definition, you can adjust the 

width of a column and hide (minimize) or show columns in the view pane. Any modifications that you 

make affect the screen appearance only, and do not affect the column formatting in reports. To format 

the column width for a report, see Add special formatting options. 

Change the width of a column in view pane 

1. In Report Designer, open the row definition to modify. 

2. On the Format menu, select Column Width. 

3. Enter a value in the Column Width dialog box. Click OK. 

You can also drag the right boundary of a column heading cell to change the width of the column. 

Hide columns in view pane 

1. In Report Designer, open the row definition to modify. 

2. Select the column or columns to minimize. 

3. Right-click, and then click Hide. 

Show all hidden columns in view pane 

1. In Report Designer open the row definition to modify. 

2. Right-click the minimized column that you want to display, and then click Unhide. 
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Create column headers 
You can add, modify, and delete the headers that appear across the top of the columns in a report by 

using the Column Header dialog box.  

You can also configure conditional spanning column headers based on the Period field, which is indicated 

in Column Definitions, and the Base Period, which is indicated in Report Definitions. The Base Period 

is a time-saving feature when you create rolling forecast reports. For more information, see Conditional 

spanning headers. 

Column Header dialog box options 
 

Option Description 

Column header text This text appears in the column header. You can type text directly into this box, or 

you can click Insert AutoText to select an option that updates the column header 

each time that the report is generated. To include multiple AutoText codes, click 

Insert AutoText again, and then click another code in the list. For information about 

the available AutoText variables and where they apply, see Column header AutoText 

codes. 

Format options Lists formatting options that can be applied to a column header, such as box or 

underline. 

Spread from and Spread to Defines the column or columns that the header text applies to. 

Justification Specifies how the Column header text will align with respect to the column or range 

of columns that are specified in the Spread from and Spread to boxes.  

 

Create a column header 

1. In Report Designer, open the column definition to modify. Double-click a header cell. 

2. In the Column Header dialog box, enter the column header text, or click Insert AutoText and select 

an option. 

3. Select a formatting style for the header in the Format options field. For additional formatting 

options, see Manage font styles. 

4. In the Spread from field, type the letter of the column over which the column header should start. In 

the Spread to field, type the letter of the column over which the column header should end. 

5. Under Justification, select whether the column header text to should be left, center, or right justified. 

6. Click OK. 
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Add a column header row 

1. In Report Designer, open the column definition to modify. 

2. Select a cell in the header row.  

3. On the Edit menu, select Insert Row. The new row is inserted above the row that you selected in step 

2. 

If you have four or more rows of report headers in a report, the headers will overlap when the 

report is export to a Microsoft Excel worksheet. To view all headers in the report, increase the top 

margin in the report definition. 

Delete a column header row 

1. In Report Designer, open the column definition to modify. 

2. Select a cell in the header row to delete. 

3. On the Edit menu, select Delete Row. 

See Also 

Column header AutoText codes 

Conditional spanning headers 

Formatting options for reports 

Column header AutoText codes 

AutoText codes are variables that are updated every time that a report is generated. Any column header 

can include these codes to specify information, such as date or period number, that can vary for reports. 

Therefore, you can use one column definition for multiple report definitions, time periods, and reporting 

trees. 

Because codes rely on the calendar information from the Column Detail section, codes are supported for 

FD and WKS columns only. The way an AutoText code appears in the column header cell affects how that 

information appears in the report. In the Column Header dialog box, the AutoText codes appear in mixed 

case, which causes mixed case text in the report. For example, in a standard calendar year, 

@CalMonthLong resolves month 7 to July. If the text should be uppercase in the report, for example 

JULY, type the code in uppercase characters, for example, @CALMONTHLONG, into the Column header 

text box. 

You can mix codes with text. For example, the following header text: Period @FiscalPeriod-@FiscalYear 

from @StartDate to @EndDate creates a report heading similar to: Period 1-02 from 01/01/02 to 

01/31/02 

The way some of the text is formatted, such as long date, depends on your regional settings on 

the Management Reporter server. To change these settings, click Start, select Control Panel, and 

then click Regional and Language. 

Note 

Note 
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The following table lists the available AutoText options for column headers. 
 

AutoText Option and Code Description 

Month name (@CalMonthLong) Prints the name of the current month in the column heading. 

If you decide to round the amounts in the report to thousands, 

millions, or billions, or if you set the column width in the report to 

fewer than nine characters, the name of the month abbreviates to 

its first three characters. 

Abbreviated month name (@CalMonthShort) Prints the abbreviated name of the month for the selected fiscal 

period. 

Period number (@FiscalPeriod) Prints the numeric form of the fiscal period identified for that 

column. If the column spans multiple periods, the last period in 

the range is printed. 

Period description (@FiscalPeriodName) Prints the fiscal period description that is identified in the 

financial data. 

Fiscal year (@FiscalYear) Prints the fiscal year for the column in numeric form. 

Calendar year (@CalYear) Prints the calendar year for the column in numeric form. 

Start date (@StartDate) Prints the column starting date. 

End Date (@EndDate) Prints the column ending date. 

Unit name from tree (@UnitName) If you restrict a column to a specific unit of the reporting tree, 

prints the unit name in the column header. 

Unit description (@UnitDesc) If you restrict a column to a specific unit of the reporting tree, 

prints the unit description in the column header. 

Book Code (@BookCode) Prints the book code specified in the column. 

Blank line (@Blank) Inserts an empty line in the column header. 

 

See Also 

Create column headers 

Formatting options for reports 
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Conditional spanning headers 

Conditional spanning headers can span across multiple columns based on specific period data. For 

example, if you have a budget report for the fiscal year and you want to display the actual budgets of past 

months with the projected budgets of future months, you can use a conditional spanning header to 

automatically update the report header. 

Be aware of the following situations when you create a conditional spanning header: 

 Any stop condition (Spread to field) that is matched before a start condition (Spread From field) is 

ignored. For example, if column B has the spread condition defined as BASE+1 to BASE, and if BASE is 

in column C and BASE+1 in column D, the stop condition in column C is ignored and the printing of 

the header starts at column D. 

 If you specify column headers that overlap, they print overlapped on the report. The following 

warning appears in the Report Queue Status although the report is still generated: “Column headers 

using Base intersect with other column headers and may cause overlapping text.” For example, if the 

header definition on column B is B to BASE+1, and the header definition on column D is BASE+1 to F, 

the headers are printed on top of each other and are illegible. Whenever BASE is used in a Spread 

from/Spread to definition, view the generated report to verify whether the headers overlap. 

 If you specify BASE in the spread definition in a No Print (NP) column, it is ignored, regardless of what 

is defined in the column definition. Essentially, it is the same as not creating a column header 

definition. 

 For conditional printing columns (P<B, P>=B), conditional spanning headers behave as any regular 

column header definition, for example, if the condition is false, any subsequent column matching the 

spread condition starts the header printing. 

Create a conditional spanning header 

1. In Report Designer, open the column definition to modify. Double-click a header cell. 

2. In the Column Header dialog box, enter the column header text, or click Insert AutoText and select 

an option. 

3. Select a formatting style for the header in the Format options field. For additional formatting 

options, see Manage font styles. 

4. Specify a period relative to the base period that is specified when the report is generated. To do this, 

type one of the following options in the Spread from and Spread to field fields: BASE, BASE-X or 

BASE+X, where X is the number of periods from the base period. 

For example, if you type BASE in the Spread from field, the conditional spanning column header text 

starts in the column header where the report definition Base period = column definition Period and 

ends in the column indicated in the Spread to field. So, if the spread is BASE to M, and the report 

definition Base period = 4, the header starts in the column with the period set to 4 and ends at 

column M, inclusively. Headers stop and start on printing columns only. 

5. Under Justification, select whether the column header text to should be left, center, or right justified. 

6. Click OK. 
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Example 

Phyllis is creating a report for a dynamic six-month forecast. She wants the word Actual to be printed 

over the columns that contain actual data, and the word Budget to be printed over the columns that 

contain budget forecasts. Each month that the report is run, there is one more actual column and one less 

budget column. Phyllis can modify the column definition manually each time that the report is generated 

to adjust the headers, but she decides to save time and effort and to create conditional spanning headers 

that will automatically create headers over the appropriate columns each time that the report is run. 

Phyllis opens Report Designer, clicks Column Definition in the navigation pane, and opens the column 

definition for the report. She enters the following information. The Base period in the report definition is 

4. 
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Phyllis double-clicks a column header cell to open the Column Header dialog box, where she enters the 

following information: 
 

Field Phyllis enters 

Column header text Actual 

Insert AutoText No selection made 

Format options Box 

Justification No selection made 

Spread from B 

Spread to BASE 

Budget header BASE+1 to end column 

 

Phyllis clicks OK. 

She then double-clicks the column header cell on column C to open the Column Header dialog box, 

where she enters the following information: 
 

Field Phyllis enters 

Column header text Budget 

Insert AutoText No selection made 

Format options Box 

Justification No selection made 

Spread from C 

Spread to BASE+2 

 

See Also 

Create column headers 

Column header AutoText codes 

Formatting options for reports 
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Apply column justification in a column definition 
The Justification cell is used to apply justification formatting to a description column in a report. This 

option affects only the column descriptions, not the actual values. 

Apply column justification 

1. In Report Designer, open the column definition to modify. 

2. Double-click the Justification cell. 

3. Select a value in the list. 

 None – No justification is applied. 

 Left – Left-aligns the column descriptions. 

 Center – Centers the column descriptions. 

 Right – Right-aligns the column descriptions. 

See Also 

Add special formatting options 

Formatting options for reports 
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Add special formatting options 
In the column definition, the formatting column detail rows apply special formatting to selected columns. 

Although some of the Print Control options and Column Restrictions options are specific to FD 

columns, most of the options apply to all column types. The formatting in the row definition overrides the 

formatting in the column definition. The formatting used in the column definition overrides the formatting 

in the report definition. 

The following rows are considered formatting rows: 

 Column Width 

 Extra Spaces Before Column 

 Format/Currency Override 

 Print Control 

Column Width 

The Column Width cell specifies the number of characters to use for the width of this column on the 

printed report. Column width is particularly important for columns that contain amounts (column type 

CALC, WKS, or FD), descriptions (column type DESC), or fill (column type FILL). The default column widths 

are as follows: 

 14 characters (including cents, commas, and parentheses) for amount columns 

 30 characters for the description columns 

 2 characters for a fill column 

The maximum width for any column is 255. 

Specify the width of a column in a report 

1. In Report Designer, open the column definition to modify. 

2. In the Column Width cell, type the number of spaces for the width of the column. To allow 

Management Reporter to select the appropriate width for the cell content, double-click the Column 

Width cell, and then click AutoFit. 

Extra Spaces Before Column 

The Extra Spaces Before Column cell specifies the width of a separator between the adjacent columns in 

the column definition. The Extra Spaces Before Column setting affects all column detail rows, but not 

the column header rows, for this column. 

Use this option to separate groups of columns or to add a few spaces before the description so that the 

description column is indented from the left-justified titles that are in the report. 

The default number of spaces between each column is two. You can change this option on the Settings 

tab in the report definition. 
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Specify the space between columns 

1. In Report Designer, open the column definition to modify. 

2. In the Extra Spaces Before Column cell, type the number of spaces to insert between columns. 

Format/Currency Override 

The Format/Currency Override cell specifies the formatting of the decimal, currency, and percentage 

amounts in this column. This formatting overrides any formatting that is specified in the report definition 

or system defaults. 

Assign a format currency override to a report column 

1. In Report Designer, open the column definition to modify. 

2. Double-click a Format/Currency Override cell in an amount column. 

3. In the Format Override dialog box, select formatting options. For more information, see Select 

Format Override cell in row definition. 
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Print Control 

The Print Control cell can contain codes that adjust the display or the printing characteristics of a 

column. There are Regular Print Control codes and Conditional Print Control codes. 

Regular Print Control codes 
 

Print Control Code Translation Description 

NP Nonprinting Excludes the amounts in this column from 

printing in the report and from calculations. 

To include a non-printing column in a 

calculation, refer to the column directly in the 

calculation formula. For example, the non-

printing column C is included in the following 

calculation: B+C+D. However, the non-printing 

column C is not included in the following 

calculation: B:D. 

XCR Change sign if normal balance of row is 

credit 

Creates a budget, or a comparative report, in 

which an unfavorable variance (such as a 

revenue shortfall or an expense overrun) is 

always negative. 

Apply this code to a CALC column. 

Select this code to reverse the sign of a CALC 

column amount if the normal balance of a given 

row is a credit (identified by a C in the Normal 

Balance column of the row definition). 

Note 

Code the appropriate rows with a C in 

the Normal Balance column (in the 

row definition) for the TOT rows and 

the CAL rows that normally carry a 

credit balance. 

X0 Suppress column if all zeros or blanks Excludes an FD column from the report if all 

cells in that column are either empty or contain 

zeros. 

SR Suppress rounding Prevents the amounts in this column from being 

rounded. 

XR Suppress rollup Suppresses a rollup. If the report uses a 

reporting tree, the amounts in this column are 

not rolled up into subsequent parent nodes. 
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Print Control Code Translation Description 

RP Repeat column on each page Repeats a specified column on each page of a 

report. For example, to include a ROW column 

type that pulls in row codes on every page, use 

RP. 

WT Wrap text Wraps text. If the text in a column is too long to 

fit the space, this option wraps the text to keep 

all of the text in the column. 

 

Conditional Print Control codes 
 

Conditional Print Control Code Description 

(none) Clears the conditional print selection. 

P<B Displays a specified column only if the period is less than the base period. 

P>B Displays a specified column only if the period is greater than the base period. 

P=B Displays a specified column only if the period is equal to the base period. 

P<=B Displays a specified column only if the period is less than or equal to the base 

period. 

P>=B Displays a specified column only if the period is greater than or equal to the base 

period. 

 

Add print control codes to a report column 

1. In Report Designer, open the column definition to modify. 

2. Double-click the Print Control cell. 

3. In the Print Control dialog box, select a code in the Select print control options list. To select more 

than one code, press and hold the Ctrl key as you select the codes. 

4. Select an option in the Conditional print options field. By default, (none) is selected. You can select 

only one conditional print code at a time. 

5. Click OK. 

Alternatively, you can type the print codes directly into the Print Control cell. Separate multiple 

print control codes with a comma. 

See Also 

Apply column justification in a column definition 

Select Format Override cell in row definition 

Tip 
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Headers and footers in report definitions 
Adding headers and footers lets you insert text or images to help define certain elements in a report. The 

Headers and Footers tab is divided into a Headers area and a Footers area. Each area is divided into 

three sections: Left section, Center section, and Right section. Use the sections to align header 

information to the left, center, or right side of the header or footer. 

Management Reporter accesses the regional settings of your Windows Operating System for the 

period description information. For example, if you specify the AutoText code of @DateLong, and 

the day of the week shows up in your report headers but you do not want day of the week, you 

must change your operating system regional settings and remove dddd (day of the week) from 

the Long Date definition. For more information about the regional settings, see your operating 

system documentation. For an explanation of AutoText options, see the Management Reporter 

Help documentation.  

Add header and footer text 

1. In Report Designer, open the report definition to modify. Click the Headers and Footers tab. 

2. Select the row to add text to. 

3. Enter text into the selected row: 

 To enter custom text, type the text into the row. 

 To use an AutoText code, click Insert AutoText, select an AutoText category, and then click an 

AutoText code. For more information about the codes, see the Management Reporter Help 

documentation.  

AutoText headers are supported for FD and WKS column types only. To use AutoText 

headers, the column must use a period and a year with a base or a value. 

Delete header and footer text 

1. In Report Designer, open the report definition to modify. Click the Headers and Footers tab. 

2. In the Headers or Footers area, in the Left section, Center section, or Right section, click a row and 

press the Delete key. 

Modify header and footer text 

1. In Report Designer, open the report definition to modify. Click the Headers and Footers tab. 

2. In the Headers or Footers area, in the Left section, Center section, or Right section, double-click 

the row that contains the text to modify, and then modify the text, as necessary. 

 

 

Note 

Note 
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Format header and footer text 

1. In Report Designer, open the report definition to modify. Click the Headers and Footers tab. 

2. Click the row that contains the text to format. 

3. Select the font style to apply from the Formatting toolbar, or click the appropriate formatting button 

in the toolbar.  

Insert an image into a header or footer 

Management Reporter supports most file types for images. This includes files that have extensions of 

.bmp, .jpg, and .png. 

Text and images cannot be used in the same section. 

1. In Report Designer, open the report definition to modify. Click the Headers and Footers tab. 

2. Click the row to add an image to. 

3. Click Images. 

4. Select an image from the list, and then click Insert.  

If the image is not loaded in Management Reporter, click Add. Then, in the Open dialog box, navigate 

to the image to use, and then click Open. Select the image, and then click Insert to insert the image 

into the report. 

Modify a header or footer image 

1. In Report Designer, open the report definition to modify. Click the Headers and Footers tab. 

2. Click Images. 

3. Select an image to modify, and then click Modify. 

4. In the Modify Image dialog box, you can change the following settings: 

 To change an image name, type a new name in the Image Name field. 

 To change an image size, enter a new value in the Scale relative to original image size field. 

 To replace an image, click Replace Image. In the Open dialog box, select a different image, and 

then click Open. 

5. Click OK to close the Open dialog box. 

Change the report starting page number 

1. In Report Designer, open the report definition to modify. Click the Headers and Footers tab. 

2. In the Start page numbering at field, enter a starting page number. 

See Also 

Format row text 

Select report components in a report definition 

Formatting options for reports 

Note 
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Report Settings dialog box 
 To change the layout, page numbering, and other details for a report, you must modify the settings in the 

Report Settings dialog box. 

To open the Report Settings dialog box, complete the following steps: 

1. In Report Designer, then open the report definition to modify.  

2. Click the Settings tab. 

3. Click the Other button to open the Report Settings dialog box. 

The Report Settings dialog box contains the following tabs: 

 Page Setup (see Change page setup) 

 Account and Transaction Details (see Account & Transaction Detail in report definitions) 

 Additional Options (see Additional options for report settings) 

Page Setup options in report definition 

You can change report setup options, such as margins, orientation, scaling, page order, and page size in 

the report definition Report Settings dialog box.  

Change page setup options 

1. In Report Designer, open the report definition to modify.  

2. Click the Settings tab, and then click the Other button. 

3. Click the Page Setup tab and select setup options, which are described later in this topic. 

4. Click OK. 

Page setup options 
 

Option Description 

Margins The Left, Right, Top, and Bottom Margins boxes display the report page margin. 

To change the margins, select the margin value and type the new value. 

Orientation Management Reporter supports portrait or landscape orientation. 

 Portrait – Displays the report vertically on the page. 

 Landscape – Displays the report horizontally on the page. 

Scaling Displays the percentage of scaling in a report. To change the scaling, select one of the following 

options: 

 Reduce or enlarge to – Changes the report size to the percentage that you enter in the % box. 

 Shrink to page width – Fits the report columns in the width of a single page.  

Page order Controls the layout of the report pages. 

 Down, then over – Report pages appear in columns. 

 Over, then down – Report pages appear in rows. 
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Option Description 

Paper Displays paper and copy settings. This option contains the following settings:  

 Size – Indicates the size of the paper in the printer. 

 Copies – Indicates the number of report copies to print. 

 Collate – Collates multiple report copies. 

Note 

Collating prints all pages of each document together. For example, if you print two 

copies of a three-page document and you select not to collate the pages, the pages 

print in this order: 1, 1, 2, 2, 3, 3. If you select to collate, the pages print in this order: 1, 

2, 3, 1, 2, 3. 

 

See Also 

Report Settings dialog box 

Account & Transaction Detail in report definitions 

Additional options for report settings 

Formatting options for reports 

Account & Transaction Detail in report definitions 

You can select which account and transaction details to include on a report, such as displaying the row 

code or printing subtotals by period, by making modifications on the report definition Account & 

Transaction Detail tab in the Report Settings dialog box. 

Not all data providers support unposted transactions. For more information, see the data 

integration guide for you Microsoft Dynamics ERP system. 

Configure account and transaction details 

1. In Report Designer, open the report definition to modify.  Click the Settings tab, and then click Other. 

3. Click the Account & Transaction Detail tab. 

4. Modify the Account & Transaction Details settings as needed, and then click OK. For descriptions of 

these options, see Account detail options and Account and transaction detail options. 

 

 

 

 

 

 

Note 
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Account detail options 

The following account detail options are available. 
 

Option Description 

Display account code or dimensions Includes the segment or dimension values from the 

financial data system in the report. The segment or 

dimension value is added into the report description 

(DESC) column at the account and transaction detail level.  

Display account code or dimension description from 

chart 

Includes the segment or dimension descriptions from the 

financial data system in the account and transaction 

detail report. As much of the description as will fit into 

the report description (DESC) column is included. 

Display row code Displays the row definition row codes in the account and 

transaction detail report. 

Combine posted and unposted amounts Combines posted and unposted balances in the account 

and transaction detail report. If you do not select this 

option, Management Reporter for Microsoft Dynamics 

ERP displays the posted and unposted amounts on 

separate account detail line items for each account that 

has unposted activity. 

Display underscore before totals Displays an underscore line before each row total in 

account detail reports. For transaction detail reports, 

select this option to print an underscore before and after 

each period total, each account total, and each row total. 

Mark unposted accounts with * Displays an asterisk (*) for unposted balances or 

transactions. If you select the option, an asterisk appears 

at the transaction detail level for every unposted 

transaction. If you do not select the option, an asterisk 

appears at the account detail level for the unposted 

account balance, and also the transaction detail level for 

all unposted transactions. 

Include detail for non-printing rows Includes nonprinting rows that you defined in in the Print 

Control column in the row definition (NP). 

Sort by natural or main segment Sorts multiple accounts that are listed at the same level. 

The overriding sort order for reports is determined by the 

account order in the row definition. 



Management Reporter for Microsoft Dynamics ERP 

Management Reporter User Guide 131 

Option Description 

Display CBR calculation Determines whether the calculation is performed if you 

select an account or transaction detail level report. By 

default, this option is selected because a report that has 

many accounts can take longer to process. If you include 

a base row calculation in the column definition, specify a 

BASEROW row in the row definition. By using these 

specifications, the appropriate calculations are performed 

on each row of the financial statement, regardless of 

detail level. 

 

Account and transaction detail options 

The following options are available for account and transaction detail reports. 
 

Option Description 

Subtotal by period Prints the opening balance, period subtotals, and YTD 

total in the Periods column. If you do not select this 

option, only the opening balance and YTD total prints on 

the report. 

Display out of balance message when amount is 

greater than 

Displays a message when the amount is larger than the 

number that you specify. 

 

See Also 

Page Setup options in report definition 

Additional options for report settings 

Report Settings dialog box 

Formatting options for reports 

Additional options for report settings 

There are additional options that you can include in a report, such as excluding inactive accounts. You can 

select these options in the Report Settings dialog box.  

Select additional options in report definition 

1. In Report Designer, open the report definition to modify. Click the Settings tab.  

2. Click the Other button. 

3. In the Report Settings dialog box, click the Additional Options tab. 

4. Select the additional options to include in the report, and then click OK. 
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Other options 
 

Options Description 

Include amounts in future periods Includes amounts in columns that specify periods beyond the base period 

that is defined on the Report tab. If the future period amounts should not 

appear in the report, clear this box. 

Include missing unit warning Displays a warning message during report processing when a column or row 

is restricted to a reporting unit and the reporting unit does not exist or was 

not selected in the tree (the default). To use a restricted row or column in 

other reports and you do not want to see this warning, clear this check box. 

Exclude inactive accounts Generates reports that exclude inactive accounts if the Microsoft Dynamics 

ERP system supports the exclusion of inactive accounts. If you select this 

check box and the ERP system does not support inactive accounts, your 

reports are not affected. 

 

Other reporting tree options 
 

Option Description 

Restart numbering with every unit Restarts the page numbering of each reporting tree unit throughout a 

report. To use sequential page numbering for all of the selected reporting 

units, do not select this check box. 

Allow rollup less than 1% Allows a rollup of less than 1 percent. If this check box is not selected, an 

entry of .25 in the Rollup % cell of the reporting tree indicates that 25 

percent of each row should be rolled up to the parent. If   this check box 

selected, an entry of .25 would limit the roll up to one-fourth of one percent. 

Disable unit security Removes unit security so all users can drill down into all detail levels. 

 

Consolidate companies that have different fiscal year end dates 
 

Option Description 

Rollup by using default company period number Rolls up accounts by period numbers in multiple-company 

reporting trees. 

Rollup by using default company period end date Rolls up accounts by period dates in multiple-company 

reporting trees. 
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See Also 

Report Settings dialog box 

Page Setup options in report definition 

Account & Transaction Detail in report definitions 

Rolling up data in a reporting tree 

Formatting options for reports 
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Advanced formatting options 

Management Reporter provides several advanced formatting functions for when you design reports.  
 

Function Description 

Dimension filter To access specific sets of data, you can use dimensions in the row definition and column 

definition. Many reports are built to use just the natural account in the row format. The 

rows can also be modified to include dimension values. Dimension filters in the column 

definition are used to access specific dimension values. 

Reporting unit restriction Set up a report row to display only information that is linked to a specific reporting unit. 

For more information, see Restrict a row to a specific reporting unit. 

Non-printing (NP) rows Non-printing rows are helpful in many reports. If several calculations are needed to 

obtain a value, these calculations can be hidden on the printed report. Non-printing 

rows are also helpful for troubleshooting report designs and for advanced cell 

placement. For more information, see Select print control in row definition. 

Column restriction The column restriction within the row definition is helpful for hiding values that are only 

relevant on some rows of the report. When percentage calculations are performed on a 

row, this column restriction prevents total columns or other columns from printing 

where these numbers do not apply. For more information, see Column Restriction cell in 

row definitions. 

IF/THEN/ELSE statement Modify calculations in a row definition or a column definition. For more information, see 

Use a calculation formula in row definition and IF/THEN/ELSE statements in a column 

definition. 

 

Advanced cell placement 
Advanced cell placement, also called forcing, involves the placement of specific values into specific cells. 

The most common example of forcing is moving the correct balance in a Cash Flow Statement. Forcing 

can be used to: 

 Move values from Microsoft Excel into specific cells. 

 Hard code specific values into a report. 

 Modify signs by copying a value from a previous cell and multiplying * -1. 

In many cases, you need to configure your report definition to perform column calculations 

before row calculations. To select this option, complete the following procedure:  

1. In Report Designer, open the report definition. 

2. Click the Settings tab. 

3. Under Calculation priority, select Perform column calculation first and then row. 

Note 
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Designing the report 
When designing your report, create all of the detail rows first to ensure that values are being pulled in as 

you expect, and then add NP (No Print) Format Overrides to suppress the detail that makes up the final 

values. 

When you use the CAL format code in the row definition, you cannot drill down into transaction 

detail. 

The key concept in forcing is to use a formula of destination column = originating column (dot) row code. 

Separate any additional placements for that row by a comma and a space and then add the next column 

reference. For example:   

[Destination Column for this Row]=[Source Column].[Source Row] 

C=C.100, F=D.100 

Examples 
The following examples show how to format the row definition and column definition for forcing for a 

basic cash flow report (Example 1), for forcing a statistical report (Example 2), and the resulting reports. 

Example 1: Basic forcing 

The following is an example row definition using basic forcing. 
 

 
 

 

The following is an example column definition using basic forcing in the row. 
 

 
 

Important 
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The following is the generated report using the previously defined row and column definitions. 
 

 
 

Example 2: Statistical reports 

The following is an example row definition using forcing for a statistical report. 
 

 
 

 

The following is an example column definition using forcing for a statistical report. 
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The following is the generated report using the previously defined row and column definitions. 
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Restrict a row to a specific reporting unit 
When a report row is restricted to a specific reporting unit, that row displays the linked data for the 

named reporting unit, only, and ignores the data for other reporting units in the reporting tree. For 

example, you can create a row that provides details for the total operating expenses for a specific 

department. 

Your report may contain duplicate data when the report contains both a reporting tree and a row 

definition that has more than just the natural account. For example, suppose that you have a reporting 

tree that lists the six departments in your organization and also have a row definition that lists a specific 

account department combination in the row. When you generate the report, the specific account and 

department combination listed in the row is printed on every level of the reporting tree, even though that 

department may not match what is in the tree. This is because the row overrides what is normally filtered 

out by the report definition. 

Restricting a row to a specific reporting unit is one way to avoid duplication of data.  

When you restrict a row that includes dimensions to a child reporting unit, the row amount is 

included without duplication for that unit and for its parent units. 

Restrict a row to a reporting unit 

1. In Report Designer, click Row Definitions, and then select a row definition to modify. 

2. Double-click the appropriate Related Formulas/Rows/Units cell. 

3. In the Reporting Unit Selection dialog box, in the Reporting tree field, select the tree that is 

assigned in the report definition. 

4. Select a reporting unit, and then click OK. The restriction is displayed in the cell of the row definition. 

5. Double-click the cell in the Link to Financial Dimensions column of the restricted row, and then 

enter a link to the financial data system. For more information, see Prepare a link column in a row 

definition. 

See Also 

Relate a format row to an amount row 

Select the base row for a column calculation 

Select a sorting code for a row definition 

Advanced formatting options 

Note 
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Select print control in row definition 
You can specify print codes for each column using the Print Control cell. For a description of available 

print codes, see Regular Print Control codes and Conditional Print Control codes. 

Add print control codes to a report row 

1. In Report Designer, open the row definition to modify.  

2. Double-click the Print Control cell. 

3. In the Print Control dialog box, select a print code, or press and hold the Ctrl key to select multiple 

codes.  

You can also type the print codes directly into the Print Control cell. Use commas to separate 

multiple print codes. 

4. Select any conditional print options. 

5. Click OK. 

Regular Print Control codes 

The following table describes the regular Print Control codes for a row definition. 
 

Print Code Interpretation of Print code Description 

NP Non-printing row Excludes the amounts in the row from being 

printed in the report and from calculations. 

To include a non-printing column in a calculation, 

refer to the column directly in the calculation 

formula. For example, the non-printing row 240 is 

included in the following calculation: 

230+240+250. However, the non-printing row 

240 is not included in the following calculation: 

230:250. 

CS Currency symbol; use currency format in this row Includes the currency symbol in all non-

percentage amounts. Percentage values never 

receive a currency symbol. 

XD Suppress row in account detail report Suppresses the display of accounts on account 

detail reports or transaction detail reports. This is 

useful when a row includes multiple accounts that 

should not be listed in the account detail or 

transaction detail report. 

Note 
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Print Code Interpretation of Print code Description 

X0 Suppress row if all zeros Excludes a row from the report if all cells in that 

row are either empty or contain zeros. This print 

control is meaningful only when option to 

suppress zero balance is not selected in the report 

definition. 

B0 Leave zero columns blank Leaves any columns in the row that contain zero 

amounts empty. 

XR Suppress rollup Suppresses a rollup. If the report uses a reporting 

tree, the amounts in this row are not rolled up 

into subsequent parent nodes. 

SR Suppress rounding Prevents the amounts in this row from being 

rounded. 

XT Suppress row in transaction detail report Suppresses the display of transactions in 

transaction detail reports. This is useful when a 

row includes multiple accounts that should not be 

listed in a transaction detail report. 

 

Conditional Print Control codes 

The following table describes the conditional Print Control codes for a row definition. 
 

Conditional Print Control Code Description 

(none) Clears the conditional print selection. 

DR Prints only the debit balances for this row. 

CR Prints only the credit balances for this row. 

 

See Also 

Advanced formatting options  

Row definition cells 

Add a format code 

Specify a row code in row definition 

Print a report 

Advanced formatting options 
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Column Restriction cell in row definitions 
The row definition Column Restriction cell has multiple purposes. Depending on the type of row, you can 

use the Column Restriction cell to specify one of the following functions: 

 The cell can limit the printing of the row amounts to a specific column. This is useful for creating a 

tabular balance sheet. For information, see the Management Reporter Help documentation.  

 The cell can specify the column of amounts to be sorted. For information, see Select a sorting code 

for a row definition. 

See Also 

Column definitions 

Advanced formatting options 

 



Management Reporter for Microsoft Dynamics ERP 

Management Reporter User Guide 142 

Use a calculation formula in row definition 
A calculation formula in a row definition can include the +, -, *, and / operators, along with IF/THEN/ELSE 

statements. Additionally, a calculation can involve individual cells and absolute amounts, which are actual 

numbers included in the formula. The formula can be up to 1024 characters long. 

Calculations cannot be applied to rows that contain cells defined as the Link to Financial Dimensions 

(FD) type. However, you can place calculations on consecutive rows, suppress the printing of those rows, 

and then total the calculation rows for report purposes.  

Operators in a calculation formula 

A calculation formula uses more complex operators than a row total formula, but allows you to multiply 

(*) and divide (/) amounts with the additional operators.  

To use a range or sum in a calculation formula, you must use the at sign (@) in front of any row code, 

unless you are using a column in the row definition. For example, to add the amount in row 100 to the 

amount in row 330, you could use the row total formula 100+330, or the calculation formula 

@100+@330. 

You must use the at sign (@) before each row code that you use in a calculation formula, or the 

number is read as a real number. For example, the formula @100+330 would add $330 USD to 

the amount in row 100. 

When you reference a column in a calculation formula, the at sign (@) is not required. For more 

information about columns in a calculation formula, see Select report columns in a row definition. 

Create a calculation formula 

1. In Report Designer, click Row Definitions, and then open the row definition to modify. 

2. Double-click the Format Code cell and select CAL. 

3. In the Related Formulas/Rows/Units cell, type the calculation formula. For more information about 

this cell, see Related formulas/rows/units. 

 

 

 

 

 

 

 

 

 

Note 
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Example 

The following is an example of a row definition that shows a total that includes a calculation. 
 

Row 

Code 

Description Format 

Code 

Related 

Formulas/Rows/Unit 

Print 

Control 

Row 

Modifier 

Link to Financial 

Dimensions 

340 Cash at 

Beginning of 

Period 

    NP BB +Account=[1100:1110] 

370 Cash at 

Beginning of 

Year 

CAL @100+@330 NP    

400 Cash at 

Beginning of 

Period 

TOT 340+370      

 

In this example, the calculation formula @100+@330 means that the amount in row 100 is added to row 

330. The row total formula of 340+370 adds the amount in row 340 to the amount in row 370, which 

includes the amount from the calculation formula.  

See Also 

IF/THEN/ELSE statements in a row definition 

Select report columns in a row definition 

Modify a number in selected columns 

Restrict calculation to a reporting unit in a row definition 

Use a row total in a row definition 

Row definitions 

Advanced formatting options 

Select report columns in a row definition 

When the row in a row definition has a Format Code of CAL, and you enter a mathematical calculation in 

the Related Formulas/Rows/Units cell, you must also enter either the letter of the associated column 

and row in the report, such as A.120 to denote column A, row code 120, or you can use the at sign (@) to 

indicate all columns. For example, you can enter @120 to denote all columns in row 120. 

Any mathematical calculation that does not have a column letter or an at sign (@) is assumed to be a real 

number. 

If you use a label row code to reference a row, you must separate the column letter from the label 

with a period (.).  For example, A.GROSS_MARGIN/A.SALES. 

The at sign (@) does not require the period separator. For example, @GROSS_MARGIN/@SALES. 

Note 
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Example 

The following is an example of a row definition that shows a total that includes a calculation. 
 

Row 

Code 

Description Format 

Code 

Related 

Formulas/Rows/Unit 

Print 

Control 

Row 

Modifier 

Link to Financial 

Dimensions 

340 Cash at 

Beginning of 

Period 

    NP BB +Account=[1100:1110] 

370 Cash at 

Beginning of 

Year 

CAL E=C.340 NP    

400 Cash at 

Beginning of 

Period 

TOT 340+370      

 

In this example, the calculation formula E=C.340 means that the calculation in the cell in column C, row 

code 340 is performed only on column E. 

When you reference a column in a calculation formula, the at sign (@) is not required. 

See Also 

Use a calculation formula in row definition 

Use a row total in a row definition 

IF/THEN/ELSE statements in a row definition 

Modify a number in selected columns 

Restrict calculation to a reporting unit in a row definition 

Row definitions 

Advanced formatting options 

Note 
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Modify a number in selected columns 

When you modify a number or calculation in one column of a particular row but do not want to affect 

other columns in the report, you can specify CAL (for Calculation) in the Format Code column of the row 

definition. 

Modify a number in selected columns 

 To perform a calculation on all report (FD) columns, do not enter a column assignment. 

 To restrict a formula to certain columns, enter the column letter followed by an equal sign (=) and the 

formula. 

 You can specify multiple columns. When you use the at sign (@) with specific column placement, the 

@ relates to the row. 

 You can enter multiple column formulas in one row if they are separated by commas. 

 Example 
 

This calculation Creates this action 

@130*.75  The value in row 130 is multiplied for each column by .75, and then the result is put in 

the current row of every column. 

B=@130*.75 The calculation is performed only on column B. 

A,B,C=(@100/@130)*.75 A=(A.100/A.130)*.75B=(B.100/B.130)*.75C=(C.100/C.130)*.75 

 

See Also 

Use a calculation formula in row definition 

Use a row total in a row definition 

IF/THEN/ELSE statements in a row definition 

Select report columns in a row definition 

Restrict calculation to a reporting unit in a row definition 

Row definitions 

Advanced formatting options 
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IF/THEN/ELSE statements in a row definition 

IF/THEN/ELSE statements can be added to any valid calculation and used with the CAL format. Enter 

IF/THEN/ELSE calculation formulas in the cell in the Related Formulas/Rows/Units column according to 

the following format: 

IF <true/false statement> THEN <formula> ELSE <formula> 

The ELSE <formula> portion of the statement is optional. 

IF statements 

The statement that follows the IF statement can be any statement that can be evaluated as true or false. 

The statement that follows the IF statement can appear as described below: 

 IF A.200>0 (simple evaluation) 

 IF A.200>0 AND A.200<10,000 (complex statement) 

 IF A.200>10000 OR ((A.340/B.1200)*2 <1200) (complex statement containing multiple expressions) 

The term Periods in an IF statement is the number of periods for the report. This term is commonly used 

for calculating a year-to-date average. For example, when running a report for period 7 YTD, 

B.150/Periods means to divide the value in row 150 of column B by 7. 

THEN and ELSE formulas 

The THEN and ELSE formulas can be any valid calculation from the simplest value assignments to 

complex formulas. Note the following formula: 

IF A.200>0 THEN A=B.200 

The statement specifies that "if the value in the cell in column A of row 200 is greater than zero, then 

place the value from the cell in column B of row 200 into the cell in column A of the current row." 

In this statement, you can also use the @ character in either TRUE/FALSE evaluations or in the formula to 

represent all columns. For example, the formula described in the preceding IF/THEN statement places a 

value in one column of the current row. Other examples are described below:  

 IF A.200 >0 THEN B.200: When the value in cell A.200 is positive, the value from cell B.200 is 

positioned into every column of the current row.  

 IF A.200 >0 THEN @200: When the value in cell A.200 is positive, the value from each column in row 

200 is positioned into the corresponding column in the current row.  

 IF @200 >0 THEN @200: If the value in row 200 of the current column is positive, the value from row 

200 is positioned into the same column in the current row. 

See Also 

Use a row total in a row definition 

Use a calculation formula in row definition 

Restrict calculation to a reporting unit in a row definition 

Row definitions 

Advanced formatting options 
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Restrict calculation to a reporting unit in a row definition 

To restrict a calculation to a single reporting unit in a reporting tree, so that the resulting amount is not 

rolled up to a higher-level unit, you can use the @Unit code in the Related Forumulas/Rows/Units cell 

in the row definition. The @Unit code is listed in column B of the reporting tree, Unit Name. The values 

are not rolled up, but the calculation is evaluated at every level of the reporting tree. 

To use this function, you must have a reporting tree associated with the row definition. 

The calculation row can refer to a calculation row or a financial data row. 

The calculation is recorded in the Related Formulas/Rows/Units cell of the row definition, along with the 

financial data-type restriction. The calculation must use a conditional calculation beginning with an IF 

@Unit construction, such as the following calculation: 

IF @Unit(SALES) THEN @100 ELSE 0 

This calculation places the amount from row 100 in each column of the report, but only for the Sales unit. 

If there were multiple units named SALES, the amount would appear in each of those units. 

Additionally, row 100 could be a financial data row and further be defined as non-printing, which prevents 

that amount from appearing in all units in the tree. You can also limit the amount to a single column of 

the report by using the column restriction, such as column H, to print the value only in specific columns of 

the report. 

You can include OR combinations in an IF statement, for example:  

IF @Unit(SALES) OR @Unit(SALESWEST) THEN 5 ELSE @100 

You can specify a unit in a calculation-type restriction in one of the following ways: 

 Enter a unit name to include those units that match. For example, IF @Unit(SALES) allows the 

calculation for any unit named SALES, even if there were several SALES units within the reporting 

tree. 

 Enter the company and unit name to restrict the calculation to SALES units in the ACME company 

only. For example, IF @Unit(ACME:SALES). 

 Enter the full hierarchy code from the reporting tree to restrict the calculation to a specific unit. For 

example, IF @Unit(SUMMARY^ACME^WEST COAST^SALES). 

To find the full hierarchy code, right-click in the reporting tree definition, and then select 

Copy Reporting Unit Identifier (H-code). 

Restrict a calculation to a reporting unit 

1. In Report Designer, click Row Definitions, and then open the row definition to modify. 

2. Double-click the Format Code cell, and then select CAL. 

3. Click the Related Formulas/Rows/Units and type the conditional calculation starting with an IF 

@Unit construction. 

See Also 

Use a row total in a row definition 

Note 

Note 
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IF/THEN/ELSE statements in a row definition 

Select report columns in a row definition 

Modify a number in selected columns 

Row definitions 

Advanced formatting options 
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IF/THEN/ELSE statements in a column definition 
An IF/THEN/ELSE statement enables any calculation to be conditional upon the results of any other 

column. You can refer to other columns, but not to a report cell in the IF statement. Any calculation must 

be applied to the whole column. 

For example, the statement IF B>100 THEN B ELSE C*1.25 means the following: If the amount in column 

B is greater than 100, place the value from column B in the CALC column. If the amount is not greater 

than 100, multiply the value in column C by 1.25, and place the result in the CALC column. 

Always follow the IF clause with a logic statement that evaluates to TRUE or FALSE. The formulas that you 

use for both the THEN clause and the ELSE clause can contain references to any number of columns, and 

can be as complex as you want. 

You cannot place the results of a calculation in any other column; the results must be in the 

column that contains the formula. 

For more information about creating IF/THEN/ELSE statements, see IF/THEN/ELSE statements in a row 

definition. 

See Also 

IF/THEN/ELSE statements in a row definition 

Calculation column in a column definition 

Advanced formatting options 

Note 
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Generate reports 

Reports are generated based upon the options specified in the report definitions. You can generate 

reports in various output types and set up schedules to generate reports automatically. 

 Generate reports to the report library 

 Report viewing options 

 Schedule reports 

 Missing account analysis 

 Report security options 
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Generate reports to the report library 
Several options are available for distributing generated reports. After a report definition is created, a 

report can be generated to a single location in the report library of Management Reporter, or generated 

to multiple locations with multiple forms of delivery. Management Reporter can publish links to generated 

reports in network locations or in Microsoft SharePoint
®

 sites. 

To send report links through email, see Share a report. 

You can generate reports only to folders and locations that you have access to in Management 

Reporter. 

Generate to a single location in the report library 

1. In Report Designer, open the report to generate. Click the Output and Distribution tab. 

2. In the Output name field, enter a name for the report after it is generated. This name does not have 

to be the same as the report definition name. 

3. To view the report after it is generated, select the View report when generated check box. 

4. Select Generate to a single report library location and type the address of the destination, or click 

 to browse to a destination for the generated report.  

5. Select the options to include in the report under the appropriate output heading. For more 

information, see Report viewing options. 

Generate to multiple locations in the report library 

1. In Report Designer, open the report to generate. Click the Output and Distribution tab. 

2. In the Output name field, enter a name for the report after it is generated. This name does not have 

to be the same as the report definition name. 

3. To view the report after it is generated, select the View report when generated check box. 

4. Select Generate to multiple report library locations. 

5. Click in the Report Library Location pane and type a destination address for the generated report. 

You can also click Add to browse to a destination folder, and then click OK to add the location to the 

report definition. 

6. To add another report library location, repeat step 5. To remove a location from the list, select a 

location, and then click Remove. To modify an existing location, double-click on the location, and 

then type or browse to a new destination address. 

7. Select the options to include in the report under the appropriate output heading. For more 

information, see Report viewing options. 

Note 
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Generate a report link 

When you generate a report to the report library, you can also generate a link to a SharePoint site or 

another network location. The related report link can open the report in one of the supported report 

output types. For more information, see Report viewing options. 

Each report library location can create multiple related report links. Security settings for the report library 

folder are applied when the related report link is opened. 

If you are using a computer that has Windows Server
®

 2008 or Windows Server 2008 R2, you 

must have the Desktop Experience feature turned on in order to post a report to a SharePoint 

site. Open Server Manager, click Features, click Add Features, and then select Desktop 

Experience. This may require a restart. 

1. In Report Designer, open the report to generate. Click the Output and Distribution tab. 

2. In the Output name field, enter a name for the report after it is generated. This name does not have 

to be the same as the report definition name. 

3. To view the report after it is generated, select the View report when generated check box. 

4. Select Generate to multiple report library locations. 

5. Click in the Report Library Location pane, and then enter the destination for the generated report. 

At least one report library location must be selected in order to generate a related report link. 

6. Double-click in the Related Report Link Location pane, and then type an address to a network 

location or a SharePoint site. You can also click Browse to browse to a destination folder, and then 

click OK to add the location to the report definition. These address paths can also be copied into or 

from other report definitions. 

If you are using Windows XP
®

, the Open Files dialog box is not available, and you must type 

the address of the destination folder.  

7. To add another related report location, repeat step 6. To remove a location from the list, select a 

location, and then click Remove. To modify an existing location, double-click the location and type a 

new destination address. 

8. Select the options to include in the report under the appropriate output heading. For more 

information, see Report viewing options. 

See Also 

Report viewing options 

Share a report 

Generate reports 

Note 

Note 
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Report viewing options 
When a report is generated, you can open the report in Desktop Viewer, as a Microsoft Excel worksheet, 

or as an XPS document.  

The following sections provide additional information about the options for viewing a report:  

 General report options 

 Microsoft Excel options 

 XPS options 

Report options 

Report options are defined in the Output and Distribution tab of a report definition. For more 

information about generating reports, see Generate reports to the report library. 

General report options 

The following table describes options that are available for all report output types. 
 

Option Description 

Include headers and footers Inserts the header and footer information that you configure on the 

Headers and Footers tab of a report definition. 

Include format rows Inserts the row definition rows (DES, LFT, RGT, and CEN rows) in the 

report. If a row is blank, it is considered a format row and will not be 

printed, unless Include format rows is selected. By default, this option 

is selected. 

Note 

When this option is selected and the Include underscore 

rows option is also selected, the printed report might display 

duplicate underscores under the final total rows. 

Include underscore rows Inserts underscore rows and double underscore rows in the report. 

Report duplicate accounts or dimensions Generates an exception report that shows the financial data accounts 

that are duplicates. 
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Microsoft Excel options 

The Microsoft Excel output type opens a report as an Excel spreadsheet. To view reports in Microsoft 

Excel, you must have Microsoft Excel 2007 or newer installed on your computer. For more information, see 

Excel and Management Reporter. 

The following table describes the options that are available for reports that are opened in Microsoft 

Excel format. 
 

Option Description 

Include fonts and shading Formats the report by using the fonts and shading that you used in the report 

building blocks and in the report definition on the Headers and Footers tab. 

For example, if you added shading or font colors to heading text, this option 

includes that formatting in the Excel spreadsheet. 

Generate to a single worksheet Generates the whole report, which includes reporting trees and drill down 

reports, to a single worksheet. 

Include comments Generates the whole report and includes any comments that are attached to the 

report. 

 

XPS options 

The XPS output type opens a report in a read-only format. To view a report in XPS, you must have the 

Microsoft XPS Viewer installed. For more information, see XPS and Management Reporter. 

The following table describes the options that are available for reports that are opened in XPS format. 
 

Options Description 

Include bookmarks For every unit of the associated tree that is included in the XPS file, a bookmark 

will be defined in the XPS file. 

Include column and page breaks Inserts column breaks and page breaks into the report. 

Include comments Generates the whole report and includes any comments that are attached to 

the report. 

Column width Specifies the width of the column, in characters. 

Wrap text If the text in a column exceeds the number of characters specified in the column 

width, this options wraps the text to keep all of the text in the column.  

If the Autofit option is selected, this option is not available. 

Autofit Automatically adjusts the width of the columns to fit the cell content. 
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See Also 

Generate reports to the report library 

Headers and footers in report definitions 

Use additional file types with Management Reporter 

Generate reports 



Management Reporter for Microsoft Dynamics ERP 

Management Reporter User Guide 156 

Schedule reports 
Many companies have a core set of reports that are run at scheduled intervals to align with their business 

processes. To provide for this practice, you can schedule a report to be generated regularly, such as daily, 

weekly, monthly, or annually. This can be a single report or a group of reports that includes multiple 

companies. You must enter your credentials for each of the companies that are specified, such as those in 

a reporting tree definition. If the credentials are not valid, the report will display only the information that 

you have access to, such as the company that you are logged on to at the time. Output information is 

read first from the report group, and then from the individual reports.  

To create, modify, and delete report schedules, you must have the role of designer or administrator. 

As report schedules are created and saved, they are displayed in the navigation pane under Report 

Schedules. You can create folders to organize the reports. 

If a single report in a schedule does not run, all other reports will continue to run. 

Create a report schedule 

To create a report schedule, you must have the role of designer or administrator. When a report is run, the 

credentials of the user who created the schedule are used to generate the report. 

1. In Report Designer, on the File menu, click New, and then select Report schedule.  

2. Under Settings, select an individual report or a report group to schedule. Only reports or report 

groups for the company or building block selection that you are currently logged on to are available. 

3. Select the Active check box to turn on the report schedule. Only the creator of the report or an 

administrator can activate or inactivate a report schedule. 

4. Click the Permissions button to enter company credentials. By default, your logon information is used 

for the company that you are logged on to. If other companies are included, such as in reporting tree 

definitions, select Use separate credentials, and then enter the credentials for any other company 

that is included in the report schedule. You can select Windows Authentication or type a user name 

and password for each company. Select the Save credentials check box to save the credentials for 

these companies, and then click OK to close the dialog box. For more information about how to enter 

and save credentials, see Credentials.  

5. Under Frequency, in the Start recurrence field, select the date when the schedule is to start. By 

default, the current system date of the client computer is selected.  

6. In the Run report at field, select the time when the report should run. If you enter a time that is 

before the current system time, the report runs on the next scheduled date. 

7. In the Recurrence pattern area, specify how often the report is run. By default, Daily is selected with 

an Interval (days) value of 1. Other options include Weekly, Monthly, and Yearly.  
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8. In the Range of recurrence area, select when the report should stop being generated. 

 No end date – The report schedule runs indefinitely. 

 Set number of occurrences – The report schedule runs for the specified number of times, and 

then is inactivated. 

 End by – The report schedule ends on the specified date. 

9. Click Save in the toolbar. In the Save As dialog box, enter a unique name and description for the 

report schedule. 

Copy a report schedule 

To copy a report schedule, you must have the role of designer or administrator. Even if an administrator 

modifies the report schedule, the report maintains the credentials of the user who created the report. 

1. In Report Designer, click Report Schedules in the navigation pane, and open a report schedule to 

copy. 

2. On the File menu, click Save As, and then enter a new name and description for the schedule in the 

Save As dialog box. Click OK, and the new schedule is displayed in the navigation pane. 

3. In the new schedule, modify the fields and information as needed, and then click Save on the toolbar, 

or click Save on the File menu. 

Delete a report schedule 

To delete a report schedule, you must be the owner of the report schedule or have a role of administrator.  

1. In Report Designer, click Report Schedules in the navigation pane.  

2. Select the report schedule to delete, and then click Delete or press the Delete key. 

3. In the deletion verification dialog box, click Yes to permanently delete the report schedule. If you do 

not have permission to delete the schedule, a message is displayed and the report is not deleted. 

Credentials 

If you do not enter credentials that are required for all companies included in the reports, you receive the 

following message when you save the report schedule: “You must enter your credentials for the 

companies that are contained in this report schedule. Select the Permissions button to enter in your 

credentials.” 

For example, Phyllis logs on to Company A using her logon and password. She creates a schedule for an 

individual report that uses a reporting tree definition to collect data from multiple companies. When this 

report schedule is saved, Phyllis is prompted to enter the credentials for the other companies that are 

specified in the reporting tree definition. 

When your credentials expire, the affected reports in the report schedule are not generated until the 

credentials have been updated. A message is also displayed in the report queue to indicate that 

permissions must be updated. 
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The report schedule fails if any of the following scenarios occur because they require credentials: 

1. A new company has been added to a report tree for an individual report. 

2. A report in a report group has been modified. 

3. A new report for an additional company has been added to a report group. 

To continue, click the Permissions button in the Report Scheduling dialog box, and then enter the 

appropriate credentials. 

See Also 

Create and manage report groups 

Generate reports 
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Missing account analysis 
You can search for financial accounts and dimensions that might be missing across all row definitions, 

reporting tree definitions, and report definition in a building block group. This is especially useful when 

you create or update several account or building blocks during a short time period, and you want to verify 

all new information is included in your reports.  

Management Reporter determines missing accounts by using the lowest and highest values from the row 

definition or reporting tree definition, and then displays a list of accounts that are not in the row 

definition or reporting tree definition, but that are in the financial data. If a missing account is greater than 

or less than the values in the row definition, that account is not included in the list of missing accounts. 

For validation purposes, this process should be run before you generate monthly reports, and 

when you create new building blocks.  

Reports that have ranges of values are less likely to encounter missing accounts. When possible, use 

ranges in the building block to include new accounts when they are created. 

To search for duplicate accounts, see Report viewing options. 

Run missing account analysis 

If any report definition is set to @ANY company, then you can log on to a specific company and run a 

missing account analysis for that company. 

If a new company has been added in Management Reporter, you must add the new company to 

the reporting trees in any existing reports or the company will not be included in the missing 

account analysis.  

1. In Report Designer, click Tools, and then click Missing Account Analysis. 

2. In the Company filter field, select a company to filter results on, or select All (no filter) to display 

results from all available companies. 

3. In the Dimension filter field, select a dimension to filter results on, or select All (no filter) to view all 

dimension information for all available dimensions. 

4. In the Group by field, select an option for sorting the results. You can sort results according to the 

building block that is affected, or you can sort results by dimension and value sets.  

5. Review the displayed results. When you select an item in the upper pane, the lower pane displays 

additional information about the exception. This includes related dimensions, values, and reports.  

6. To open the affected item, click the associated icon that is displayed in the list pane, or right-click the 

item and select Open. To select multiple items, hold down the Ctrl key as you select the items in the 

lower pane. 

 

 

 

Tip 

Note 
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7. If any values, building blocks, or reports are returned that should not be included in the analysis, 

right-click the item and select Exclude, or select the Exclude check box next to the item to remove 

the item from the list. Excluded items are not included when the list is refreshed. To select multiple 

items, hold down the Ctrl key as you select the items in the lower pane. 

To view all items, included any results that you previously selected to exclude from the analysis, select 

the Show excluded building blocks and values check box, and then click Refresh. 

8. Click Refresh to refresh exceptions that you have addressed. Click Yes to perform a full refresh of all 

of the results, or click No to perform a partial refresh of addressed items. 

The form is automatically refreshed upon opening, unless the form has been opened in the 

last 15 minutes. 

9.  When the issues are resolved, click OK to close the dialog box. 

Keyboard shortcuts for missing account analysis 

When you run a missing account analysis in Management Reporter, the following keyboard shortcuts are 

available: 
 

To do this Use this keyboard shortcut 

Filter by company Alt+C 

Filter by dimension Alt+D 

Select the Group by field Alt+G 

Show excluded blocks and values Alt+S 

Refresh results Alt+R 

Exclude the selected building block Alt+X 

Exclude the selected row definition Ctrl+B 

Exclude the selected dimension value Ctrl+D 

Open the selected report definition Ctrl+R 

Open the selected row definition Ctrl+O 

 

For more information about keyboard shortcuts in Management Reporter, see the Management Reporter 

Help documentation.  

See Also 

Report viewing options 

Generate reports 

Note 
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Report security options 
Management Reporter has several levels of security for reports to help ensure that only authorized users 

can view report data, and that users can view only the data that they have access to. 

For example, if you have a report that must be distributed to several users, and each user has different 

levels of security permissions, you might consider generating the same report multiple times to make sure 

that each user sees only the data that the user has access to. This would result in multiple copies of the 

same report, stored in multiple locations on a network share or in email. 

With Management Reporter, you can generate a report with personalized levels of access, so that each 

user can view only the information that the user has access to. You would need to maintain only one copy 

of the report.  

Different levels of security can be applied based on your business model or business need. For example, 

you might secure reports at the only folder level in the report library, or you might secure an individual 

report in the report library. If your report uses a reporting tree, you can secure individual reporting units in 

the reporting tree. In all cases, a secure report link is created whenever you apply one or more levels of 

security. When a user opens the report link, the report displays only the information that the user has 

been granted permission to see, based on the security that is applied. 

Reporting unit security 

The lowest level of report security is based in the reporting tree. Users can be assigned to specific units in 

the reporting tree definition. For more information, see Restrict access to a reporting unit.  

Report library security 

The next level of security is in the report library. Users or user groups can be granted access to different 

folders and reports in the report library. For more information, see Report library security and Change 

report library permissions. 

Report link security 

After a report is generated, a report link is created in the output locations that are specified on the 

Output and Distribution tab of the report definition. You must specify a location in the report library 

where the report is generated to, and the security settings of the output location are applied to the 

report, so you can generate to a public folder in the report library or to a more secure folder. If you select 

a Microsoft SharePoint or network location for the related report link, you must also select a report library 

location. The report library location determines the security access when the user opens the report link.  

Only active Management Reporter users can open a report link, and users can only open report links that 

they have been granted access to. This helps to ensure that the report displays only the information that 

the user has access to. 

For more information about report links, see Generate reports to the report library. 
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See Also 

Generate reports 

Security, user roles, and permissions 

Generate reports 
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Organize reports 

After you have designed building blocks and generated reports, it is helpful to organize these objects so 

that they are easier for users to locate. The following topics explain how to organize existing reports, 

building blocks, and objects in Management Reporter. 

 Maintain report versions 

 Create a folder 

 Move a folder, report, or building block 

 Rename a folder, report, or building block 

 Create and manage report groups 

 Delete report library items 
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Maintain report versions 
The report that appears in the report library is always the most current version of the report. However, a 

report can have many different versions. Each time that a report is generated, Management Reporter puts 

the new version of the report in the report library. 

When you delete a version of a report, it cannot be recovered. 

View a specific version of a report 

1. In Desktop Viewer, click Report Library in the navigation pane. 

2. Right-click a report, and then select Show Versions.  

3. In the Versions dialog box, select the report version to view, and then click Open. 

Rename a version of a report 

1. In Desktop Viewer, click Report Library in the navigation pane. 

2. Right-click a report, and then select Show Versions.  

3. In the Versions dialog box, select the report version to rename, and then click Rename. The Name 

field becomes active. 

4. Type the new name, and then press Enter. 

Delete a specific version of a report 

1. In Desktop Viewer, click Report Library in the navigation pane. 

2. Right-click a report, and then select Show Versions. 

3. In the report Versions dialog box, select the report version to delete, and then click Delete. 

4. Click Yes to permanently delete the report. 

See Also 

Insert external files into the report library 

Change report library permissions 

Report viewing options 

Organize reports 

 

 

Note 
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Create a folder 
Use folders to organize your reports, building blocks, and other objects in Management Reporter. 

Create a folder in Report Designer 

Use folders to organize your building blocks in Report Designer. All folders are specific to the type of 

building block they contain. For example, all folders that contain row definitions are located in the Row 

Definitions pane of Report Designer. 

1. In Report Designer, select the type of building block to organize in the navigation pane. For example, 

to sort a row definition, click Row Definitions. 

2. In the navigation pane, select the existing folder that the new folder will be created under, and then 

complete one of the following actions: 

 Right-click the parent folder and select New Folder. 

 Select the parent folder, click File, and then select New Folder. 

3. When the new folder appears, type the name of the new folder and press Enter. 

Create a folder in the report library 

In Desktop Viewer, you can create folders to organize your reports in the report library. 

When you move a report from its original location in the report library, you are only moving a 

copy of that report, and the moved report is not listed in the version list of the original report. For 

more information about report versions, see Maintain report versions. 

To permanently change the report library output location for a report, see Report viewing 

options. 

1. In Desktop Viewer, click Report Library in the navigation pane. 

2. In the navigation pane, select the existing folder that the new folder will be created under, and then 

complete one of the following actions: 

 Right-click the parent folder and select New Folder. 

 Select the parent folder, click File, and then select New Folder. 

3. When the new folder appears, type the name of the new folder and press Enter. 

See Also 

Organize reports 

 

 

 

Note 
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Move a folder, report, or building block 
Use folders to organize your reports, building blocks, and other objects in Management Reporter.  

Move a folder or object in Report Designer 

When you move a folder or building block that is used for a report, Management Reporter maintains the 

link to the moved object. As a result, you do not need to update the associations between building blocks 

and reports. 

1. In Report Designer, use the navigation pane to locate the folder or building block to move.  

2. Select the folder or item, and then drag it to a new location in the navigation pane. All contents of a 

folder are moved with the folder. 

Move a folder or report in the report library 

If you move a folder in the report library that is used as the output location for a report, the report library 

location in the associated report definition is updated. 

However, if any of the reports in the moved folder have related report links, you must manually update 

the report links on the Output and Distribution tab of the report definition. For more information about 

related report links, see Generate reports to the report library. 

When you move a report, you can move either the most recent version or all versions of the report. If you 

move a specific version, that version is no longer associated with the original report and will not be 

updated when the report is regenerated. 

1. In Desktop Viewer, click Report Library in the navigation pane. 

2. Select a folder or report, and then drag it to a different folder or to the report library. All contents of a 

folder are moved with the folder. 

See Also 

Change report library permissions 

Organize reports 
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Rename a folder, report, or building block 
You can rename folders, reports, building blocks, and other objects in Management Reporter to help 

organize your files. Depending on the type of object that you rename, you might have to update 

associations to that object.  

Rename a folder or building block in Report Designer 

In Report Designer, you can rename folders, report definitions, row definitions, column definitions, and 

reporting tree definitions.  

When you rename a building block, you must update any reporting definitions that use the 

building block, or new report cannot be generated successfully. 

1. In Report Designer, use the navigation pane to locate the folder or object to rename. 

2. Right-click the folder or object, and then click Rename. The Name field in the navigation pane 

becomes active. 

3. Type a new name, and press Enter. 

4. If the item is a row definition, a column definition, or a reporting tree definition, you must update 

other building blocks that are associated with the item. Right-click the item that you renamed in step 

3, select Associations, and then select an item in the list to update it.  

5. Repeat step 4 until all associated items are updated. 

Rename a report or folder in the report library 

In Desktop Viewer, you can rename folders, reports, report versions, and external documents in the report 

library. 

When you rename a folder that is used as the output location for a report, the link to the renamed folder 

is used as the output location for all future versions of that report. 

When you rename a report in the report library, you are renaming a specific version of the report. The 

next time that the report is generated, the original report name is used, but your renamed version still 

appears in the version list.  

1. In Desktop Viewer, click Report library in the navigation pane. 

2. Right-click an item, and then click Rename. 

3. Type a new name, and then press Enter. 

See Also 

Insert external files into the report library 

Change report library permissions 

Organize reports 

Note 
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Create and manage report groups 
You can group report definitions to generate multiple reports at the same time. 

To create, modify, delete, and generate report groups, you must have a role of designer or administrator. 

Users with a role of generator can generate and view report groups and can also modify the user report 

definitions setting for report groups. 

View a report group 

1. In Report Designer, click Report Groups in the navigation pane.  

2. Double-click a report group to open the group. The reports that are included in that group are 

displayed in the viewer window. 

Create a report group 

1. In Report Designer, click Report Groups in the navigation pane.  

2. On the File menu, select New, and then select Report Group Definition, or click  in the toolbar to 

open a new report group in the viewer window. 

3. Click Add, and then select the reports to include in the report group. Press and hold the Ctrl key to 

select multiple reports. 

4. Click OK in the Add dialog box. The new reports are added to the list in the Reports in Group 

window. 

5. On the File menu, click Save, or click  in the toolbar to save the new report group.  

6. To save all of the reports in the report group to the same location in the report library, select the 

Override report library location from report definition check box. Click  to select a new 

location in the report library for all of the reports in the report group. This setting is saved per report 

group.  

7. In the Save As dialog box, enter a unique name for the report group, up to 255 characters. The Name 

field cannot be left blank.  

Modify a report group 

1. In Report Designer, click Report Groups in the navigation pane.  

2. To change the name of a report group, right-click the report group in the navigation pane and select 

Rename. 

3. To add report definitions to the report group, double-click the report group to open it, and then click 

Add. Select the reports to include in the report group, and then click OK. 

4. To remove a report from the report group, select the report to remove, and then click Remove. 

5. To modify the order in which the reports are generated, select a report in the list, and then click Move 

up or Move down. 
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Generate a report group 

If you have scheduled reports to be generated in the report definition settings, you can override those 

settings and generate a report immediately. 

1. In Report Designer, click Report Groups in the navigation pane. 

2. Select the report group to generate. Click  to open the Override Report Definition Settings 

dialog box. 

3. Select the Override report dates from report definition check box. 

4. Select the Base period and Base year for your report. 

5. To view the last report in the report group in Report Viewer, select the View last report in report 

group when generated check box. If this option is not selected, Report Viewer does not open when 

the report group has been generated.  

6. Click OK. If you selected the option in step 5, the Report Queue Status dialog box opens, and Report 

Viewer opens to display the last generated report in the report group. 

Delete a report group 

1. In Report Designer, click Report Groups in the navigation pane. 

2. Right-click the report group to delete in the navigation pane, and then select Delete. 

3. When a deletion verification window appears, click Yes. 

See Also 

Schedule reports 

Organize reports 
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Delete report library items 
If you have Delete permissions, you can delete reports, folders, and external files in the report library. 

However, Delete, Edit, and Create permissions can be specific to a report or folder. For example, you 

might have Delete permissions for a specific report or a specific folder in the report library, but not for 

other reports or folders. 

Deleting works differently for different report library items. The following information describes how the 

Delete function works with each item: 

 Report – A report can have many versions. When you delete a report, you are prompted to delete the 

current version or all versions. To select the version from a list, select the report, and then click Show 

Versions on the View menu. 

 External File – When you delete an external file, you are prompted to confirm the deletion. External 

files do not have versions. 

 Folder – When you delete a folder, you are prompted to confirm the deletion. If you click Yes, the 

folder and all of its reports and external files are deleted. 

Delete report library items 

1. In Desktop Viewer, click Report Library in the navigation pane. 

2. Select an item, and then press Delete. To select multiple items, press and hold the Ctrl key. 

3. If you have selected one or more reports to delete, you are prompted to delete all versions or the 

most recent version. If you are deleting reports, in addition to folders or external files, you are 

prompted to delete all versions or the most recent version; however, this message pertains only to 

reports. 

See Also 

Insert external files into the report library 

Change report library permissions 

Organize reports 
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Use additional file types with Management 

Reporter 

In Management Reporter, you can work with other types of files, including worksheets in Microsoft Excel, 

XPS files, and XBRL. Features and functionality vary depending on the type of file that you are using. 

 Excel and Management Reporter 

 XPS and Management Reporter 

 XBRL and Management Reporter 
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Excel and Management Reporter 
Microsoft Excel is a spreadsheet application that lets you store, modify, and graph data. You can use 

Management Reporter to link a report to an Excel spreadsheet to combine data and to summarize and 

display information in additional ways. For more information, see Link reports to Microsoft Excel.  

You can also create a link that opens a report as an Excel spreadsheet by selecting Excel as the report 

output type in the report definition. For more information, see Report viewing options and Share a report. 

See Also 

Prepare a link column in a row definition 

Match worksheets with fiscal periods 

Identify an Excel file in a reporting tree 

Link reports to Microsoft Excel 

By linking rows to cells in a Microsoft Excel spreadsheet, you can combine the data from report building 

blocks and Excel to summarize and display information in additional ways.  

A row definition typically contains links to financial accounts and dimension. These links allow for dynamic 

reporting. Management Reporter pulls the information from the links every time that you generate a 

report. In this manner, the report always uses the most current information available. 

You can also create links from a row to a cell in an Excel spreadsheet file that is maintained separately 

from your Management Reporter reports. For example, you can create a report that compares actual 

expenses from Microsoft Dynamics ERP to the budget in an Excel spreadsheet. 

When used with a reporting tree, linking enables each unit in the reporting tree to use a different Excel 

workbook or worksheet. This means that reports can be formatted to pull in the same data or distinct data 

for each level of the report. 

You can access data in an Excel worksheet by using a combined worksheet link or a separate worksheet 

link. For more information, see Using a combined worksheet link and Using a separate worksheet link. 

Using a combined worksheet link 

A Financial Dimensions + Worksheet link, also known as a combined worksheet link, combines 

references to cells in an external worksheet file into the same link column that you use for links to 

accounts or dimensions. When you use this method to access data in an external worksheet file, some 

rows in a column of the report will contain data from your financial data system, and other rows in that 

same column will contain data from the external worksheet file. We recommend that you use this method 

when you are importing limited amounts of data, such as work hours, head count, or units sold, that you 

do not have to associate with a specific unit in the reporting tree. 

This method does not require a reporting tree, but can only pull data from a single worksheet per 

link. 

Note 
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Using a separate worksheet link 

A separate worksheet link lets you access multiple rows and columns of data in an external worksheet file, 

and to associate one or more external worksheet files with one or more reporting units in the reporting 

tree. You create a special column in the row definition that links to cells in the external worksheet file, and 

then add the names of the external worksheet files to the reporting tree. 

If you link to spreadsheets that have identical worksheet layouts, you reduce the number of link 

columns that are required in the row definition and the time that is required to maintain your 

report. 

Linking to Management Reporter reports 

In Management Reporter, you can use data from an Excel spreadsheet that was generated by 

Management Reporter and link it to another Management Reporter report. This is useful when you want 

to use the data from one Management Reporter report in other Management Reporter reports. You can 

link to individual reports or, if you use a reporting tree, you can link to data in multiple Management 

Reporter reports. 

See Also 

Prepare a link column in a row definition 

Match worksheets with fiscal periods 

Identify an Excel file in a reporting tree 

Use additional file types with Management Reporter 

Prepare a link column in a row definition 

Within a row definition, one or more link columns contain the links to the dimensions and Microsoft Excel 

files. Each row definition can have up to 100 link columns. The row definition column heading indicates 

the link types that are supported in that column.  

By default, the row definition includes one link column titled Link to Financial Dimensions, for linking to 

the financial data. You can add new link columns, and you can modify the link type of existing link 

columns. 

Each link column can link to one of the following types of data. 
 

Data Type Description 

Financial Dimensions Links to only the financial data system. 

External Worksheet Links to an Excel file based on the reporting tree. 

Financial Dimension + Worksheet Links to the financial data system and/or to an Excel file. 

Management Reporter Report Links to another report in Management Reporter.  

XBRL taxonomy Links to an XBRL Taxonomy 

 

Note 
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Add a link column to a row definition 

1. In Report Designer, open the row definition to modify.  

2. On the Edit menu, click Row Links to open the Row Links dialog box. 

3. In the Row Links dialog box, click New. 

4. Under Link definition, in the Link type list, select one of the following options: 

 Financial Dimensions – Links to only the financial data system. 

 External Worksheet – Links to an Excel file that is specified in the reporting tree. 

 Financial Dimension + Worksheet – Links to the financial data system. Optionally, you can also 

link to an Excel file or to another Management Reporter report.  

 XBRL Taxonomy – Links to an XBRL taxonomy. For more information, see Link to XBRL 

taxonomies. 

 Management Reporter Worksheet – Links to another worksheet in  Management Reporter that 

is specified in the reporting tree. 

5. In the Link name field, type a name for the link column. 

6. If you selected the Financial Dimensions + Worksheet link type in step 4, you can link to an Excel 

worksheet or another report in Management Reporter. 

 To link to an Excel worksheet, enter the file path in the External worksheet file path field, or click 

 to browse to the file. 

 To link to another report in Management Reporter, enter the file path in the Management 

Reporter worksheet path field, or click  to browse to the file. To link to a specific tab in the 

worksheet, enter the tab name in the Worksheet tab name field.  

You can link to any report in the Management Reporter report library, even if you do not 

have access to that report. However, the linked data will not be included in the report that 

you generate. 

Modify the properties of a link column in a row definition 

1. In Report Designer, open the row definition to modify. 

2. On the Edit menu, click Row Links. 

3. In the Row Links dialog box, select a link from the table. 

4. Under Link definition, modify any of the available properties, and then click OK. 

Delete a link column from a row definition 

1. In Report Designer, open the row definition to modify. 

2. On the Edit menu, click Row Links. 

3. In the Row Links dialog box, select a link from the table. 

4. Click Delete. 

Note 
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Referring to Excel worksheet names 

To reference a specific Excel worksheet, type the name in the Worksheet name field of the Row Links 

dialog box. When you reference a particular Excel worksheet, the name of the worksheet must be at least 

two characters, for example, [workbook.xlsx]AA. 

When you reference a specific cell in an Excel worksheet, use the column letter of the cell and row number 

references. For example, C10 would be column C, row 10. Management Reporter does not support 

referencing ranges of cells in an Excel worksheet. 

The following examples are valid references for FD + worksheet links: 

 @WKS(B5) 

 @WKS(B=B5) 

 @WKS(B=B5, C=C5, D=D5) 

The following examples are valid references for worksheet links: 

 B5 

 B5=B5 

 (B=B5, C=C5, D=D5) 

Because the column definition is defined separately from the row definition in Management Reporter, you 

must determine which report columns are to receive the data from the Excel worksheet. If you specify a 

single cell, such as B5, the value is only added in a WKS column. If you use specific cell references like 

B=B5, you can position Excel values in FD, WKS, or CALC columns. 

The report columns that accept data from an Excel worksheet are the columns that are identified 

in the column definition as FD or WKS. If you reference an Excel worksheet cell in a CALC, DESC, 

or FILL column, the value is ignored. 

See Also 

Link reports to Microsoft Excel 

Match worksheets with fiscal periods 

Identify an Excel file in a reporting tree 

Link to Management Reporter reports 

Import and maintain XBRL taxonomies 

Use additional file types with Management Reporter 

 

Note 
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Match worksheets with fiscal periods 

If you have data in an external worksheet or a Microsoft Excel spreadsheet, you can create a link in a 

report in Management Reporter to add the external data to the report. You can use either a combined link 

or a separate link to retrieve the external data. 

Combined link and separate link methods 

The combined link method is primarily used to add spreadsheet data to a row in the report. A combined 

link must meet the following requirements:  

 Connect to a single Microsoft Excel spreadsheet. 

 The row definition supplies the spreadsheet file name and location. 

 Spreadsheet cell references are preceded by @WKS. 

In the separate link method of adding external data to a report, the following three building block 

definitions contribute to the setup of the link. In addition, the report definition is set up to pull worksheet-

related data from the reporting tree. 

 The row definition contains worksheet cell references in one or more external worksheet links. 

 If the worksheet is designed with periodic data, then the related period offset code (/CPO or /RPO) is 

also required. 

 If multiple WKS type columns are defined in the column definition, then the related column is also 

entered in the link syntax; for example, C=B4, E=C4. 

 The column definition contains one or more WKS type columns. 

 The reporting tree definition is associated to the external link in the row definition in addition to the 

location of the worksheet file. 

You can use either a column period offset (/CPO) or a row period offset (/RPO) to link to Microsoft Excel 

files that cover multiple reporting periods. 

Column Period Offset (/CPO) 

If you are linking to an Excel file that has multiple columns that represent different periods, for example, a 

worksheet that has a detailed, 12-month budget forecast, use the /CPO (column period offset) option to 

match the accounting periods in the column definition with the appropriate columns in the Excel 

worksheet. You can use this technique with either the combined worksheet link or the separate worksheet 

link. 

To use the /CPO option, in the row definition, type the cell address that points to one column to the left 

of the first period (column). Then, add the /CPO option at the end of the cell address. 

The following table shows an example of using the /CPO option to link to a column from the external 

Excel worksheet file. 
 

Row Code Description ... Link to Worksheet 

340 Total Units Sold ... A7 /CPO 
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The following table shows an example of using the /CPO option to link to a column from the external 

worksheet file. 
 

Row Code Description ... Link to External Worksheet 

340 Total Units Sold ... @WKS (B=B2) /CPO 

 

When you run a report for period 1, Management Reporter uses the values in column B of the worksheet 

(January). For period 2, Management Reporter uses the values in column C of the worksheet (February), 

and so on. 

Note that the referenced cell (A7) is one column to the left of the first amount that you want to import 

into the report for the first period. 

Include the /CPO or /RPO option only one time per link cell, regardless of the number of Excel 

references in that link cell. 

Row Period Offset (/RPO)  

If you are linking to an Excel worksheet that has multiple rows that represent different periods, use the 

/RPO (row period offset) option to match the accounting periods in the column definition with the 

appropriate rows in the Excel worksheet. You can use this technique with either the combined worksheet 

link or the separate worksheet link. 

To use the /RPO option, type the cell address that points to one row above the first period (row) in the 

building block for the given column. Then, add the /RPO option at the end of the cell address. 

The following table shows an example of using the /RPO option to link to a row from the external Excel 

file. 
 

Row Code Description ... Link to Worksheet 

340 Total Units Sold ... B2 /RPO 

 

The following table shows an example of using the /RPO option to link to a row from the external 

worksheet file. 
 

Row Code Description ... Link to External Worksheet 

340 Total Units Sold ... @WKS (B2) /RPO 

 

When you run a report for period 1, the values in row 3 of the worksheet (January) are used. For period 2, 

the values in row 4 of the worksheet (February) are used, and so on. 

Note 
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Note that the referenced cell (B2) is one row above the first amount that you want to import into the 

report for the first period. 

Include the /CPO or /RPO option only one time per link cell, regardless of the number of Excel 

references in that link cell. 

Using multiple WKS columns 

If you specify multiple WKS columns in the column definition and use the /CPO or /RPO option in the row 

definition, Management Reporter matches a column in the Excel worksheet with each corresponding WKS 

column in the column definition. In this case, specify a value in the period cell of each WKS column. You 

can use a specific period, such as 6, or a relative period, such as B+2. 

For more information about how to add a value to the period cell, see Financial Dimensions column. 

Example 1 

To reference multiple values in a worksheet, you must enter multiple columns in the same WKS statement.  

The following table shows an example of using the /CPO option to link to multiple columns from the 

external worksheet file. 
 

Row Code Description ... Link to worksheet 

340 Total Units Sold ... @WKS (B=A2, C=A3) /CPO 

 

Example 2 

To use the same worksheet value as a base reference, you can use the values in the PERIOD column of a 

column definition to determine what values to retrieve for the calculation. The PERIOD column can use a 

hard-coded period, or the BASE+# and BASE-# codes for this calculation. 

For example, you can use the WKS statement of @WKS (B=A2, C=A2, D=A2) /CPO with the following 

column definition: 
 

A B C D E 

DESC FD WKS WKS WKS 

 ACTUAL    

 BASE    

 BASE BASE+1 BASE+2 BASE+3 

 PERIODIC    

 

This calculation uses the same cell in the external worksheet (A2) as a reference point, but the BASE+ 

period codes in the column definition determine which values to retrieve for the report. 

See Also 

Link reports to Microsoft Excel 

Note 
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Identify an Excel file in a reporting tree 

Prepare a link column in a row definition 

Use additional file types with Management Reporter 

Identify an Excel file in a reporting tree 

After you have created an External Worksheet column in the row definition and have specified the Excel 

worksheet cells to include in the report, you must update the reporting tree with the linked column and 

the Excel file information. An Excel file can be imported into any unit in the reporting tree. 

Identify the Excel link in a reporting tree 

1. In Report Designer, open the reporting tree definition to modify. 

2. Double-click the Row Definitions cell, and then select the row definition that contains information 

about the Excel file. 

The cells in the Row Definitions column display information based on the selected row 

information, because the same row definition must be used in all units of the reporting tree. 

3. In the Worksheet Link cell for a reporting unit, select the link name that corresponds to the external 

worksheet that is selected in the row definition. 

4. In the Workbook or Report Path cell for a reporting unit, type the name of the Excel file or browse 

to select the Excel file. 

5. To specify a worksheet in an Excel file, type the name of the worksheet in the Worksheet name cell. 

6. Repeat steps 3 through 5 for each reporting unit that should receive data from an Excel file. To 

prevent incorrect data from appearing in your report, make sure that the correct Excel file names 

appear in the corresponding unit of the reporting tree. 

See Also 

Link reports to Microsoft Excel 

Match worksheets with fiscal periods 

Prepare a link column in a row definition 

Link to Management Reporter reports 

Note 
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XPS and Management Reporter 
XML Paper Specification (XPS) is designed to give you a consistent document appearance, regardless of 

where and how the document is viewed. XPS documents also support security features, such as digital 

signatures, to provide better document security. When applied to a document, digital signatures can help 

ensure the identity of the signer and indicate whether an XPS document has changed since it was signed. 

 To create a link that opens a report as an XPS document, see Share a report.  

 To specify display options for XPS documents, see Report viewing options. 

 To export a report as an XPS document in Desktop Viewer, see Export a report. 

For more information about XPS and its benefits, see “XPS Documents” on MSDN 

(http://msdn.microsoft.com/en-us/library/dd316975(v=VS.85).aspx) and “XML Paper Specification: 

Overview” on MSDN (http://msdn.microsoft.com/en-us/windows/hardware/gg463373.aspx). 

To use XPS features, you must have the Microsoft XPS Viewer installed. This viewer is 

automatically installed on Windows Vista
®

, Windows 7®, Internet Explorer
®

 6, Internet Explorer 7, 

Internet Explorer 8, and Internet Explorer 9. To download the viewer, see Microsoft XML Paper 

Specification Essentials Pack (http://www.microsoft.com/download/en/details.aspx?id=11816). 

Note 

http://msdn.microsoft.com/en-us/library/dd316975(v=VS.85).aspx
http://msdn.microsoft.com/en-us/windows/hardware/gg463373.aspx
http://www.microsoft.com/download/en/details.aspx?id=11816
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XBRL and Management Reporter 
Management Reporter supports XBRL, or extensible business reporting language. XBRL functionality in 

Management Reporter allows you to prepare, publish, and exchange financial statements in a common 

format. Regulating authorities create taxonomies that regulate the tagging of data in this common 

format. Companies must choose line item tags from the regulator’s taxonomy and map the tags to their 

financial figures. The XBRL functionality in Management Reporter automates this data-tagging process. 

Taxonomies have been established in the United States for U.S. GAAP and the Securities and Exchange 

Commission, and also for HM Revenue and Customs in the United Kingdom. XBRL use by regulating 

authorities world-wide is expected to increase in the future.  

The consistent identity structure of XBRL is intended to make financial information easier for analysts, 

investors, and others to search and analyze across companies, reporting periods, and industries without 

having to reenter data manually. XBRL tags can be recognized and processed by databases, spreadsheets, 

and financial reporting systems.  

 Import and maintain XBRL taxonomies 

 Create and maintain XBRL entities 

 Maintain XBRL units 

 Link to XBRL taxonomies 

See Also 

Export a report 

Use additional file types with Management Reporter 

Import and maintain XBRL taxonomies 

XBRL taxonomies define the specific tags that you will use for the individual items of data in reports, such 

as net profit. Different taxonomies are required for different business reporting purposes. After your 

company has determined which taxonomy it needs, it is downloaded from the appropriate website.  

XBRL represents each concept as an element with a name. An element is an XBRL component, such as a 

table, a domain member, and dimension. 

You must be in an administrator or designer role to work with XBRL taxonomies. 

Import a taxonomy 

1. In Report Designer, on the XBRL menu, click Taxonomies. 

2. In the XBRL Taxonomies dialog box, click New. The Add XBRL Taxonomy dialog box opens. 

3. In the Name field, type a name that has either been established previously by your company or assign 

a name to the taxonomy. 

4. Type the URL of the XBRL taxonomy schema document or, if the taxonomy already exists on your 

computer, click  to browse to the taxonomy.  

5. Click OK. Loading the taxonomy may take several minutes. 
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Modify a taxonomy 

To change the name of a taxonomy or its default language, follow these steps: 

1. In Report Designer, on the XBRL menu, click Taxonomies. 

2. In the XBRL Taxonomies dialog box, select the taxonomy to modify, and then click Modify. 

3. Rename the taxonomy and select the default language. Click OK. 

Update a taxonomy 

1. In Report Designer, on the XBRL menu, click Taxonomies. 

2. Select the taxonomy to update from the list. 

3. Click Refresh. 

Delete a taxonomy 

1. In Report Designer, on the XBRL menu, click Taxonomies. 

2. In the XBRL Taxonomies dialog box, select the taxonomy to delete from the library, and then click 

Delete.  

You cannot delete a taxonomy that is currently being used by an entity.  

3. Click Yes to permanently delete the taxonomy. 

See Also 

Create and maintain XBRL entities 

Maintain XBRL units 

Link to XBRL taxonomies 

Use additional file types with Management Reporter 

Note 
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Create and maintain XBRL entities 

An entity in XBRL manages the rules for data and provides the context for the instance document.  

This section contains the following procedures: 

 Add or modify an XBRL entity 

 Link an XBRL entity to a company 

 Delete an XBRL entity 

Add or modify an XBRL entity 

1. Open Report Designer. On the XBRL menu, click Entities to open the XBRL Entities dialog box. A list 

of entities added by the user is displayed. 

2. To add an entity, click New. 

To modify an entity, click Modify. 

3. Depending on whether you are creating or modifying an entity, enter the following information for 

the entity in the New XBRL Entity box or the Modify XBRL Entity dialog box. 
 

Label Description 

Name The name of the XBRL entity. 

Taxonomy The XBRL taxonomy that is associated with the entity. If 

the taxonomy that you want to use is not in the list of 

available options, click New to open the Add XBRL 

Taxonomy dialog box. For more information, see 

Import and maintain XBRL taxonomies. 

Identification scheme: Location The web address of the regulatory body. 

Identification scheme: Identifier The identifying name or number for the entity that is 

used by the regulatory body. 

Custom namespace: Location The web address of the XBRL entity. 

Custom namespace: Prefix A short prefix for your custom namespace. For 

example, “cl” for “Contoso, Ltd.” 

Enter company and other descriptive information 

to be included in your XBRL instance document. 

Specifies which labels will appear in rows. Double-click 

on the XBRL Label space to open the Entity XBRL 

Label Selection dialog box. You can also filter the list 

of options. For more information, see Link to XBRL 

taxonomies. 
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Link an XBRL entity to a company 

1. In Report Designer, on the Company menu, click Companies to open the Companies dialog box.  

2. Select the company to link an XBRL entity to, and then click Modify. If the company to modify is not 

displayed in the list, click New and create a new company. 

3. In the XBRL entity field of the Modify company dialog, select the name of the XBRL entity to use for 

the company, or click New to create a new XBRL entity. 

4. Click OK. 

Delete an XBRL entity 

1. In Report Designer, on the XBRL menu, click Entities to open the XBRL Entities dialog box. A list of 

entities added by the user is displayed. 

2. Select the entity to delete, and then click Delete. 

3. Click Yes to permanently delete the item. 

See Also 

Link to XBRL taxonomies 

XBRL and Management Reporter 

Use additional file types with Management Reporter 
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Maintain XBRL units 

An XBRL unit is an element in an instance document that specifies the measure applied to numeric values. 

A unit depends on the element type and data type specified in the Label Selection dialog box. 

Add or modify an XBRL unit 

1. In Report Designer, on the XBRL menu, click Units. 

2. In the XBRL Units dialog box, a list of the available XBRL units is displayed. To add a new unit, click 

New. To modify a unit, click Modify. 

3. In the New XBRL Unit dialog box or the Modify XBRL unit dialog box, enter or modify the following 

information.  
 

Label Description 

Unit Name A unique name for the unit. For example, Miles, Gallon, or MilesPerGallon. Use letters, 

numbers, and underscores. Do not use spaces. 

Unit description A unique description for the unit. For example, the description for Salary might be 

Expenditure for salaries of employees. 

Define a new measure The name of a new unit of measure to be applied to numeric values. For example, 

enter USD for U.S. dollars. 

Use existing unit(s) Select this option to use existing units. Specify the first and second measures and the 

operator. 

 

4. Click OK. The new or modified unit is displayed in the list. 

5. In the XBRL Units dialog box, click Close. 

Delete an XBRL unit 

1. In Report Designer, on the XBRL menu, click Units. 

2. In the XBRL units dialog box, select the unit to delete, and then click Delete.  

3. Click Yes to permanently delete the selected item, and then click Close. 

See Also 

Import and maintain XBRL taxonomies 

Link to XBRL taxonomies 

XBRL and Management Reporter 

Use additional file types with Management Reporter 
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Link to XBRL taxonomies 

To tag items of data in a report, you must link to an XBRL taxonomy.  

To link to an XBRL taxonomy, the company that you are creating a report for must have an XBRL 

entity associated with it. For more information, see Create and maintain XBRL entities. 

Add an XBRL taxonomy row link 

To link a row to an XBRL taxonomy label, complete the following steps: 

1. In Report Designer, open a row definition for a company that has an XBRL entity associated with it. 

2. On the Edit menu, click Row Link. The Row Links dialog is displayed. 

3. Click New to create a new link. 

4. In the Link definition area, select XBRL taxonomy for the link type. Enter a name and description for 

the link. 

5. To add XBRL labels for each amount row based on the row description, select the Add XBRL labels in 

row link check box. 

6. Click OK. The Link to XBRL taxonomy column is added to the row definition and the XBRL label 

select dialog is displayed. 

7. In the XBRL Label Selection dialog box, under Possible matches for, select an XBRL label to attach 

to the row. You can browse the possible matches for the label or browse the entire taxonomy in the 

hierarchal pane. You can also click Find to search by keyword. 

Browse for an XBRL taxonomy label 

To browse through the taxonomy in the XBRL Label Selection dialog box, complete the following steps: 

1. In the Taxonomy view field, specify how the taxonomy is displayed: 

 Use the Presentation view to browse labels by title. 

 Use the Definition view to browse labels by definition. 

2. Use the Filter field to narrow search results to a particular label topic. 

3. In the Data type field, select a label. One of the following data types will be assigned automatically. 

The data type defines the kind of data that will be tagged with the XBRL item.  

 Text box is blank (Abstract) 

 Tuple (Tuple) 

 Monetary (Monetary) 

 Decimal (Decimal) 

 Shares (Shares) 

 Pure (Decimal) 

 Integer (Integer) 

 True or False (Boolean) 

 Date (Date) 

 Date/Time (DateTime) 

Note 
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 Time (Time) 

 Text (String) 

4. For some data types, you must specify how to report that item. Do this in the Report the selected 

item as field. 

5. If the Value list option is available, you can enter or select a note for the data type and label.  

The Documentation, References, and Properties tabs display information that is relevant to 

the selected label.  

7. Double-click the selection and the label will appear in the Link to XBRL Taxonomy cell of the row 

definition. 

See Also 

Link to Financial Dimensions cell in a row definition 

XBRL and Management Reporter 

Use additional file types with Management Reporter 

Specify XBRL currency and dimension in column definitions 

The following procedures describe how to specify an XBRL currency and dimension for an XBRL instance 

document. 

To select an XBRL currency and dimension, the company must be associated with an XBRL entity. 

For more information, see Create and maintain XBRL entities. 

Specify an XBRL currency 

1. In Report Designer, open the column definition to modify. 

2. Double-click the XBRL Currency cell in the appropriate column. 

3. Select a currency. 

Specify an XBRL dimension 

1. In Report Designer, open the column definition to modify. 

2. Double-click the XBRL Dimension cell. Click  to open the XBRL Dimensions dialog box. 

3. Select a row definition in the Row definition to display associated dimensions field. 

4. In the Display labels in field, select the language that labels will appear in. 

5. In the Dimensions and values field, select the dimension and dimension members for the column. 

6. Click OK.  

Dimensions not defined in the XBRL Dimensions dialog box must be defined in the reporting 

tree definition. For more information, see Reporting tree definitions. 

Note 

Note 

Note 
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See Also 

XBRL and Management Reporter 

Format a multiple currency report in a column definition 

Use additional file types with Management Reporter 
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Desktop Viewer 

The Management Reporter Desktop Viewer allows you to view and share generated reports, and interact 

with the data in a generated report.  

Some features and tasks are not available to users who are assigned to the viewer role in 

Management Reporter. 

To open Desktop Viewer, click Start, select All Programs, and then select the Microsoft Dynamics folder. 

Open the Management Reporter 2012 folder, and then click Desktop Viewer. This is the default 

location. Your administrator may have installed it in another location. 

 Interactive components in Desktop Viewer 

 Fact pane 

 View a report 

 Change page setup 

 Change report magnification 

 Print a report 

 Share a report 

 Insert external files into the report library 

 Export a report 

 Create a chart 

 Add a comment to a report 

 Drill to Dynamics 

 Send an instant message 

 

Note 
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Interactive components in Desktop Viewer 
 

Component Description 

Quick charts Create a chart from selected rows or columns of data in a report. You can 

paste the chart into a PowerPoint
®

 slide, save the chart for future use, or copy 

and paste it into an email message to send to a co-worker. For more 

information about charts, see Create a chart. 

Add comments All users can create and modify their own comments and respond to another 

user’s comment in a report. Administrators and designers can delete any 

comments. For more information about how to use comments, see Add a 

comment to a report. 

Find To quickly locate a word in a report, click Find on the Find menu. A search 

pane opens above the report. Type a word to locate. Click Options to specify 

Match whole word only or Match case. Click Next. The line in the report 

that contains the word is highlighted with a box around it. 

Go To You can move to a specific line of key data in a report. The Go To pane is 

located at the bottom of the report view pane. You can also access Go To 

from the Find menu. Click Go To and select a line of the report from the 

menu. The page of the report that has that line on it is displayed in the view 

pane. To show or hide the Go To pane, select View, and then click Go To 

Pane. 

Paging buttons Use the report page navigation buttons to navigate between pages of the 

report or move to the first or last page of the report. The paging buttons are 

located in the Go To pane at the bottom of the report view pane. 

Send an instant message Use Microsoft Lync
®

 2010 to send an instant message to a co-worker when 

you are viewing a report. To start an instant message dialog, right-click a line 

in a report and select Send an Instant Message. 

Note 

To use this feature, you must have Microsoft Lync 2010 or a later 

version installed on your computer. 

Drill Down in Management Reporter Some reports contain detailed information that you can view by drilling down 

into the report. To determine whether a report has detailed information, 

move the pointer over the report rows. A hyperlink appears when the row 

contains a detailed report. Double-click the row to view the detailed report. 

To see more information about a line in a report, you can use one of the 

following procedures from the account level in a report: 

 Click  in the toolbar. 

 Select a line of the report, and on the View menu, click Drill Down. 
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Component Description 

Drill to Dynamics To see information beyond the Management Reporter transaction level, you 

can drill down in the Microsoft Dynamics ERP system. Your pointer must be at 

the account level of a report for this option to be active.  

 

The report library 
Desktop Viewer also contains the report library, which stores all versions of the reports that have 

Management Reporter selected as the output type. For more information about output types, see Report 

viewing options.  

The structure of the report library is always visible in the navigation pane, and you can examine the 

content of all folders. However, throughout the report library you can view only the reports and external 

files that you have View permission for. For more information about report library permissions, see Report 

library security 

See Also 
Organize reports 

Web Viewer 

Desktop Viewer 
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Fact pane 
The Fact pane appears to the right of the view pane when you have opened a report in Desktop Viewer. It 

displays the comments that are in the report and any charts that you have created from the report data.  

To hide or display the Fact pane, from the View menu, click Fact Pane. If the Fact pane is hidden and you 

add a comment to a report row, the Fact pane is displayed. To expand and collapse the fact pane, click the 

arrow in the upper-right corner. To change the width of the pane, select the splitter bar on the left side of 

the pane. 

Comments in the report are shown at the top of the Fact pane. You can use the scroll buttons to scroll 

through the comments, or you can click a comment, and then use the arrow keys to move through them. 

You can add or delete a comment using the icons in the Comment toolbar. For more information about 

comments, see Add a comment to a report. 

Charts that you have created from the content of the report are listed under the comments in the Fact 

pane. Click on a chart title to view it in the Fact pane, and double-click a chart to open it in a new window. 

For more information about how to create charts, see Create a chart. 

See Also 

Add a comment to a report 

Create a chart 

Desktop Viewer 
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View a report 
Depending on your permissions, you can view the latest version or a previously generated version of a 

report. 

View a report 

1. In Desktop Viewer, click Report Library in the navigation pane. Reports are listed in the viewer pane. 

2. Double-click the report to view to open the report in the viewer pane. 

 If the report uses a reporting tree, the reporting tree appears in the navigation pane. 

 If the report includes additional detail, a hyperlink appears when you move the pointer over the 

data. Double-click report data to view the supporting detail. When you drill down into a report, 

you can navigate back and forward through the report views by clicking the Forward and Back 

buttons on the toolbar. 

View a specific version of a report 

1. In Desktop Viewer, click Report Library in the navigation pane. Right-click a report, and then click 

Show Versions. 

2. Select the report version to view, and then click Open. 

See Also 

Desktop Viewer 
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Change page setup 
Use the Page Setup dialog box to change the margins, orientation, scaling, page order, and paper size for 

reports. This page setup applies to all reports in the current Management Reporter session, only. When 

you close Management Reporter, the page setup reverts to the default page setup for the report. To make 

permanent changes to page setup, see Page Setup options in report definition. 

Change page setup 

1. When viewing a report in Desktop Viewer, click File, and then click Page Setup. 

2. Modify the Page Setup options as needed. 

3. Click OK. 

The following options are available: 
 

Option Description 

Margins Select the width of the top, bottom, left, and right margins of the report. The default margin value is 

0.75 inches.  

Scaling Resize the report page.  

 Reduce or enlarge to – Changes the size of the printed report and maintains the proportions of 

the report columns.  

 Shrink to page width – Adjusts the size of report columns to fit on a single page of paper. Page 

width is based on the Paper size dimension. 

Orientation Select Landscape for horizontal page orientation or Portrait for vertical page orientation. 

Page Order Controls the order that the report pages are displayed. 

 Down, then over – Information in report pages is read or displayed down in columns first, and 

then over in rows. 

 Over, then down – Information in report pages is read or displayed across in rows first, and then 

down in columns. 

Paper size Select the page size that is appropriate for your location or project requirements. 

 

See Also 

Change report magnification 

Print a report 

Desktop Viewer 
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Change report magnification 
You can change the magnification of the print on a report to make it easier to read. 

Change report magnification using a predefined zoom setting or a 

custom setting 

1. Open a report in Desktop Viewer. 

2. On the View menu, click Zoom. Select a predefined zoom size, or click Other to enter a custom zoom 

size. 

Change report magnification using the slider 

To use the slider to change report magnification, open a report in Desktop Viewer and complete one of 

the following steps: 

 On the bottom of the report window, click the slider and drag it to the right to increase magnification. 

Drag the slider to the left to reduce magnification.  

 Click the + sign to increase magnification, or click the – sign to reduce magnification. 

 Click the report magnification number to open the Zoom dialog box. Select a magnification 

percentage and then click OK. 

See Also 

Change page setup 

Print a report 

Desktop Viewer 
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Print a report 
You can print the current view, current page, current reporting unit, selected reporting units, or all 

reporting units. When working with a detailed report, you can print the entire financial report, which 

combines all supporting details, or you can print specific detailed reports. 

To change the report page setup in Desktop Viewer, on the File menu, click Page Setup. 

Print a report 

1. In Desktop Viewer, click Report Library in the navigation pane, and open the report to be printed.  

2. On the File menu, click Print, or click Print in the toolbar. 

3. Select the print destination in the Printer field. To change the printer options, click Printers. 

4. Under Print range, select one of the following options. 

 Current View - Prints the current view of a report. For example, if the current report view is three 

pages, those three pages are printed. 

 Current Page – Prints the page that is currently displayed in Desktop Viewer. 

 Current Reporting Unit – Prints the current reporting unit of a reporting tree. For example, if the 

current reporting unit is three pages, three pages are printed. 

 Selected reporting units – Opens a dialog box where you can select the reporting units to print. 

 All reporting units – Prints all reporting units in a reporting tree. 

5. Under Report type, select one or more of the following options. If you selected Current View or 

Current page for the Print range option, these options are not available.  

 Financial report – Prints only the financial report. 

 Account details – Prints only the account details report. 

 Transaction details – Prints only the transaction details report. 

 Exception report – Prints only the exception details report. 

6. To print any comments that are included in the report, select Include comments. 

7. Specify the width of the report columns, or select Autofit to automatically define the column width. 

8. Specify the number of copies to print and whether to collate multiple copies, and then click OK to 

print the report. 

See Also 

Change report magnification 

Change page setup 

Desktop Viewer 

 

Note 
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Share a report 
You can create an email message that contains a link to your report in the report library. In Desktop 

Viewer, select a report, click File, and then select Send link using email. Select one of the following 

options:  

 Management Reporter – Send a link by email to the report that is in the report library. The email 

recipient must have the appropriate permissions in Management Reporter to view the report. 

 Microsoft Excel (.xlsx) – Send a link by email to open the report as a Microsoft Excel worksheet. 

 Microsoft XPS – Send a link by email to open the report as a Microsoft XPS document. 

 All – Send a link by email to the report in all output types.  

See Also 

Export a report 

Web Viewer 

Desktop Viewer 
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Insert external files into the report library 
You can add external, supporting documentation to the report library, such as an Excel worksheet, a 

Microsoft Word
®

 document, or a .pdf file. This can be useful to view files associated with a report. To 

open the external file, double-click the file name. The file is opened by the appropriate application. 

To view the external file, you must have the application associated with the external file installed 

on your computer. 

Insert external files into report library 

1. In Desktop Viewer, click Report Library in the navigation pane, and select the folder to insert an 

external file in to. 

2. On the Insert menu, click External File. 

3. Browse to the location of the file. 

4. Select the file, and then click Open. 

See Also 

Change report library permissions 

Use additional file types with Management Reporter 

Desktop Viewer 

 

 

Note 
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Export a report 
Management Reporter can export a report to a .xps document, an Excel spreadsheet, or to an XBRL 

instance document. If you have export permission, you can export a reporting tree, a current reporting 

unit, or a current view. When you work with a detailed report, you can also export the entire financial 

report, including all the supporting details, or you can export specific detail reports. For more information 

about security and export permissions, see Security, user roles, and permissions. 

To change the default import and export file directory for the current user, open Desktop Viewer. 

On the Tools menu, click Options to open the Options dialog box. In the Default import and 

export file directory field, type or browse for a new default file directory. Click OK. 

Export a report to Microsoft Excel 

1. In Desktop Viewer, click Report Library in the navigation pane, and then double-click a report to 

open it. 

2. On the File menu, click Export, and then click Microsoft Excel (.xslx). 

3. In the Export to Microsoft Excel dialog box, in the Export data to field, enter a path and file name 

to export the report to, or click  to locate a path and file name. The file name that you specify 

must end in .xlsx or .xls. 

4. Under Export range, select one of the following options: 

 Current View – Exports the current view of a report.  

 Current Reporting Unit – Exports the current reporting unit of a reporting tree.  

 Selected Reporting Units – Open a dialog box where you can select the reporting units to 

export. 

 All Reporting Units – Export all reporting units in a reporting tree. 

5. Under Report type, select one or more of the following options: 

 Financial report – Export only the financial report. 

 Account details – Export only the account detail report. 

 Transaction details – Export only the transaction detail report. 

 Exception report – Export only the exception report. 

Report type options are not available if you select Current View for the Export range 

option. 

6. To export any comments that are attached to the report, select Include comments. 

7. Under Microsoft Excel options, select one or more of the formatting and file options. 

8. Click OK. If you selected Open workbook after exporting, the report will open in Microsoft Excel. 

Otherwise, it is saved to the location that you specified in step 3. 

Tip 

Note 
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Export a report to an XBRL instance document 

If XBRL details were included when a report was generated, you can export the report to an XBRL instance 

document. 

1. In Desktop Viewer, click Report Library in the navigation pane, and then double-click a report to 

open it. 

2. On the File menu, click Export, and then click XBRL Instance Document. This opens the Export to 

XBRL Instance Document dialog box.  

3. In the Export data to field, enter the location where your instance document will be sent. 

4. In the File and folder name field, enter the name that will identify the file and folder after it is sent. 

Click OK. 

If you use the File and folder name field, the supporting XBRL documents, such as the 

taxonomy files and extensions, will be sent together with the instance document. 

Export a report to an XPS document 

1. In Desktop Viewer, click Report Library in the navigation pane, and then double-click a report to 

open it. 

2. On the File menu, click Export, and then click XPS. 

3. In the Export to XPS dialog box, in the Export data to field, enter a path and file name to export the 

report to, or click  to locate a path and file name. The file name that you specify must end in .xps. 

4. Under Export range, select one of the following options: 

 Current View – Export the current view of a report.  

 Current Reporting Unit – Export the current reporting unit of a reporting tree.  

 Selected Reporting Units – Open a dialog box where you can select the reporting units to 

export. 

 All Reporting Units – Export all reporting units in a reporting tree. 

5. Under Report type, select one or more of the following options: 

 Financial report – Export only the financial report. 

 Account details – Export only the account detail report. 

 Transaction details – Export only the transaction detail report. 

Report type options are not available if you select Current View for the Export range 

option. 

6. To export any comments that are attached to the report, select Include comments. 

7. Select the width of the report columns, or select Autofit to automatically size the columns. 

8. Under XPS options, select one or more of the formatting and file options. 

9. Click OK. If you selected Open XPS after exporting, the report will open in Microsoft Document 

Viewer. Otherwise, it is saved to the location that you specified in step 3. 

Note 

Note 
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See Also 

Security, user roles, and permissions 

Change report library permissions 

Use additional file types with Management Reporter 

Desktop Viewer 
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Create a chart 
You can quickly create a chart from highlighted rows or columns of data within a report. When you view 

report data, the fact pane, which displays the comments that are within the report and the charts that you 

have created from the report data, opens to the right of the viewer pane. 

For a list of the types of charts available in Desktop Viewer, see Chart types later in this topic. 

Create a quick chart 

1. Open a report in Desktop Viewer.  

2. Select the sequential rows or columns of data to include in the chart. You can include data from the 

financial, account, and transaction levels of the report. You can select data in the following ways: 

 Right-click on a row or column in the report, and select Select Row or Select Column from the 

context menu.  

 If there is an active cell in the report and you right-click and select a chart or click a chart icon in 

the toolbar, the row where the active cell resides is used to create the chart. 

 Select a row or column, hold down the Shift key, and use the arrow keys on the keyboard to select 

sequential row or columns of data. 

3. Select the type of chart in one of the following ways: 

 Right-click on the report data, select Quick charts, and then select the type of chart to create. 

 Click the appropriate chart icon in the tool bar. 

4. A separate window opens to display the chart. Click  in the chart toolbar to pin the chart to the fact 

pane. It docks beneath the last docked chart. Optionally, you can right-click on the chart and select 

one of the following options: 

 Copy – Copy the image to the clipboard to paste into other applications. 

 Show Legend – Show or hide the chart legend. 

 Chart Type – Select and create a different chart using the same data. 

 Palette – Select a different color palette for the chart. 

 Series – If a row was selected for the chart, all columns are listed. If a column was selected, all 

rows are listed. Select Add All to chart all series or select Clear All to clear all series, in which case 

the chart would be blank. 

 3D – Convert the chart to a 3D image. 

 Add Chart Title – Opens the Chart Title dialog box. Type the name of the chart and select 

formatting options. Click OK. 

When you close the report, the chart is saved with it. 

Example 

Kevin is preparing a Microsoft PowerPoint presentation of monthly sales for the quarterly review. On the 

Profit and Loss report, it shows each month, January through August. Kevin highlights the Sales row, right-

clicks, and then selects Quick Chart and then Pie. A separate window opens that displays the data in a pie 
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chart. Kevin clears the Total column option so that he sees just the sales month over month. Kevin reviews 

the trend and finds it to be very useful. Kevin right-clicks the chart, clicks Copy, and then pastes the chart 

into his PowerPoint slide. When he closes the report, the chart is saved with it. 

Chart icons and options 
 

Icon Description 

 Lightning bolt action menu in the fact pane provides the following options: 

 Move Up – Move the selected item above the previous docked item. If the item is already at the top, 

no action occurs. 

 Move Down – Moves the selected item below the previous docked item. If the item is the last item, no 

action occurs. 

 Undock– Undocks the item from the fact pane and opens chart in a separate window. 

 Close – Closes the item. 

 Collapses the detail of the item. When collapsed, only the caption bar is displayed.  

 Expands the detail of the item. 

 Docks the chart to the fact pane. 

 Closes the chart.  

 

Chart types 

The following charts can be created from an open report in Desktop Viewer: 
 

Chart type Description 

Bar chart A bar chart has rectangular bars with lengths that are proportional to the values that they represent. 

The bars are plotted horizontally. Bar charts are used to plot data that has discrete values and is not 

continuous. 

Tip 

Do not use a bar chart for comparisons or larger data sets; use a line chart. 

Column chart A column chart displays a series as a set of vertical bars that are grouped by category. These charts 

are useful for showing data changes over a period of time or for illustrating comparisons among 

departments. 

Tip 

Do not use a column chart for comparisons or larger data sets; use a line chart. 
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Chart type Description 

Line chart A line chart displays information as a series of data points that represent individual measurements 

that are connected by straight line segments. A line chart is often used to visualize a trend in data 

over intervals of time. 

Tip 

Do not use a line chart if the X axis has non-numeric values. 

Pie chart A pie chart, or a circle graph, is a circular chart divided into sections that illustrate proportion. Pie 

charts can be an effective way to display information if the intent is to compare the size of a slice 

with the whole pie, rather than comparing the slices among them. It also shows the frequency within 

certain groups of information. 

Tip 

Do not use a pie chart for exact comparisons of values because it is difficult to estimate 

angles. For rank data, use a column or bar chart, and for grouped data, use multiple column 

or bar charts. If proportions vary greatly, do not use multiple pies to compare 

corresponding parts. 

Area chart An area chart displays graphically quantitative data. It is based on the line chart with the area 

between axis and line ordinarily emphasized with colors, textures, and hatchings. Area charts are 

used to represent cumulated totals using numbers or percentages over time. 

 

See Also 

Interactive components in Desktop Viewer 

Web Viewer 

Desktop Viewer 
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Add a comment to a report 
You can add and respond to comments in any report that you have access to. Comments appear in the 

report and, optionally, in the Fact pane. If you have the role of designer or administrator, you can also 

copy comments from a previous report version into the current report version, which overwrites any 

existing comments. 

Comments can be added to all user-defined financial dimension rows, calculation rows, and total rows. 

Add a comment to a report 

1. Open a report in Desktop Viewer. 

2. Right-click a row in the report to comment on, and then click Add Comment.  

3. Type your comments in the Comment dialog box.  

4. Click OK. The comment is displayed in the fact pane. When you close your report, the comments are 

saved with it. 

Copy comments from a previous report version 

You can copy comments from an earlier version of a report to the current version. You must have the role 

of designer or administrator to copy comments, and the original author maintains ownership of the 

comments. Copying overwrites any comments in the current version.  

1. Open a report in Desktop Viewer. 

2. From the toolbar, click Copy Comments. The Report Versions dialog box opens. 

3. Select the version of a report that contains the comments that you want to copy. 

4. Click OK. 

Hide a comment in a report 

You can hide comments that have been added to a report in Desktop Viewer. To hide comments, double-

click the comment indicator. 

To view hidden comments, close the report and open it again in Desktop Viewer. 

See Also 

Fact pane 

Desktop Viewer 
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Drill to Dynamics 
The Drill to Dynamics feature lets you obtain additional information about an account from the Microsoft 

Dynamics ERP system, such as viewing the source and originating transactions for general ledger data to 

provide more details for data analysis. 

For example, suppose that Phyllis generates a Quarter 1 Income Statement. She opens the report in 

Desktop Viewer and drills down to the account level on Sales. She wants to view additional information 

about the account, such as where the transactions originated. Phyllis knows that she can drill down to the 

transaction level in Management Reporter, but she wants to see more information than what is provided. 

On the account level, she can right-click and select Drill to Dynamics. Depending on the Microsoft 

Dynamics ERP system she is using, an ERP system window opens, and from there she can view additional 

information related to the account. 

Use Drill to Dynamics  

To use Drill to Dynamics, a Microsoft Dynamics ERP client must be installed on the computer that 

you are using, or the following options will not be available. 

In Desktop Viewer, open the report. To use the Drill to Dynamics feature, you must be at the account level 

of the report. You can access the Drill to Dynamics feature in one of the following ways:  

 Select an amount, and then click  on the toolbar. 

 Select an amount, and then on the View menu, select Drill to Dynamics. 

 Select an amount, press Alt+D. 

Depending on the Microsoft Dynamics ERP system that you are using, the ERP system window opens, 

based on the system that is connected to the report or the node of the tree that you are drilling down on. 

If you are not logged on to the ERP system, you must enter your credentials.  

Reports that were generated using a previous version of Management Reporter might not 

produce accurate results for the Drill to Dynamics feature. If this occurs, you must generate the 

report again.  

See Also 

Desktop Viewer 

Note 

Note 
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Send an instant message 
You can initiate an instant message exchange with a co-worker while you view a report in Desktop Viewer. 

To use this feature, you must be using Microsoft Lync 2010. 

Send an instant message 

1. Open a report in Desktop Viewer. 

2. Right-click in a cell in the report, and select Send an Instant Message to open the Microsoft Lync 

instant message dialog box. 

See Also 

Add a comment to a report 

Desktop Viewer 
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Web Viewer 

The Web Viewer allows you to view a Management Reporter report in a web browser, without using 

Desktop Viewer or an installation of the Management Reporter client. 

Web Viewer requires a current generation web browser. For more information, see the 

Management Reporter System Requirements (http://go.microsoft.com/fwlink/?LinkID=162565). 

 

 Web Viewer commands 

 View a report in the Web Viewer 

 View or add comments to a report in the Web Viewer 

 View charts that are associated with a report in the Web Viewer 

 View units of a reporting tree in the Web Viewer 

Note 

http://go.microsoft.com/fwlink/?LinkID=162565
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Web Viewer commands 
The following table describes the buttons that are available on the application bar of the Web Viewer. 
 

Button Description 

Reporting Tree View information for individual units of the reporting tree of the report. You can view only the 

units of the reporting tree that you have been granted access to in Management Reporter. 

Note 

This option is available only if the current report uses a reporting tree. 

Add Comment Add a comment to the row that is currently selected in the report. 

Go To View specific rows in the report or a specific level of the reporting tree. 

Note 

This feature is available for the Financial level of a report only. 

Show Open a menu of the following commands: 

 Show Charts and Comments or Hide Charts and Comments – View the charts and 

comments that are associated with rows of a report. By default, charts and comments are not 

displayed. 

 Show Header and Footer  or Hide Header and Footer – View the headers and footers for 

the report. By default, headers and footers are not displayed.  

Zoom Increase or decrease magnification of the report data. 

Download Download the current report as an XPS (.xps) file, a worksheet in Microsoft Excel (.xlsx file), or as a 

report in Management Reporter. 

For more information about export options in Management Reporter, see Export a report. 

Settings View information about Management Reporter. 

 

See Also 

Share a report 

Export a report 

Web Viewer 
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View a report in the Web Viewer 
To view a report in the Web Viewer, you must generate a link to the report in the report library. For more 

information about how to create a link to a report, see Share a report. 

If the report in Management Reporter contains additional levels of detail, such as the Account or Financial 

Detail view, links for these views are displayed below the title of the report. Click one of the view options 

to display additional data for the selected level of detail. For example, if you are viewing transaction 

details for a sales account, click the Financial Detail link to view a Financial Detail version of the report 

with summarized data. 

If the report in Management Reporter contains account and transaction details for certain rows of the 

report, the rows are displayed as hyperlinks in the report. Click a row that includes details to view 

additional information in Web Viewer. 

1. Select the link to open the report in the Web Viewer. 

2. Use the arrow keys to move through the rows of the report. 

3. To select a row in the report, click between the columns of data to select that row. Any charts or 

comments that are associated with the row are displayed in the Fact Pane. 

Only one row can be selected at a time. 

4. To return to a previous view of the report, click the Back button in the Web Viewer. The Back button 

is located next to the report name. 

Do not use the Back button in the web browser. 

5. To print a report, use one of the following options: 

 Click Print in the web browser. 

 Download the report as an .xps file or a worksheet in Microsoft Excel, and then use the Print 

function in the application that you selected. 

See Also 

View a report 

Web Viewer 

 

Note 

Note 
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View or add comments to a report in the Web Viewer 
Any user who can view the report in the Web Viewer can add comments to rows in the report. Comments 

can be added to any level of detail in the report, such as the Financial, Account, or Transaction detail level. 

To view comments in a report in the Web Viewer, select a row in the report. On the application bar, click 

Show, and then select Chart and comments. Comments for the selected row are displayed in the Fact 

Box. 

To delete a comment that you created, select the comment, and then click Delete. Click Yes to 

permanently delete the comment. 

By default, you can modify or delete only the comments that you have created. To delete the 

comments of other users, you must have the Delete permission that is defined in the report 

library Management Reporter. To modify the comments of other users, you must have the Edit 

permission that is defined in the report library in Management Reporter. 

See Also 

Add a comment to a report 

Report library security 

Web Viewer 

Note 
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View charts that are associated with a report in the 
Web Viewer 
Any user who can view the report in the Web Viewer can view the charts that are associated with the 

report. If a chart is added to the report in Desktop Viewer, the chart is displayed in the Fact Pane of the 

Web Viewer. 

To view a chart in the Web Viewer, select a row in the report. Any charts that are associated with that row 

are displayed in a gallery in the Fact Pane. Click a thumbnail to view the chart. 

See Also 

Create a chart 

Fact pane 

Web Viewer 
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View units of a reporting tree in the Web Viewer 
If a report has a reporting tree, you can filter data for individual units of the reporting tree. Users can view 

only the units of the reporting tree that they have been granted access to in Management Reporter. 

To filter data in the report, click Reporting Tree in the application bar, and then select a unit of the 

reporting tree to filter results for. 

If the report has a reporting tree, click Reporting Tree in the application bar to view information for a 

specific unit of the reporting tree. 

See Also 

Reporting tree definitions 

Web Viewer 
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